
System requirements 

To install and run SDL Trados Business Manager Team, you need: 

 OS: Microsoft Windows 7 or higher 

 Database engine (Microsoft SQL Server or PostgreSQL), or 

 No database engine, in case application is running locally for one user (in this mode, 

local Microsoft SQL Server CE is used) 

 CPU and RAM: Any 

 Hard drive: SSD recommended 

 Installed libraries: Microsoft NET Framework 4.7 (or later) 

To install and run SDL Trados Business Manager Online you need: 

 OS: Microsoft Windows Server, any version, with Internet Information Services feature 

installed 

 Database engine (Microsoft SQL Server or PostgreSQL) 

 CPU and RAM: Any 

 Hard drive: SSD recommended 

 Installed libraries: Microsoft NET Framework 4.7 (or later) 

The Microsoft .NET Framework can be downloaded 

from: https://dotnet.microsoft.com/download/dotnet-framework. 

When you run SDL Trados Business Manager for the first time (clean installation), 
you will be prompted to enter a password. By default, user name is Admin, and 
password is User@TBM. After logging in, you can go to the Other/tools > 
Users, select Admin user and change its password (and even set to blank, so logon 
window won't appear when you launch TBM). 

Demo version limitations 

For desktop version, the following limitations apply when application is running in Demo 

mode (license is not installed): 

 Full access to all tables and functionality of the application 

 Possibility to create no more than 40 translation jobs 

 Possibility to create no more than 15 invoices 



 Impossibility to delete translation jobs and invoices 

For web-version, there is no demo mode. If license is not installed or license due period is 

ended, application switches to Demo mode, which allows to view any data, but denies any data 

modification (edit and delete). 

When trial license is installed, you can use all functionalities of the application without any 

limitations up to trial end date. 

Internet connection 

Sometimes SDL Trados Business Manager may connect to the Internet to perform some 

actions. 

SDL Trados Business Manager may sent network requests during usage: 

 to check if program update is available and to download it 

 to download currency rates 

 to send reports to SDL Trados Business Manager server when program crash occurs. 

These reports include information about installed version, your name and email (to be 

able to back contact) 

 to send email messages from within corresponding form (to send invoices, payment 

reminders, etc.) 

 to connect with a ProZ.com account and perform corresponding actions on the user's 

behalf (setting availability, post/edit WIWO entries, post/edit feedback on the Blue 

Board. When connection is established, information about logged user (user name on 

ProZ.com) is saved in the internal log 

 (optional) To connect to your database which may be stored on the cloud server 

This is all the data which SDL Trados Business Manager may send or receive online. If the 

Internet connection is turned off (or restricted), then the program will continue to work, but 

without the mentioned features. 

Even if you are using the application as a ProZ.com Plus package subscriber, you may 

disconnect from the Internet for up to 14 days past login. After that, the application will require 

to check your profile to confirm that the Plus subscription is still valid. 



Installing SDL Trados Business 
Manager Team (desktop version) 

This is how you install SDL Trados Business Manager. 

Procedure 

1. The SDL Trados Business Manager installers are available for download from your SDL 

Account. Download and run the installer. In the first step of the installer wizard, the 

license agreement page, carefully read the information, accept it and select Next. 

2. In the Select Installation Folder page you can browse you folder destination. 

By default, SDL Trados Business Manager will be installed into your Documents folder. 

This allows to keep the program installation data, settings and database (in case it will 

be used in local mode) in one place, which makes the program fully portable (you can 

move it to another computer, cloud drive or USB drive without the need to install it on 

another computer). If you change the installation path to Program Files (x86), the 

program will be separated from database and settings files, which will be stored in 

the Documents\SDL Trados Business Manager\database folder by default. Later you 

will be able to change a folder where to store program settings and database file. 

Note: If the application is installed into the Program files folder, and you want to keep 

database file in the same folder, then the program must be run with administrator 

rights. 

3. Click Next and then Install. When the installation is completed, a SDL Trados Business 

Manager shortcut is added on your desktop and a group in the Start menu. 

Note. If the program does not run, please check that you have .NET Framework 4.7 

installed on your machine (the setup will ask to install it, if it is missing). 

4. On first launch, to logon into the application, use the following credentials: user 

name: Admin, password: User@TBM (case-sensitive!). After first login, you can go to 

the Other tools > Users > Admin, and change password to blank - it will allow to run 

application without password prompt, if you don't need security. 



Moving the SDL Trados Business 
Manager installation to a new 
computer 

To install SDL Trados Business Manager on another computer and move data from previous 

one, you have to do the following: 

Procedure 

1. Run the installation file and install SDL Trados Business Manager. 

 If SDL Trados Business Manager was installed outside of the Program 

files folder, copy the following files from previous computer to the same 

locations on a new computer: 

 InstallationFolder\database\baccsdb.sdf 

 InstallationFolder\settings.bin 

2.  

 If SDL Trados Business Manager was installed inside the Program files folder, 

copy the following files from previous computer to the same locations on a new 

computer (considering that you install SDL Trados Business Manager into the 

Program files folder again, otherwise copy these files to a place mentioned in 

point 2a): 

 Documents\SDL Trados Business Manager\baccsdb.sdf 

 Documents\SDL Trados Business Manager\settings.bin 

3. If you use the network version, there is no need to copy the baccsdb.sdf file. 

Only settings.bin file is needed, as it contains information about network location 

of your database. 

Installing SDL Trados Business 
Manager Team Online (web version) 

Web-version of SDL Trados Business Manager is an ASP .NET application, which can be 

installed on a server running under Windows Server operation system with Internet 

Information Services installed. Although configuration and installation of operating system and 



environment can't be covered by this article, it will provide some basic information about 

system components and application itself. For secure environments, configuration will require 

more work of qualified system administrator. 

To install and run Business Manager in on-premise mode, you need: 

 Windows Server operating system 

 .NET Framework version 4.7 

 Internet Information Services feature 

 Database engine (Microsoft SQL Server will be used as an example in this article) 

 SDL Trados Business Manager Team Online installer 

Installing Internet Information Services 

After clean installation of Windows Server, it is required to install Internet Information 

Services for installation of Business Manager Online. To install IIS, follow these steps: 

1. In the Server Manager window, select Manage > Add roles and features. 

2. On the Server Roles step of the wizard, select Web Server (IIS) feature. Click Next. 

3. On the Features page, make following selections: 

.NET Framework > ASP.NET 4.6 

4. On the Web Server Role (IIS) > Role services page, make following selections: 

Web server > Common HTTP features > HTTP Redirection 

Web server > Performance > Dynamic Content Compression 

Web server > Security > Basic Authentication 

Web server > Security > URL authorization 

Web server > Security > Windows Authentication 

Web server > Application development > ASP 

Web server > Application development > ASP.NET 4.6 

Web server > Application development > ISAPI Extensions 

Web server > Application development > ISAPI Filters 

Management tools > Management service 



 
 

5. Click Next > Install to finish installation. 

Installing Microsoft SQL Server 

Basic information about installing Microsoft SQL Server engine can be found in this article. 

However, on step 7, instead of Mixed authentication mode, you may leave Windows 

Authentication mode. In this case, you need details of a Windows user who has access to a 

database server. 

Installing and configuring SDL Trados Business 
Manager Team Online 

1. Download recent build from your account (sdl_business_manager_online_version.exe). 

2. Install it on server. Default installation location: C:\inetpub\SDL PLC\SDL Trados 

Buusiness Manager Team Online\ 

3. Open IIS Manager and do the following: 

a. Do one of the following: 

A. right click on Sites and select Add website...; or 

B. In the list of websites, select Default web-site, which is created in IIS 

automatically, and click Basic settings... in the right menu; 



b. Specify Site name and Physical path (insert installation folder path): 

 
c. In the Bindings group, specify domain name, if you have any. Otherwise, leave 

this field empty to run website under localhost. 

d. Click OK to finish creating website. 

e. In the Features View of a created website, double click Authentication, right 

click on Anonymous Authentication, select Edit and then select Application 

pool identity in the opened dialog: 

 
f. Switch to the Application pools view, right click your application pool and 

select Advanced settings... 

g. Select true for Enable 32-bit Applications parameter (it is mandatory); 

additionally, you may follow this screenshot to adjust additional parameters: 

 



Important. If Microsoft SQL Server uses Windows authentication, on this step 

you also have to check Identity parameter. By default, its value 

is ApplicationPoolIdentity. However, you may need to specify another user 

here, who has access to SQL server engine with DBCREATOR rights. 

h. After saving changes, website will be automatically restarted. You may select it 

in the list of sites and click Browse localhost on *:80 (http) item in the right 

panel (in case you didn't specify bindings on the step c). 

4. From Start menu (or from Configurator folder, which can be found inside application 

installation folder), run configuration utility. 

 
 

a. Click Install/uninstall license to install license for application (process is 

default for all single-user SDL products); 

b. Specify database connection parameters in the Database configuration section. 

Depending on installed engine and authentication mode, provide database 

server location, database name (it will be created automatically upon first 

launch of the application), and, optionally, user name and password to access 

database engine. 

c. Click Apply configuration to save database connection settings. 

d. Switch to IIS manager and restart application pool and website (select website 

or application pool on the left panel, and then click Stop and Start buttons on 

the right panel). 

5. If application runs correctly, you will see logon window. To logon into the application, 

use the following credentials: user name: Admin, password: User@TBM (case-

sensitive!). 

Launching the application 

After first installation, as noted in the corresponding articles about installing SDL Trados 

Business Manager, you will be prompted to enter user name and password: 



 

By default, with clean installation, system creates 2 users: Admin (password is User@TBM) 

and User (password is blank). Admin has full access to database, while user has no access to 

any data except own logon details. After first logon, it is highly recommended to change default 

password. You can manage users under Other/tools > Users section: 

 

Depending on assigned role, users can be restricted to edit and even view other users. To 

change own password, select own user or click user name in the top right corner of the 

application and select My details. On the user page, click Change my password or Generate a 

new password for the selected user button: 

 

On the Change password dialog, you have to follow these rules for setting new 

passwords: password should have at least 1 lowercase letter, 1 uppercase letter, 1 number, 1 

special character and be at least 8 characters long. 

Administrators can't view password of other users. Instead, in case of loosing a password, 

administrators can only reset passwords and inform users about newly generated passwords. 



Notice about user locking 

In Online version, it is important to logoff the application at the end of a session. Main reason of 

this is number of users provided by a license. Usually license includes a number of users which 

are allowed to use application at the same time (this number does nit include vendors and 

customers). This number is counted by a number of logged in users. If you just close a browser 

tab without logging off, your user will still be counted as logged in, which could prevent others 

from logging into system if user limit is reached. Additionally, particular user name can't be 

used for logging in on another machine until that user logs off. However, application will 

automatically release a user in case of 15 minutes of inactivity. So, even if you forget to log off, 

your user will be available for logging in on another machine in about 10-15 minutes. 

SDL Trados Business Manager 
localization 

The SDL Trados Business Manager user interface is available in the following languages: 

English, French, German, Italian, Japanese, Chinese, Polish, Russian and Spanish. 

About this task 

However, SDL Trados Business Manager provides the means to manually localize the software 

into any desired language. If you like to add new localization language and make corrections in 

the existing localization, do the following: 

Procedure 

1. Launch the program, select Tools tab on the ribbon and select Edit model. 

2. In the Model Editor, expand the Languages drop-down and select the desired language 

or, if the desired language is missing, select Languages manager. 

a. If desired language is missing, add it via Languages manager. Select Add and 

select a language. 

3. After selecting target language, select Localization. Localization window will be opened. 

4. Filter the Is Calculated column (false, or unchecked) and the Is Translated column 

(false, or unchecked) to display only those rows which need localization. 

5. (Optional) Select Translate to automatically translate strings using Microsoft 

Translator. 

6. You can manually translate necessary strings in this window 



7. Select Save to save your translation. 

8. Select all displayed rows, then select Export > Selected rows. The exported .csv file 

can be opened with any CAT tool. If you need current translation memories for existing 

localization languages, write to app-signing@sdl.com. 

9. After localization, select Import to import translated results. 

10. (Optional, but recommended) Send the translated .csv file to app-signing@sdl.com. 

Quick Start 

This topic contains condensed instructions to get you to quickly start working with SDL SDL 

Trados Business Manager. 

First of all, when you run SDL Trados Business Manager for the first time (clean installation), 

you will be prompted to enter a password. By default, user name is Admin, and password 

is User@TBM. After logging in, you can go to the Other/tools > Users, select Admin user and 

change its password (and even set to blank, so logon window won't appear when you launch 

TBM). 

When you first open SDL Trados Business Manager, a First run assistant provides initial setup 

instructions. You can also access the assistant through the Tools tab. 

The more settings and reference data you enter to begin with, the better. But it is hard to fill in 

this type of baseline information in any program until you get a feel for the program itself. Here 

are the minimum fields that must be completed before you create your first job. 

Set up reference data 

About this task 

Set up basic settings for your work environment in the Reference data tab. 

Procedure 

1. Select Reference data > Languages and check if all the languages that you will work 

with are in the list. If not, select New > Language in the ribbon and enter the language. 

Select Save and Close and also close the Languages tab once you are done adding 

languages. 



2. Select Reference data > Language pairs and then select New > Language pair in the 

ribbon. Use the drop-down to select source and target languages. Close the Language 

pairs tab. 

3. If you need to add to the default currencies (USD, GBP and EUR), select Reference data 

> Currencies and then select New > Currencies. 

4. Select Reference data > Taxes and add one or more taxes with their percentages. 

5. Select Reference data > Payment methods and add a payment method - add the name 

(the name will appear on the invoice), the currency and other details. 

Set up application 

Procedure 

1. Go to Tools > Settings. 

2. In the Main data and contact details tab, complete the details you need for your first 

invoice. 

3. In the Application settings, p1 tab, complete base currency and default language pair. 

4. In the Invoice settings tab, select an invoice template. 

5. Save your changes. 

Create first job 

Procedure 

1. Go to Workspace > Translation jobs and select New > Translation job 

2. Change the deadline date. 

3. Select or add a customer. 

4. Select or add a PM (client contact) for that customer. 

5. Check that the currency and language direction are correct. 

6. In the job details window at bottom of the job window itself, add a new task and specify: 

a. Work type (translation, revision, DTP, etc.) 

b. Quantity (number of words, hours, etc.) 

c. Unit (source word, hour, line, etc.) 

d. Rate 

7. Select Save and Close. You will see the job in green because its status is 'Processing'. 



Finish the job 

Procedure 

1. Go to the Translation Jobs view and double select the job row. 

2. Insert the delivery date. 

3. Select Save and Close. The row turns to red because the status is 'Sent'. 

Invoice the job 

Procedure 

1. Go to the Translation Jobs view. 

2. Select the job row (select arrow furthest left). 

3. Select Create invoice from the ribbon 

4. Set the invoice due date in the Term date picker. 

5. Select the default payment method or add a new one. 

6. On the the bottom-right of the form, add any taxes or discounts. 

7. Save changes. 

8. Select Print invoice. 

9. In the Print Preview tab, edit the invoice and print it as you wish. Of course, do not 

forget that when you have got time, you will need to return to the Reference Data tab 

to complete more default values, open the newly-created customer to complete more 

details there, and even customize an invoice when you have got all the rest under 

control. 

Network setup 
When SDL Trados Business Manager is used by teams, an option with local database storage 

becomes unsuitable. All users in your teams must have access to the same data. This means, 

this data must be stored in some central location, which must be available for all users. 

This location is called a database server. This server may be located on your local network or 

on the Internet. For now, SDL Trados Business Manager supports two commonly used types of 

database servers - Microsoft SQL Server and PostgreSQL. You can choose an option which 

better suits your needs. 



The free edition of Microsoft SQL Server (SQL Server Express) has a limit of database file 

size, which is set to 10 GB. Since SDL Trados Business Manager allows to store files directly in 

the database, this limit may be quickly reached. You will then have to switch to paid version of 

SQL Server (SQL Server Standard). 

Another option is PostgreSQL the free and open-source database engine which offers not only 

unlimited database size, but can also be installed on servers running on Windows, Linux or 

Mac. Another advantage of this system is installation file size - it is just only 160 MB, and this 

package includes database management utility, which can be used, for example, to backup and 

restore your databases. For example, to get similar GUI tool for SQL Server, you have to 

download additional large package (greater than 1 GB). With the default installation you only 

get a command line tool to perform database maintenance operations. 

For simplicity, we recommend the use of PostgreSQL, as it provides similar performance as SQL 

Server, has no limits for database file size, it is free (Standard edition of SQL Server costs 

several thousands of US dollars), installation is much faster and a server can be installed on any 

operating system. 

With that said, to setup SDL Trados Business Manager to work in network mode, you need to 

select a server (physical computer to store data) and install PostgreSQL or Microsoft SQL 

Server on it. You have the following options: 

1. Use own computer as a server. It must be accessible by other workstations in your 

network. Usually this method is the best choice for small teams working in a single 

office, where local network is established. This method is also the fastest one, because 

data in a local network usually transferred much faster comparing to Internet. 

2. Rent SQL Server Database in the cloud. For example, in Azure. Using this method, you 

will be able to create database on special management page, get its details and enter 

them in the program settings. 

3. Rent cloud virtual private server. You will get virtual PC which may be accessed via 

Internet. Such virtual servers have Microsoft Windows Server or Linux operating 

system pre-installed. You can install database engine, configure it and connect it from 

within SDL Trados Business Manager from any location in the world. Microsoft SQL 

Server 2017 got support of Linux systems. 

Options 1 and 3 require you to manually setup server computer and install database server on 

it. Options 2 and 4 allow to avoid all these actions and immediately get a server database which 



is ready for use. Information about rent charges is provided on the SDL website. Also you may 

analyze prices in Azure or Amazon Web Services. 

In network mode, teams will be able to fully control access rights of each user. Files attached to 

projects, jobs and sent messages will be available to all users, since they are stored in the 

database. Invoice templates and other printing forms will also be available to all users, 

regardless of workstation where this template has been created. 

Installing PostgreSQL 

This section contains information about installing and configuring PostgreSQL database engine. 

See nested articles, which contains detailed information on this subject. 

PostgreSQL installation 

The installation of the PosgreSQL database management engine is fast and simple. You can get 

a database server up and running in about a minute. 

Procedure 

1. Go to the PostgreSQL website (https://www.postgresql.org/download/windows/). 

2. Select Download the installer and choose the correct installation package (according 

your operating system). Depending on operating system, you will see different 

instructions for installation. 

 



3. Run installer and follow the procedure for installation. 

 
On the component selection step, you can remove Stack Builder: 

 
4. During installation select admin password, as it will be required to connect SDL Trados 

Business Manager to PostgreSQL server. 

 



5. Leave default port: 

 
6. Proceed to finish instalation. 

PostgreSQL configuration 

Procedure 

1. After installation, open the PosgreSQL port (5432 by default) in the Windows Firewall. 

2. To allow connections from remote computers to a server, open pg_hba.conf file 

(PostgreSQL installation directory\data) and add these strings at the end 

of the file: 

host all all 0.0.0.0/0 md5 

host all all ::/0 md5 

3. After that, open Windows Services (Win+R and type services.msc), find PostgreSQL 

server service and restart it to apply new configuration. 

Connecting client computers to 
PostgreSQL server 

1. Run SDL Trados Business Manager in local mode and open Settings. 

2. Go to the Database settings tab. 

3. Select Turn on network mode. 

4. Select PostgreSQL as Database engine. 

5. Database server path: type localhost if you run SDL Trados Business Manager from 

the same PC where PostgreSQL is installed, or type computer name or IP address of a 



server. Ensure that server PC is available (visible) over network (in case you setup it in 

local network). 

6. Database name: any name you wish to use for database. 

7. Database user name: user name you selected during PostgreSQL installation ( 

postgres, by default). 

8. Database user password: password you selected during PostgreSQL installation. 

9. User name (for chat): leave empty, as this field is not used now. 

Database backup 

Procedure 

1. After installation, run the pgAdmin 4 utility, which was installed along with the server. 

It may look like: 

 
2. Enter your password and confirm that server works correctly. Enter the prerequisites 

here (optional). 

3. From within SDL Trados Business Manager, you can create and restore backups only 

when the program in local mode. With network mode, backups are created using 

corresponding database engine (PostgreSQL, in this case). 

4. Expand server - Databases - find your database, right click on it and select Backup. 

 



5. Specify file name, select compression ratio if your database file size is large enough, and 

select Backup. 

 

Database restore 

About this task 

To restore database from backup, follow these steps: 

Procedure 

1. Open pgAdmin utility and delete database you wish to restore. 

 
2. Create an empty database with the same name. 

 



3. Right-click on the created database and select Restore. 

 
4. In the shown dialog, specify backup file location and select Restore. 

 
5. After the restore operation completes, you can connect to the restored database. 

 

Installing SQL Server engine 

This topic shows you how to install and setup Microsoft SQL Server database engine. 

About this task 

To setup SDL Trados Business Manager in network mode, it is necessary to install database 

server first. Another option is to rent database in the cloud (for example, Azure or Amazon Web 

Services). In this case, you will simply get server name, user name and password for your 

database, which may be specified in the program settings. 



But if you have local network with access from all workstations, an option with installing SQL 

Server Express will be preferred in most cases (take a note on database file size limit in this 

section description ). 

Procedure 

1. Go to the Microsoft website and download SQL Server 2014 Express installation file. 

You can download it from here: https://www.microsoft.com/en-

us/download/details.aspx?id=42299  

2. Select Download and select the smallest package to download (Express 

64BIT\SQLEXPR_x64_ENU.exe or Express 32BIT\SQLEXPR_x86_ENU.exe, 

depending on your platform). 

3. Run the installer, and select New SQL Server stand-alone installation or add features 

to an existing installation. 

 
4. On the Installation type page, select Perform a new installation of SQL Server 2014. 

If no SQL Server instances are installed on your computer, this step will be 

automatically skipped. 

5. On the Feature selection step, it is enough to select Database Engine Services. You 

can deselect the other options. 

 



6. On the Instance configuration step, specify instance name or leave default 

(SQLEXPRESS). 

 
7. On the Database configuration step, select Mixed mode (SQL Server authentication 

and Windows authentication) and specify password for the instance being created. 

 
8. Select Next to start the installation. 

9. Select Close. 

10. SQL Server is installed and ready to be used. You can run sqlcmd utility and create 

empty database (in the desired location). Otherwise, it will be created automatically by 

SDL Trados Business Manager in the next step. 

Connecting SDL Trados Business 
Manager with database server 

After SQL Server or PostgreSQL instance is installed or prepared in the cloud, you can start 

configuring SDL Trados Business Manager to connect with it. 

Before you begin 



Before you start, please check that you have the following details: 

 SDL Trados Business Manager license code for network version 

 Database server network instance path (for SQL Server, it will have a form of 

[ServerAddress]\[SQLInstance], where default SQL Server instance name is 

SQLEXPRESS; for PostgreSQL, it will be ip-address of server or localhost, if server is 

installed on the same computer where you are installing SDL Trados Business Manager) 

 Database server user name (default administrator user is sa for SQL Server 

and postgres for PostgreSQL) 

 Database server user password (specified during installation) 

Procedure 

1. Run SDL Trados Business Manager. It will start in local mode, and local database will be 

created. If you previously worked with the program and already have some data, it will 

be possible to transfer it later. 

2. Open program Settings and switch to the Database settings tab. 

 
3. Check Turn on network mode checkbox, then select desired database engine and fill-

in provided fields with the data you previously prepared. 

4. To check if provided details are correct, select Check connection (visible only if SQL 

Server database engine is used). 

If everything is ok, you will see the corresponding message. If you provided wrong 

details, then you may experience a small delay before message appears to inform about 

incorrect details. 

5. Select Save changes and restart the program to apply new database settings. 

Results 

After successful start you will get a new empty database available for access from the network. 

Now you can import data from the local database or simply start working with an empty 

database. 



Moving data from local database to 
server database 

If you decided to switch to network mode, but previously used the program in a local mode, than it 

may be required to transfer old data to a new database. 

Procedure 

1. Run SDL Trados Business Manager in the local mode. 

2. Open program Settings. 

3. Select Export all data to Json file. 

4. Select file name and folder to save exported file. 

5. In the Settings form, switch to Database settings tab and provide details of your database 

server. 

6. Restart the program and open Settings. 

7. Select Import data from Json file, select exported file and wait while operation finishes. 

 

This procedure doesn't allow to transfer custom reports, QuickReports, users and roles. To 

transfer reports, please export/import each template manually from the designer. For users and 

roles, it will be required to re-configure them manually. 

Application update 

The application has an auto update mechanism. It checks for a new version on launch, and if 

the new version exists, you will see the corresponding notification. 

Select Update available to launch Updater tool. It will check your current version and 

perform necessary actions to update the program to the latest version. Before update starts, it 

will show full list of changes since installed version until the version being downloaded. 

Select Update and wait until the process finishes. If you keep your program up to date, then 

update process will go quickly, because patches usually take no more than 1 Mb. 



Note. When you use both desktop and web versions, upon releasing of a new update your 

version of web-application will be immediately updated. This means that desktop version will 

stop working until you update it as well. This happens because database version is increased 

with each release, and application may work only when application version and database 

version are identical. 

Program structure and navigation 

Application window contains three main areas: 

 

Ribbon menu 

This menu only contains different commands/actions, which depend on a currently selected 

window. 

It always contains the Quick job creation button, to quickly create new jobs on a base of 

previously entered jobs. When you edit some data, buttons to save and close form will appear 

here. In lists you will see filtering, printing, view variants changing buttons. Hover mouse 

pointer over any button to see its description, keyboard shortcut, or to understand why 

particular button is currently disabled. 

By default, ribbon menu contains the following tabs: 

The Home tab is the main program-wide commands and commands specific to a currently 

opened tab. 

The View tab contains duplicate of the navigation tree, application theme selector, and a button 

to organize currently opened tabs. 



The Tools tab contains additional useful commands, like Settings, Backup, Model editor, Mail 

sender. 

The Support tab contains few buttons to get help about SDL Trados Business Manager: links 

the manual, forums, social pages. 

Navigation tree 

Allows to open new views/tabs in the work area. 

 

Navigation tree contains few main sections: 

Workspace (to access dashboards and documents, like jobs, invoices, assignments), 

Reference data (to view/edit reference data tables, like customers, contractors, units, 

languages, etc.), 

Other/tools (contains different service windows), 

ProZ.com (contains windows for consuming ProZ.com services from within SDL SDL Trados 

Business Manager) 

Reports (provides access to extensive reporting engine, which includes invoice/quote/PO 

templates, CV templates, custom reports and quick reports). Each item may have an arrow on 

left showing that it has nested items. For example, Main dashboard item has nested items to 

open other variants of a dashboard. 

To faster find necessary item in the navigation, you can use search box at the top of it. 



Work area 

Used for viewing/editing data. SDL SDL Trados Business Manager uses tabbed UI to display 

views. 

You can open any number of views simultaneously. When you close the program, currently 

opened set of views will be saved and re-opened on a next launch. Selecting any navigation 

item in the navigation tree opens corresponding form (view) will be opened in a separate tab. 

You can easily switch between tabs with the mouse or using Ctrl-Tab or Ctrl-Shift-

Tab shortcuts. Small preview is displayed to help with selection of a tab. 

To close active tab using keyboard, press Ctrl-W. To close all opened tabs, press Ctrl-Shift-W. 

In addition, you may move tabs, unpin them from main panel, and display side by side. Just 

start dragging any window by selecting on tab header, and then drop it on any place of you 

screen or on special pinning icons which are displayed during dragging. When dropped on such 

pinning icons, the window will stick to another opened tab. In the example 

below, Invoices window was sticked on the right of Translation jobs tab. 

 

When any tab is opened, Home tab of the ribbon was filled with a number of commands. 

Depending of the currently opened entity type, composition of such commands will be 

different. First two buttons are usually the same - they allow to create new empty entity or 

clone currently selected one. 

 To edit selected row, simply double click on it. 

 To delete it, select Delete in the Edit group on the ribbon or press Сtrl-D combination 

on the keyboard. 

The same commands are always available via context menu. 



Data dependency between tabs 

Information in one tab may depend on information created, edited or deleted in another tab. 

For example, if you change the customer name in the Customers tab, and then switch to 

the Translation jobs tab, then you will still see the old customer name of the customer you just 

changed. In this case, hit the F5 button on the keyboard or select Refresh on the ribbon (if 

there are unsaved changes, you have to save them before doing this). Such behavior is by-

design, and is used to improve performance. 

In special cases, when edited data is critical in terms of business state, information in other tab 

will be updated automatically. For example, when you create or edit payment over invoices, 

then after saving a payment and switching to Invoices tab you will see updated data, without 

need to refresh the table. In most cases, data is refreshed automatically, and the shown 

example with customer name when manual refreshing is needed is a rare case. 

Software configuration 

Information about application configuration. See nested articles for detailed information. 

Program settings 

To open application settings, select gear icon in the quick access bar or in the Tools tab of the 

main ribbon: 

 

Nested articles describe each page of the application settings. 

Main data and contact details 

Here you specify your name, company name, VAT number, time zone, address, web pages and 

license code. Also it is possible to upload a photo (which then can be included into your CV, for 

example). 



 

List of fields which may require special attention: 

Full address. When you enter any data into address fields (city, address line, zip code, 

etc.), Full address field will be filled automatically. At the end, you can manually edit contents 

of this field according your preferences. However, if you will make any edits in address fields in 

future, Full address field will be automatically re-composed, and you will loose manual 

changes. 

Web-app URL. This is the url-address for the web-part (SDL Trados Business Manager Team 

Online instance). When this field is given a value it serves as a signal that you have the web-

version of SDL Trados Business Manager. This URL will be used to build links to entities 

(translation assignments, jobs, projects, etc.) and to insert them into mail message bodies. 

Integrations 

 

This page allows to configure integration settings with external systems. 

SDL Trados projects folder 

Allows to specify a folder where projects.xml file is contained. When configured, you can directly 

import analysis reports from SDL Trados Studio without running Studio. 

GroupShare 

GroupShare server address and login details. required to used GroupShare integration, which is 

described in a separate section of the manual. 



Click Check connection… button to check if specified credentials are valid. If you get error 

message, please check if server address, login and password are entered correctly. 

ProZ.com 

Allows to connect SDL Trados Business Manager to ProZ.com account to use extensive integration 

features (Blue Board, WIWO). See separate section in this manual for details. 

Cloud drives 

SDL Trados Business Manager allows to connect to Dropbox, Google OneDrive and Microsoft 

OneDrive to insert links and share files stored on cloud drives, without downloading them locally. 

Here you can use Connect... and Disconnect from... buttons to establish connection with your cloud 

drive accounts. 

Application settings 

Application settings are divided into 2 tabs: Application settings, p1 and Application 

settings, p2. 

Application settings, p1 

m 

Database/settings storage path 
 

When the program was installed into the Program Files folder and user does not have 

administrator rights, then your settings and database will be stored 

at User\Documents\SDL Trados Business Manager folder by default. Otherwise, 

settings and database file are stored in the same folder where SDL Trados Business Manager is 

installed. You can change and copy database/settings files into the custom location (for 

example, it could be a older synced with cloud drive). 



Click Zoom icon in this field and select a new folder. The program will offer you to copy 

existing database into a new location. When done, it will be required to restart the program. 

Old database file would not be deleted automatically, you have to do it manually. This is done 

for safety reasons. 

To restore default path, select Cross icon. Again, the program will offer to copy your database 

file back to default location. 

Base currency 

The base currency is used to convert amounts from different projects (which may be in 

different currencies) into a single one using today's conversion rate. 

For example, choose USD as base currency (as seen in the screenshot). In this case, if you get a 

project in EUR, than it will contain two total amounts: in EUR and in USD. The amount in EUR 

will be used to track balances, but the amount in USD will be shown in the total calculations, 

which involve projects in different currencies. Example: 1st project - total 100 USD (100 USD in 

the base currency). 2nd project - 100 EUR (~115 USD in the base currency, if the conversion 

rate is 1.15). Then, the total amount for both projects: 100 EUR and 100 USD (215 USD in the 

base currency, which for example will be shown in the Dashboard). It is possible to change the 

base currency when you already have entered some jobs or invoices, but it will require some 

additional actions to recalculate the base currency for the existing documents. 

After saving settings, open the Settings window again and click Recreate transactions on the 

ribbon. All the amounts will be recalculated into the new base currency (provided you have 

entered the necessary currency rates). 

Many tables in SDL Trados Business Manager contain Amount (base currency) column. This 

column contains an amount converted to the base currency (if document's currency differs 

from it). It allows to get meaningful totals in any table, expressed in one single currency. Such 

columns will be automatically renamed to include your base currency name in brackets. 

Earning accounting type 

Allows to specify a method of determining a date when creating a record in the Ledger. In other 

words, a date when earning/expense is accounted. 



Possible values are By date and By deadline. In the first case records date in the ledger will be 

determined by the job date. In the second case - by the job deadline. 

Earning accounting method 

This setting has three choices: Job-based, Invoice-based and Payment-based. It specifies 

when to add transactions into the Ledger and Balance sheet. 

If the first option is selected, then when a new job is created, you will see increased income and 

debt from the client. But if you select the second option, job creation will lead to nothing, while 

invoicing of this job will mean income registration and increase of the debt from the client. 

Note. If you change this setting, it will be necessary to select Recreate transactions button on 

the ribbon. 

When Invoice-based method is used, the program will also track currency differences in cases 

when invoices are issued in a currency which is different from base currency. 

Example. You issue invoice on some day, specify amount, currency rate and amount in base 

currency. When a payment arrives, currency rate changes, which means you get different 

amount in base currency. Depending on direction of the exchange rate change, you may get 

more or less than expected amount. This difference is called currency difference and must be 

registered in the Ledger. SDL SDL Trados Business Manager tracks these changes and creates 

corresponding records in the Ledger on the date of payment arrival. 

Financial year start 

This setting allows to specify a date when financial year starts in your country. This allows to 

generate reports by financial year (instead of calendar year), and apply filter in lists of 

jobs/invoices/assignments/etc. by financial year and month. 

Default language pair 

You can specify the language direction, which will be applied for all added jobs by default. 

Default work type 

This work type will be used by default in all job tasks and quote items. 



Default fuzzy type scheme 

Specifies fuzzy type scheme and corresponding fuzzy discounts which will be applied to default 

prices during creation of jobs. 

Disabling price pick-up mechanism 

When you enter a new task in a translation job or assignment, the system tries to determine 

price based on selected customer, work type and unit. 

If explicit price not found, price pick-up mechanism is used to determine a price based on 

existing data. This mechanism uses adjustment factors you set for work types and units. 

For example, if price for Translation in Words is set to 0.1 USD , and you enter a task with 

Proofreading work type with Words unit (for which 0.33 adjustment factor was set), then the 

system will determine price according this formula: 0.1 * 0.33 = 0.033 USD. 

This checkbox allows to disable this calculation and apply only prices which actually exists in 

customer's or contractor's price-lists. 

Display language pairs as codes 

By default, when you select language pair (in a job, assignment, etc.), it is displayed as 

SourceLanguageName => TargetLangueName. 

To save screen space (especially in grids), you can select to display language pairs as codes 

(example: en-gb => ru-ru). To do this, mark this checkbox, and a shorter notation will be used 

for language pairs everywhere in the application. 

Use DirectX for rendering 

Allows to enable DirectX usage capabilities to improve rendering in different application 

screens. 

Allow self-registration for vendors 

When turned on, logon screen on web-portal will contain Register button, which allows 

visitors to self-create new vendor accounts. 



Numbering 

These fields (separate for invoices and translation jobs) allows you to set the rules of the new 

number generation when a new job or invoice is created. 

The default value is Sequential, which means that numbers are assigned in sequential order (1, 

2…10). Also you can select Per client code value. In this case, each client will have its own 

numeration, and the document number will include a special prefix (client code). 

Invoice/job/quote/assignment number format 

These parameters allow you to set-up number generation for each type of document. In SDL 

Trados Business Manager, document has numerical numbers. To provide ability to represent 

these numbers in desired form, there is a second string field, which is formed on the basis of 

specified rules. This is the start of your concept. 

You can use any symbols here and a number of variables (numeric document number, date and 

client code). These variables are placed inside curly brackets. You may also apply additional 

formatting to each variable by specifying format after a colon sign. For example, if you want to 

get a number which contains some prefix, followed by 6-digit number and year, use the 

following string: 

prf_{0:d6}_{1:yyyy} 

Here is prf is our prefix, followed by variable 0 (document number) formatted as 6 digits, 

followed by date formatted as four numbers of the year. 

You can see a number of examples below these fields showing how to use these parameters. 

Also, each field contains a zoom button to test and find out the string format which suits your 

needs. Also, near the zoom button, there is another button with the arrow which allows to 

apply formatting string to all documents. For example, you used 4-digits number for jobs (like 

{0:d4}), but now the number of jobs increased above 10k entries. To re-format all previous 

numbers, change formatting string to {0:d5} and select Apply format to all jobs. In the result 

the new format will be applied (for example, number 0345 will turn into00345). 

Currently, the following variables are available: 

{0} - document number 

{1} - document date 



{2} - client code 

{3} - currency name 

Automatic backup 

This group allows to set-up auto-backup system. 

When turned on, please select a Folder to store database backups. If something will happen 

with your database, you will be able to restore it from one of backup. By default, the system 

creates backups for 5 days (5 copies). Backup is created when program closes and before 

update installation. When you change backup path using Zoom icon, then the program will 

offer to move all existing backup files into a new folder. 

It was noticed that automatic backup and restore system does not work on Mac computers 

running Windows on virtual machines. In such cases it is recommended to create backup 

manually by simply copying sdf file into a safe place. Current path to a database file can be 

found in the application status bar (bottom left). 

Auto download currency exchange rates 

Allows to setup automatic downloading of currency rates on the program startup. 

Select source of rates and up to three currencies to switch this feature on. Clear values in the 

Currency 1, Currency 2 and Currency 3 fields to turn this feature off. 

Automatically send information about errors to SDL Trados Business Manager 

developer 

This checkbox controls program behavior when any error occurs. When checked, the program 

will automatically send bug report to the SDL SDL Trados Business Manager server. This report 

contains information necessary to quickly fix the bug. You can view copy of this information in 

the SDL Trados Business Manager.log file, which can be found in the SDL Trados Business 

Manager installation folder. This information does not contain any private data. 



Application settings, p2 

 

Custom quick deadline values 

Allows to create predefined values for quick selection in fields for entering deadlines (in 

projects, jobs, assignments). 

You can define most commonly used time periods, and values may include not only specified 

time of a day, but also number of days which will be added to a document date. 

Examples: end of day in 3 days; tomorrow's afternoon. 

Checklists 

In this group you can define default checklists added to a newly created translation projects, 

translation jobs and translation assignments. 

Main service types 

In different parts of the application, it is obligatory for system to know, which service 

corresponds to Translation, Proofreading and Editing work types. In this group you can set this 

correspondence. 

Notifications 

You may send notifications to necessary users about created/edited projects and jobs. 

For example, when administrator create some project, selected responsible person or all 

managers of your organization could get notifications about this action. Notifications appear 

when user logs in into application (or during 10 minutes, if a user is already logged in). The 

only requirement to make notifications working is to link your staff members created in 

the Contractors list, with users created in a Users list. For this, Associated contractor field of 

a user entity is used. System considers all users with Contractor employment type as managers. 



In this group of settings, you may specify if system should send notifications to all managers 

when someone creates or changes status of translation projects and translation jobs. 

Audit trail settings 

This section allows to enable or disable audit trail functionality in the following entities: 

 Quotes 

 Translation projects 

 Translation jobs 

 Translation assignments 

 Invoices 

 Incoming invoices 

 Payments 

 Outgoing payments 

See Audit trail article for detailed information. 

Invoice settings 

 

Default tax. This tax will be automatically added to all rows in the invoices. Of course, you can 

delete tax in particular rows or select another one. To make it possible to choose the default 

tax, please add it in the 'Taxes' reference data. 

Accent color. This is the main color used to style elements in your invoices. 

Invoice template. Here you can select the invoice template. There are 7 built in templates, and 

you can create any number of custom templates using built-in template designer. Additional 

details about the invoice designer can be found in the corresponding section of this manual . 

Invoice signature text. This text is added to the bottom of the printed invoice. Usually it 

contains some kind of 'thanks' to your clients. 



Invoice numbering settings group contains the following parameters. Numbering reset date 

option allows to select a date, from which the program should start new numeration chain for 

invoices. Reset numbering each year and Reset numbering each month check-boxes allow 

you to have a new numeration sequence each year or month. 

The Default file name parameter allows you to setup a default file name when the printing 

form is exported to some file. There are a number of available variables you can use to generate 

file name: 

 invoice number 

 invoice date 

 customer code 

 customer category code 

 PO number (PO number of a first job in an invoice, if invoice includes multiple invoices) 

The Invoice save folder, respectively, allows you to specify the default location to save the 

exported documents. 

Common numbering with credit notes 

When this option is checked, credit notes and invoices will share same numeration sequence. 

For example: invoice 1, credit note 2, invoice 3. If you use per-customer numeration, then it will 

be taken into account, and next credit note number will be generated based on per-customer 

numeration sequence. 

Electronic invoices group allows to enable features to generate electronic invoices for Italy 

and Poland. 

The last field, Logo, allows to select an image file to display it in generated invoices. 

Job settings 

 

Reset numbering each year 

This checkbox allows to have a new numeration sequence each year. 



Default unit 

Allows to specify a unit which will be automatically pre-selected in all tasks created in 

translation jobs (including 'Prefill fuzzy types' command). 

Translation assignments settings 

 

Default PO template 

Allows to specify PO template used by default when application generates purchase order 

automatically (all cases except clicking drop-down button near Print button for an 

assignment). 

PO number format 

Allows to specify a rule to generate PO number in translation assignments. It also supports a 

number of variables which can be used in the same manner as number formats described 

above. To turn off PO number generation function, please leave this field empty. 

Automatically send notifications about new assignments 

Allows to send a message using default Assignment confirmation template (see message 

templates) to a contractor when a new assignment is created and confirmed. 

Reset numbering each year 

Allows to start new numeration sequence for translation assignment on the 1st of January of 

each year. 

Categorized list of assignments 

Check this box to add list of contractors in the list of assignments. You will be able to view 

assignments only of a contractor selected in the contractor list. 

Notify other candidates about assigned work 

This setting allows to enable feature, which automatically sends notifications to all candidates 

who still didn't answer if some vendor gets assigned to an assignment. Notification text is 

contained in a message template with 'Use as default for' value set to 'Automated notification - 

notification to candidate that a job was assigned to another vendor'. 



Quote settings 

 

Default quote template 

Default template used to generate quotes. You can also specify default quote templates for 

individual customers (in their respective editing views). 

Default payment terms 

Specifies default payment policy applied in all created quotes (except those which were created 

by Clone function). 

Always create a project on accepting a quote 

By default, when accepting a quote, the system creates translation project with multiple jobs if 

a quote includes multiple target languages. However, if a quote contains only one language 

pair, the system will create just one translation job when accepting a quote, without creating a 

translation project. This option allows to change behavior and force the system to always 

create translation projects when accepting quotes, even if they contain only one language pair. 

Scheduler settings 

 

The Scheduler settings tab group contains a few parameters. Calendar type field allows to 

select a service you use for scheduling: Google Calendar or Outlook Calendar. 

Translation jobs group contains parameter for creating events in the built-in scheduler and 

syncing them with cloud calendar. 

Invoices group, correspondingly, contains similar parameters for invoice. 

Use built-in scheduler option allows to turn built-in scheduler on or off (On by default). When 

turned off, job/invoice saving will be slightly faster. 



Sync with online calendar option allows to enable or disable Google Calendar or Outlook 

Calendar synchronization. On the first attempt to sync, a browser window will be opened to 

login into your Google or Outlook account. After that, the program will be able to synchronize 

automatically. Please note that SDL Trados Business Manager only sends data to the Google 

Calendar, but does not import your existing entries. 

Sync with Workload Planner option allows to create multiple records in a calendar according 

information contained in the Workload Planner tab of a job. System can help with planning 

periods of working on a job according your pre-defined work day period. When this option is 

checked, instead of one long entry which lasts from job date until job deadline, the program 

will create corresponding calendar entry for each day spanned over defined work period. 

Create entries only for delivery time. When checked, system will create an event in the 

calendar only for delivery time (1 hour before delivery), instead of an event spanning from 

starting time to deadline time. 

Note. Syncing with Google Calendar or Outlook Calendar will take more time if this feature is 

enabled, because it will be required to create multiple entries instead of one. However, it allows 

to get more clear picture. 

The Default scheduler entry contents. When a new translation job or invoice is created, the 

system creates the corresponding appointment in the scheduler (and in your cloud calendar, if 

needed). This parameter allows to adjust the text used as a header (summary) for that 

appointment. 

For jobs, you can use the following variables in this text: {0} - project number, {1} - project date, 

{2} - project name, {3} - client name, {4} - work field, {5} - average volume. 

For invoices, the following variables are available: {0} - invoice number, {1} - invoice date, {2} - 

invoice due date, {3} - client name, {4} - amount due, {5} - currency name. 

Productivity settings 

 

Turn on workload planner check-box allows to start using a feature which helps to track 

daily workload and facilitate in decision making process about accepting new jobs. You can 

read detailed information about this feature in the Workload planner article. 



Daily capacity specifies your daily outcome. It is calculated in weighted units. This means that 

each quantity is converted into some average volume using adjustments factors. For example, 1 

hours may correspond to about 500 translated words, or 1000 proofread words may 

correspond to 300 translated words. Adjustment factors are set in the Units list. 

Workday start/end time fields allow to specify your normal working day. Workday end time 

is used to automatically set time when determining deadline during job creation. 

Preferred job allocation method allows to select one of methods to automatically allocate 

jobs in the workload planner. Possible choices are Earliest delivery, Latest 

delivery or Evenly. 

Clear workload planner data for finished jobs 

This option allows to erase workload planner information when translation job status changes 

to Finished or Sent. It could be useful if you wish to clear picture in the Workload planner 

window, and see there only jobs which are actually in work now. 

CV/professional data 

 

This tab is used to provide data for the CV generation tool. It allows to set the following data: 

Personal slogan 

Career start year 

Education 

Skills 

Work experience 

Diplomas and certifications 



Languages 

Work fields 

Feedback 

References 

Professional software 

Other software 

Custom data 

Personal details and words to potential clients 

A full description of the CV generation tool can be found in the corresponding section of this 

manual. 

Vendor's portal 

 

Currently this tab contains only one setting - Allow vendors to edit only empty fields. It has effect 

only for web-version. When checked, vendors will be able to edit only empty fields in their profiles, 

while fields which already contain any information will be disabled for editing. 

Buttons in the Ribbon menu 

Except parameters listed in the above articles, the Settings form provides access to the 

following commands available in the ribbon menu: 

Edit custom fields - opens a windows which allows to create custom fields in the database. 

Recreate transactions - allows to recalculate accounting data. For example, after turning on 

workload planner new entries in the planner will be created only after re-saving existing job. 

After selecting this button all jobs (and invoices, payments, assignments, etc.) will be re-saved. 



Export all data to Json file - allows to create backup file containing all information from 

database and save it in a popular json format. 

Take a note that the following data won't be exported: 

 Custom templates (for quotes, invoices, etc.) 

 Custom reports 

 QuickReports 

 Users and roles 

 Custom fields 

For reports and templates, you can easily export and import them manually, one by one. As for 

role configuration, it will be required to re-configure them in a new installation. 

Import data from Json file - allows to import backup in json format. Also used to import data 

from SDL Trados Business Manager version 2. 

Clear user data - is used to erase database (except settings) and start from scratch. Usually 

used to clear demo data. 

Create demo data - allows to fill database with dummy data to quickly evaluate its functions 

without need to enter it manually. A number of customers, vendors, projects, jobs, invoices, 

payments and translation assignments will be created, which will serve as base data for built-in 

reports. 

Manage E-mail accounts - opens a window to create and edit e-mail accounts. Mail sender 

allows to select an account used to send mail messages. In each account you provide name 

displayed in the From field, login, password, SMTP server, port and SSL protocol usage to 

connect to an e-mail service provider. Mail sender feature allows to send invoices from the 

print preview window, payment reminders, offers to contractors, etc. You will find examples of 

parameter values for the most popular e-mail service providers (Gmail, Outlook and Yahoo) in 

the e-mail account editing window. 

Also, in the Tools tab of the ribbon you will find Create backup and Restore from 

backup buttons. The first command allows you to save your database in the desired place. The 

second one does the opposite operation, restoring saved data. After restoring, the application 

requires to be shut down and run again, to update the restored database if a backup was 

created in the previous version. 



It was noticed that automatic backup and restore system does not work on Mac computers 

running Windows on virtual machines. In such cases it is recommended to create backup 

manually by simply copying sdf file into a safe place. Current path to a database file can be 

found in the application status bar (bottom left). 

Files and folders 

On this tab, you can configure file storage parameters. 

 

SDL Trados Business Manager allows to create folder structure when you create quotes, 

translation projects, translation jobs and translation assignments. Folder names are specified 

using special pattern mechanism which supports parameters. Base folder for all other folder is 

specified in the Default folder with work files field. This will be a base folder on hard drive 

which will contain folders for quotes, projects, jobs and assignments. 

Then, you can specify separate settings for quotes, projects, jobs and assignments, in 

corresponding groups. Each group contains two parameters: Folder name 

template and Nested folders. In a folder name template, you can use variables listed below a 

field. To use any variable, find it in the list and type its name in the field (using curly brackets, 

as shown). For Date variable, you can apply additional formatting using default .NET 

formatting rules (can be found here). In the Translation projects group, for the Project 

number variable, you can apply additional formatting for numeric fields (description can be 

found here). To apply additional formatting, use the following notation: {1:formatting}. Some 

examples can be found in the Application settings article. 

When you specify folder name template, you can configure it to create folder not directly 

inside Default folder with work files, but in some nested folder. To do this, simply type '\' in a 

template. For example, this pattern will put job files into Jobs\2019\Customer1\0001 

folder: Jobs\{1:yyyy}\{2}\{0}. 

Available variables for quote folders: 



{0} - quote number, {1} - quote date, {2} - customer, {3} - customer code, {4} - specialization 

category, {5} - specialization, {6} - quote name, {7} - source language. 

Available variables for translation project folders: 

{0} - project number, {1} - project date, {2} - customer, {3} - customer code, {4} - specialization 

category, {5} - specialization, {6} - project name, {7} - PO number, {8} - source language. 

Available variables for translation job folders: 

{0} - job number, {1} - date, {2} - customer, {3} - customer code, {4} - specialization category, 

{5} - specialization, {6} - job name, {7} - project name, {8} - PO number, {9} - project number. 

Available variables for translation assignment folders: 

{0} - assignment number, {1} - assignment date, {2} - vendor name, {3} - base job folder, {4} - 

base job number, {5} - base project folder, {6} - base project number. 

Nested folders option allows to create additional folders inside main 

quote/project/job/assignment folder. To create a folder, type its name and press comma. After 

this, folder name will be converted into token. Nested folders can also be nested. For example, 

to create Style guide folder inside Reference files folder, type this: Reference files\Style guide. 

Mail sender settings 

Constant recipients 

Allows to specify comma-separated list of e-mail addresses, which will always be added to BCC 

field of all messages sent via built-in Mail sender. 

Send copies of mail messages to myself 

When checked, all messages sent from SDL Trados Business Manager will also be sent to an e-

mail address specified on the Main data and contact details tab. 

Add 'Sent with SDL Trados Business Manager' row at the end of messages 



Allows to support SDL Trados Business Manager and include link to the application web-site at 

the bottom of each generated message. 

Total size limit for mail attachments, Kb 

Allows to set limit for file attachments allowed to be sent with a message. Especially useful 

when mail message is generated automatically, when the process is not controlled by a user. 

Auto-upload to cloud drives section 

Cloud drive 

Allows to select cloud drive service used to automatically upload large files from Mail sender. 

To completely turn this feature off, select None in this field. If you select any cloud service here, 

be sure to correctly establish connection with chosen service on the Integrations tab. 

File size limit 

Allows to specify minimum size of files in megabytes to use cloud auto-upload feature. Files 

with lower size will be simply attached to a message. 

Auto-upload path 

Allows to specify folder where uploaded files will be stored. Folders can be nested (for 

example, Mail/Attachments). 

Links header 

When application will upload files to hard drive and insert links to a message text, additional 

header before this text can be added, which is specified by this parameter. For example: "Links 

to download files:". 

What is the easiest way to attach 
invoice in Mail sender? 

I tried to attach externally thinking that internal wouldn't attach. But it never attached.   

Application language 



To change the application language, click Application language button in the Tools tab of the 

ribbon: 

 

Currently, the following languages are supported: English, German, Spanish, French, Italian, 

Japanese, Polish, Russian. 

After changing a language, although part of UI will be immediately changed, it is recommended 

to restart the application to reflect all changes. 

Application locale 
Sometimes you may wish to view all dates and numbers using a locale which is different from 

your default system or browser locale. In such cases, you may set SDL Trados Business 

Manager to use any desired locale. To switch it, click Tools > Select default locale button (or 

button in the top right corner in web version). 

When clicked, you will see this window, where you can select desired culture: 

 

To apply changes, it is recommended to close and re-open currently opened forms. 

If SDL Trados Business Manager is used by many users, each user is able to select own locale. 



Application font and size 
You can change application font and size on fly. Select View tab on the ribbon and find Font 

family and Font size buttons. Select desired font settings and they will be saved for future use. 

 

 

Application quick access menu 

To open quick access menu, press Alt-X or click View > Show quick access menu. The 

following menu will be opened near mouse pointer: 

 

It allows to quickly open certain most important views of the application. 

Working with lists 

Lists (tables) are the most used component in the application. This is an accounting and 

managing software, used to maintain some information and store it in the database, which is 

inevitable linked with tables. 



In this application you are working with tables. You can also view reports, print documents, 

send e-mails, do some other stuff, but anyway all of these operations are performed in tables. 

Since SDL Trados Business Manager is built all around tables, it is recommended to carefully 

read all articles from this section. 

Let us start with editing modes. There are a number of editing modes you may use in SDL 

Trados Business Manager. The first is the simplest: inline editing, which is used when you add 

or correct data right in the table. 

 

Inline editing allows to quickly enter data. You may press Enter key, which behavior depends 

on a currently selected column. If current column contains drop-down list to select reference 

value, and if current value is empty, then this drop-down list will be opened to allow you to 

select a value. 

1. If current cell contains any value, then hitting Enter key will lead to moving a caret to a 

next column. 

2. When you're in the last column, and if you wish to create a new row, hold Shift key and 

press Enter to create a new row and move a caret to the first column. 

Note: To select rows in list, you can use small column with checkboxes on left. Also, you 

can use default Windows technique to select rows by holding Ctrl or Shift keys. 

3. To edit some value, just select inside the cell and type (or select from the list) the 

desired value. 

 

Depending on the cell type, some limitations may apply. For example, in a cell with a 

drop-down list it is possible to only select from listed values, in the date call you can 

only enter/select dates, amount cells allow you to enter only numbers, etc. 

Another type of editing method is a separate form (tab). This is used when an entry contains 

many fields. The main example, of course, is the job editing form. 

You can open as many such forms as needed from the main list (list of jobs, in this case). When 

the necessary changes are made, select Save (Ctrl-S) or the Save and close (Ctrl-Enter) 

button on the ribbon. After that, changes will be reflected in the main list. 



 

Opening reference data editing form 

Edit form for entering data contain different types of editors. Some editors allows to enter 

string, date or numeric values, but some fields allow to select data from underlying related 

tables using combo-boxes. Such data is called reference data. 

To open the editing form of referenced entry (for example, open customer editing form from 

job list, or open translation job from invoice), select a cell in a list with reference data, and 

find Open... button on the ribbon. Three points will be replaced by reference data type name. 

Select a customer cell and select Open Customer.  

 

The editing form for the Euro-Soft customer will be opened. 

You can also open the editing form by holding Ctrl-Shift keys and clicking in a customer cell. 

This function allows to navigate between data much faster. 

Additional information 

See nested articles of this section for additional information. 

Conditional formatting 



All lists in SDL Trados Business Manager support a conditional formatting feature. 

This feature allows you apply user-defined styles (font and color settings, icon, etc.) depending of 

some conditions. For example, you can simply change the background depending on the value of a 

particular column, or draw an icon to highlight an important point, or visualize a value changing 

depending on previous row, or even draw a small chart behind a numeric value. 

Rows can have different background depending on status, sent and paid jobs has its own icon, 

missing PO numbers are highlighted with bright yellow, and the amount column has a small chart 

which compares job amount with the largest job. 

There are two methods to setup conditional formatting rules: via appearance rules editor and via table 

context menu. The first method allows to edit appearance rules for some entity type, and these rules 

will be applied in all forms in the program: list forms and edit forms. For example, if to take 

Translation job, we have the following forms: job list, recent jobs in the dashboard, job editing form, 

job list in the customer editing form, list of available jobs in invoice creation form, etc. When 

appearance rules are created using Appearance rules editor, those rules will be applied to all such 

forms. 

Second method allow to edit rules specifically for one concrete table. For example, if you will create 

a rule for the general job list, those rules would not be applied to the list of job in the Dashboard. 

Be careful when mixing these methods. The first has priority, and if row background color will be set 

using a rule created in the Appearance rules editor, it would not be possible to override this color on 

the base of individual table rules. 

Setting up conditional formatting rules using appearance rules editor 

Procedure 

1. To access Appearance rules editor, use the Edit appearance rules button which you can 

find in each list view. The Appearance rule window is displayed. 

 

2. It contains all rules applied to the current list view. You can delete and edit existing rules, as 

well as create new ones. 



 

 

3. In the Rule name field you specify any logical name of the formatting rule. 

4. The Priority field allows to specify priority of the rule, when multiple rules are applied to the 

same column/field. Lower value means higher priority. 

5. In the Object type field is filled automatically and specifies type of the object which this rule 

will be applied to. 

6. The Criterion filed contains an expression which specifies when to apply this rule. To edit 

expression, select the ... button. You will see default expression editor, which you may use to 

visually build criteria of any complexity. 

 

 

7. Target items field specifies columns/fields to apply edited rule. To apply a rule to all fields 

(to highlight the whole row in the table), use asterisk symbol ( *). If you wish to apply a rule 

to one or multiple fields, list them here, separating by comma. List of available fields is 

provided in the Available fields list at the bottom. 

8. Rule context field specifies where to apply edited rule: in list views, in detail views (edit 

forms), or in both contexts. 

9. In the Background color, Foreground color, Font style fields you specify applied 

formatting. Visibility fields allow to hide a column or fields when rule criteria is met. 

10. Field edit enable checkbox specifies availability to edit target items when rule criteria is met. 



To better understand how appearance rules work, check default rules in the translation jobs 

list. It contains a number of built-in rules of different types. 

In the criteria expression editor you can visually build criteria by selecting necessary fields 

and their values. However, sometimes this editor can not help to compose complex criteria, 

In this case, you can manually build rule criteria by switching to the Text tab of the criteria 

editor. 

In the table below you can find formulas to process date values: 

FUNCTION DESCRIPTION EXAMPLE 

AddDays(DateTime, 

DaysCount) 

Returns a date-

time value that is 

the specified 

number of days 

away from the 

specified 

DateTime. 

AddDays([Deadline], 30) 

AddHours(DateTime, 

HoursCount) 

Returns a date-

time value that is 

the specified 

number of hours 

away from the 

specified 

DateTime. 

AddHours([Deadline], 2) 

AddMilliSeconds(DateTime, 

MilliSecondsCount) 

Returns a date-

time value that is 

the specified 

number of 

milliseconds away 

from the specified 

DateTime. 

AddMilliSeconds(([Deadline], 

5000)) 

AddMinutes(DateTime, 

MinutesCount) 

Returns a date-

time value that is 

AddMinutes([Deadline], 30) 



FUNCTION DESCRIPTION EXAMPLE 

the specified 

number of minutes 

away from the 

specified 

DateTime. 

AddMonths(DateTime, 

MonthsCount) 

Returns a date-

time value that is 

the specified 

number of months 

away from the 

specified 

DateTime. 

AddMonths([Deadline], 1) 

AddSeconds(DateTime, 

SecondsCount) 

Returns a date-

time value that is 

the specified 

number of seconds 

away from the 

specified 

DateTime. 

AddSeconds([Deadline], 60) 

AddYears(DateTime, 

YearsCount) 

Returns a date-

time value that is 

the specified 

number of years 

away from the 

specified 

DateTime. 

AddYears([Deadline], -1) 

Now() Returns the 

current system 

date and time. 

AddDays(Now(), 5) 

Today() Returns the 

current date. 

Regardless of the 

AddMonths(Today(), 1) 



FUNCTION DESCRIPTION EXAMPLE 

actual time, this 

function returns 

midnight of the 

current date. 

UtcNow() Returns the 

current system 

date and time that 

is expressed as 

Coordinated 

Universal Time 

(UTC). 

AddDays(UtcNow(), 7) 

When you start typing a formula, expression editor will help you to pickup fields from the 

drop-down menus. 

Setting up conditional formatting rules via table context 
menu 

To set-up conditional formatting rules, right-click on any column name and select Conditional 

formatting. 

You will see a sub-menu, where it is possible to select formatting from a pre-defined set, or 

select Manage rules to show a customization window. 

 

This window contains an ordered list of active rules. Here you can see conditions, a small resulting 

example, assigned column, a parameter that allows you to apply the rule to the whole row and 

checkbox to turn the rule on and off. 



To create a new rule, select New rule. 

 

Depending on the Rule type selection, you'll see different options of the rule in the bottom part of 

the window. You can find details about each Rule type below: 

 Format cells based on their values - it is usually applied to numeric values and allows to 

apply formatting based on minimum and maximum values. 

For example, you may change cell background from red (minimum) to green (maximum). 

Instead of 2-color scale, you may select from 3-color scale, data bar and icon sets. When 

format style is selected, simply specify range thresholds in percents or numbers, select 

desired colors and select OK. 

 Format only cells that contain - allows you to define formatting based on a field value. This 

formatting type is intended for numeric and date values. 

Especially it will be useful for date values, because here you can select one or multiple values 

from a wide list of predefined date rules: 

 

 Format only top or bottom ranked values - this rule type allows to highlight n rows with 

maximum or minimum values. Useful to highlight largest and smallest jobs. 

 Format only values that are above or below average 



 Format only unique or duplicate values - this rule type will be useful to point out on data 

which may be forgotten to be changed. For example, to highlight rows with repeated PO 

numbers. 

 Use formula to determine which cells to format - this is the most powerful rule type 

allowing you specify complex conditions. Rule criteria builder is similar to filter builder. You 

may specify number of conditions using values of multiple fields and apply different logical 

operators to them. Here is an example, which shows how to highlight Paid jobs with Website 

or Software localization specializations: 

 

When you apply any filter to the list, and have some conditional rules applied which depend on 

numeric values, those formatting rules will be recalculated, and you will see another picture. 

Filtering 

Applying filters 

Filtering is a quick way to display only necessary data and get summaries for this data. Each 

table in SDL Trados Business Manager provide reach filtering capabilities, which may be 

accessed using different approaches. 



The fastest one is quick filters available via icon in each table column: 

 

Hover mouse pointer over column name and select the filtering icon. Depending on the type of 

column, you will see different options to select from. In the example above, filtering menu 

opened for the Deadline column, which determines available options. In addition, filtering 

window consists of two tabs. Switch to the Values tab, to see another set of options, where it is 

possible to filter a list by selecting years, quarters or months. 

 

Open the filtering menu for another column (for example, Customer), then you will get another 

selectable values, and select which customers to display in the list. 

 



When data is filtered in the list, all summaries displayed at the bottom will be immediately 

updated according applied filter. 

There is another, more complex way to edit filters - through special filter editor. 

 

To open it, select on any column with right-click and select Filter editor. You can build 

complex filtering criteria using different logical operators and group of operators. Currently 

applied filter is displayed below the table. 

 

Select X to delete filter. 

Use checkbox to temporary disable applied filter. 

Use drop-down list to select from one of previously applied filters (history is saved 

automatically), or select Edit filter to open the Filter editor window. 

Saving filters for future use 

When any filter applied to a list, you can save it for future use. 

Some filters may be complex enough, so it is not convenient to configure them from scratch. 

Instead, it is possible to save current filter condition under defined name and quickly apply it 

when it is needed. 



1. To save a filter, select Filters > Save current filter. A dialog will appear to provide a 

name for a new filter. 

 
2. Select OK. A new filter will appear in the list of filters on the toolbar. 

 
3. To apply previously saved filter, simply select it from this drop-down menu. 

Note: When a filter is applied this way, data in a grid is filtered on database level. This 

means that you can apply additional filtering in the grid, and it will be 'added' to a 

currently applied filter, not 'replace' it. 

4. To display all data in a grid, select Filters > Clear current filter. 

5. It is also possible to edit or delete custom filter. Select Filters > Manage filters to open 

management window. 

 
6. From the Manage filters window, you can change order of items as they appear in the 

filter selection drop-down, delete custom filters, and edit their criteria. To edit a filter, 

double click on it top open editing window, where you can use criteria builder tool to 

edit filter condition. If it is difficult to manually edit criteria, delete custom filter and 



create a new custom filter from the main list. 

 

Important. Filters created this way filter data before they are loaded into a table. This is 

particularly important for network scenarios, as creating custom filters allows to only load 

limited number of records when a view is opened. 

Note. When some custom filter is selected, the same filter will be automatically applied next 

time you open the same view. Please consider this in cases when you can't find some 

information in a table. 

Grouping 

A grouping feature is available in almost all lists in SDL Trados Business Manager, and allows 

you to group rows by some column or columns (nested groups). This helps you to better 

organize displayed rows and get additional totals by the groups of interest. 

For example, with the help of grouping you may quickly find out the amount of jobs completed 

for different clients over a certain period of time. 

We'll be demonstrating the grouping feature using a job list, as this list is the most common 

used page in SDL Trados Business Manager. To group rows, simply drag any column header to 

the grouping area. If this area is hidden, right-click on any column name and select the Show 



group by box. 

 

Group panel will be shown: 

 

When any column is dropped to this area, it disappears from the list itself, and the 

corresponding groups are created. In the following example, two groups are created (Client, 

and then Currency): 

 

Even if columns are moved from the table to group area, you can still use filtering and sorting 

by those columns. Just select the group name to sort by it, or use the filter icon to apply some 

filters. 

Each group has totals. By default, there are only two total values: amount and amount in the 

base currency. But you can easily create your own totals. To do this, right-click on the group 

name and select Group summary editor. In the shown window you can select which totals to 



display for any column (default total types: max, min, sum, average) 

 

Using these simple actions you can setup as many totals as needed. 

In addition to sorting by grouping value, you can also sort table by grouping summaries. To do 

this, right-click on any group name, select Sort by summary, and then select the summaries 

which are setup for the current list. 

One of the most interesting features of grouping is the possibility to group by date intervals. 

Therefore, if you group by date or deadline, then you get access to an additional item in the 

context menu of the group name: Group interval. For example, it allows to group a list by 

months: 

 

Summaries 

Adding a summary to a column 

Summary panel is displayed at the bottom of each table. 



1. If this panel is hidden, you can display it by right clicking on a table header and 

selecting Show summary panel option. In the same manner, you can hide summary panel 

when it is not needed. 

 

2. To add a summary to any column, right click on a summary panel below that column and 

select desired function. 

 

3. To add another summary, right click on a summary panel, select Add new summary, and 

select desired summary type. 

 

Adding a summary to a group 

In addition to total summaries, you may create summaries by groups. 



1. When a table is in grouped state, right click on a corresponding column in the group panel 

and select Group summary editor. 

 

2. On the Items tab of the group summary editor, select necessary columns and summary 

functions for them. You may create as many summaries in this window as needed. 

 

3. Switch to the Order tab and set desired order of summaries. 

 

Special summaries 

Few lists, like jobs list and invoices list, contain special summaries (not customizable). 



These summaries are located below a table and allows you to view totals by currently selected rows. 

Select necessary rows (using Shift and Ctrl keys), and summary value will be immediately refreshed. 

This summary shows not only total amount of selected jobs, but total amount in a base currency and 

in all currencies of the selected jobs. The same summaries you can find for invoices, payments, 

translation assignments. 

Column chooser 

All tables in SDL Trados Business Manager support a function of hiding and displaying columns. 

Many columns in different tables may be hidden by default. 

For example, translation job list has a lot of hidden columns, which you may display if needed. To 

work with hidden columns, do the following: 

1. Right click on any column name and select Column chooser. 

 

2. Column chooser will be shown in the right bottom corner. 

 

3. Drag any column from the Column chooser to the table, or vice versa. 



4. To hide any column, it is not necessary to open Column chooser. Instead, you can simply 

drag column name and drop it somewhere below. 

 

5. Column chooser has an Add... button, which allows to add custom column to a table. For 

example, in the translation job list we can add additional information about customer. 

 

Hint. It is not necessary to open Column chooser to hide unwanted columns. Simply drag any 

column and drop it below table header. That column will become hidden. 

Searching 

You can find particular value in the large table, by using the search function. 

To access it, right click on any column name and select Show find panel. 

Type search string and hit Enter to see the results The program will look for searching string in 

all columns, highlight found values and filter the table accordingly. 

To cancel current search, select Clear in the search panel. 



 

Copy data to clipboard 

It is possible to copy individual cells, selected cells or selected rows. 

When one cell is selected and you press Ctrl-C, than only this value will be copied to the clipboard. 

If you select a number of cells (by dragging mouse across necessary cells) and then hit Ctrl-C, than 

selected cells will be copied to the clipboard in table format, so you can easily paste it to Word or 

Excel. 

To select a number of rows, use Ctrl key (individual rows) or Shift key (range of rows). 

If any conditional formatting is applied to the table (different background colors, for example), then 

this formatting won't be copied to the clipboard. If you wish to transfer selected rows into Excel 

along with colors (conditional formatting), right click in the list > Print preview > Export to > XLSX, 

and then use Excel to extract required data from the exported document. 

Reference data 

This section contains articles describing reference data tables (Navigation tree > Reference data). 

Analysis import settings 

When you import analysis data from CAT tools into your quotes, jobs and projects, sometimes 

you may wish to apply different settings depending on circumstances. These settings include: 

 Volume source (words or characters) 

 Import type (all fuzzy matches or single average volume) 

 Unit conversion settings (for example, convert Words+Characters into Lines) 

 Unit conversion formula 



To allow users to quickly switch between these settings, Analysis import settings reference 

data table can be used. You can define default import settings in the application settings, 

individual customer settings, in individual quotes, projects and jobs. 

For example, if you select non-default analysis import settings in a translation project, then the 

system will use them when you try to import any analysis report into any job which belongs to 

that project. 

Analysis import settings list looks like this: 

 

And editing form has the following layout: 

 

Name specifies name of a set. By this name, you can select these settings in analysis results 

window, for example: 

 

Import type allows to choose from All fuzzy types (multiple rows will be created in a target 

entity, per each fuzzy match in an analysis report) or As average volume (single row in a 

target entity). 

What to import specifies units of import: Words or Characters. This depends on pricing 

policy in your company. 

Work type allows to choose work type used in an import operation which uses this set of 

settings. Default work type is specified in the global application settings. If it differs from 

default, you can select it here. 

Default unit allows to select a unit used for created items in a target entity. 



Conversion settings tab allows to specify unit conversion settings. For this, you have to 

check Convert to another unit checkbox and the specify Volume 

source (Words, Characters or Words+Characters), Target unit and Conversion dividend. For 

example, you can use these settings to convert analysis data into lines: 

 

Additional services field allows to select workflow, which contains work types (steps), that 

you wish to additionally add to a quote/job/assignment when these analysis import settings 

are used (except work type selected in the Work type field). For each additional service, SDL 

Trados Business Manager will attempt to calculate estimated volume, based on adjustment 

factor of units which are selected as default for each additional work type. 

Example. You import analysis report with average volume of 10000 words. Selected workflow 

includes Proofreading work type, with default unit set to Hours. For the Hours unit, you have 

set adjustment factor to 312 (we can proofread 312 words per hour), and in the Adjustment 

factors per work types table you have set 3 for Proofreading (proofreading is 3 times faster 

than translation). See example image for the Hours unit configuration: 

 

In a result, in a target quote or job, SDL Trados Business Manager will create additional task 

with Proofreading work type and Hours unit, and Quantity will be calculated as 10,000 x 1 / 

312 / 3 = 10.68 hours. 

Checklists 

This type of reference data allows to create predefined lists, which can be quickly inserted into 

translation projects, jobs and assignments. 

Checklists are used to define custom workflow, reminding your or your vendors to performs 

some actions before delivering a project/job/assignment. Each item of checklist has priority 

and explanation. Depending on priority, each item gets different color. 

To view a list of custom checklists, select Reference data > Checklists in the navigation tree. 



Checklist creation window: 

 

It contains only Name field and a table of items. For each item you can set priority and 

explanation text. 

You may have as many predefined checklists as needed, and then insert them into translation 

projects, jobs and assignments. Additionally, you can select some checklists as default, so they 

will be automatically inserted into corresponding entities when they are created. 

To set default checklist, open Settings > Application settings, and find Checklists group. This 

group contains three fields, which allow to select default checklist for each type of entity. 

Checklists usage 

Editing windows for translation projects. jobs and assignments contain a tab called Checklists. 

If any default checklist is selected in the application settings, a table in this tab will be filled 

automatically when a document is created. 

Additionally, you can use enter rows manually here or use Load button to load a checklist from 

reference data 

 

After loading predefined checklist, you can edit and delete created items as needed. 

To mark an item as completed, select on the checkbox in the first column, or select any number of 

rows in a table and select Mark as completed button on the toolbar. 



Main list of projects/jobs/assignments contain a column called To-do (this column is hidden by 

default, and you have to use Column chooser to display it), which displays number of checklist items 

which are still not marked as completed. Take a note that this number does not include items with 

Optional status. 

When you use a checklist in a document, then the system will track existence of uncompleted items 

when status of a document changes to Finished, Sent, Paid, Delivered, and similar. If any 

uncompleted checklist item exist, the system will show a warning and won't allow to save a 

document until all checklist items will be marked as completed (except those with Optional status). 

Contacts 

This list simply contains all contacts of all customers, allowing to work with them from 

centralized place. 

You can quickly delete or archive old contacts, write mail messages, or just quickly edit 

personal information. 

When you create an e-message to any customer's contact (for example, from a job list, or 

invoice list, or other place), the system will automatically use main e-mail address. If 

alternative e-mail is specified for a contact, it will be automatically add to the CC field. 

Currencies 

This is one of the basic lists, which contain all currencies you work with. When the application 

launches for the first time, it creates two default currencies: USD and EUR, as most used 

currencies in the world. 

 

Currency editing window looks like this: 

 

In addition to main information, it also contains all rates for a selected currency. It's also 

possible to view all currency rates for all currencies in a separate reference data table. 



Of course, you can add any currencies you like. The only requirement is to use default 

abbreviation for the added currency, because it will be used to automatically download 

currency rates. 

In the settings there is a Default currency parameter. Again, USD currency is used by default, 

but you can change it any time. It is recommended to set default currency before starting to use 

application. But if it will be needed to change it later, than it will require to recreate all 

transactions for entered documents (jobs, invoice, etc.) to recalculate amounts expressed in the 

base currency. 

The base currency is a currency, in which all your amounts will be expressed. 

Example. Your base currency is USD, but you get a project counted in EUR. Add a job, select 

EUR, specify details and amounts. When you edit or save the project, all EUR amounts will be 

recalculated into USD, but only in case that you've added currency rate in the corresponding 

list. In a result, despite currencies used by your clients, you will always have total amounts in 

your preferred currencies. At the same time, financial information required to issue invoices 

and get payments, will be left in the currency of the job. 

For situations when you unintentionally create two or more identical currencies, you may 

use Merge currencies button to join them: 

1. Select the target currency. 

2. Select Merge currencies. 

3. Select duplicates and select OK. 

4. The system will find all references to selected duplicates and change them to target 

currency. Duplicates will be deleted. 

Currency rates 

This list contains currency rates, which allow you to recalculate amounts between different 

currencies. 

 



All rates are saved in the base currency which is specified in Settings. If you use USD as the base 

currency, then amount in USD will be calculated by multiplying the amount in EUR by the currency 

rate. 

If you change the base currency the values in the currency rates list becomes incorrect. In this case, it 

is recommended you erase this list and re-fill the currency rates. 

Customers 

Overview 

The Customers list contains all clients you work with. The list is divided into two parts: client 

categories and clients themselves. 

 

Categories are needed to divide clients into some logical groups, which help to find necessary 

client when needed. To manage categories, select Manage customer categories on the ribbon. 

To move selected customer(s) to a specified category, select Move to category and select a 

category in a popup window. 

You can merge two customer into one. When two customers merge in real life, or when you 

unintentionally created two customers, which should be merged now. To do this, select target 

customer and select Merge customers. In the opened list of customer, select duplicates and 

select OK. The system will merge all selected customers (find duplicates in projects, jobs, etc. 

and merge them with one main customer). 

List of clients contains filter buttons, which also allows you to filter and sort clients according 

your needs. 



Customer editing window 

 

Main data 

This tab contains basic information about the client: Name, Short Name, Customer Code, 

Supplier code, Parent client, VAT number, Category (each category may have own code, 

which can be used as a variable in different places of the program), Logo. 

Customer code is used as a prefix when per-client numbering system is used. 

Short name is used in invoice/job/project/assignment numbering variables, in price-list short 

descriptions (generated automatically), to automatically name invoice files, and other 

functions. 

Parent client field allows to set a parent client for the currently opened client. 

Logo allows to save client's logo. 

Address group allows to enter customer's address. When you enter data into any field, the 

system generates resulting address in the Full address field. You can edit contents of this field, 

but take a note that any change of a value in the upper fields will lead to re-determination of a 

value in this field. 

Web group allows you to specify web-portal address for this client along with the login details. 

Comments group contains one field for entering any comments about a customer. 



Main customer settings 

 

On this tab you can provide different parameters which affect on application behavior when 

dealing with particular customer. 

Taxes group allows you to specify default taxes applied in invoices for this client, VAT number 

and Tax number. 

Currencies, invoices and additional parameters group contains the following parameters: 

Default currency 

This currency will be automatically selected in all jobs created for this client. 

Minimal charge 

If job amount will be less than this amount, then the program will warn user about it. 

Default rounding 

A number of decimal places in job and invoice amounts for this client. For example, number 2 

means that amount of 12.835 EUR in the job will be rounded to 12.84 EUR. 

Default payment method 

By default, SDL Trados Business Manager selects accepted payment methods in invoice in 

according to selected currency. If to select particular payment method in this field, then this 

method will be explicitly used in the invoices created for this client. 

Default formatting language 

By default, when invoices, quotes, and other documents are printed the amounts and dates are 

formatted using the current application culture. However, you may wish to apply a specific 

culture for specific customers. This parameter allows you to set the default culture for all 

documents printed for a particular customer. 

Invoicing threshold 

Allows to set an amount upon reaching of which you will see corresponding notification on the 



dashboard about possibility to issue new invoice for this customer. This amount is provided in 

the base currency. 

Default invoice template 

Allows to set default invoice template for the selected customer. Later, when invoice print 

button will be clicked, this default template will be used instead of general default template 

selected in the program settings. 

Default fuzzy type set 

A set of fuzzy types with their weights. Used to apply different fuzzy discounts for different 

clients. 

Hide from Quick job creation list 

Allows to exclude a customer from the Quick job creation button, which allows to quickly 

create a job for the most recent customers. 

Default invoice template  

Allows to set default quote template for the selected customer. Later, when Print button will be 

clicked for a quote, this default template will be used instead of general default template 

selected in the program settings. 

The Invoice due date settings panel allows you to control how the program determines 

payment term in the new invoices. Method of determining invoice due date contains three 

options: Add days from invoice date, Day of the next month and Day of the next 2nd month. The 

first option is used when payment term is determined by addition of a number of days to 

invoice date. In this case, please specify number of days in the next field. Two other options 

allow to set payment term for particular day of the next or second next month. A remark: if you 

will set 31th day, and determined month contains only 30 days, than this additional day will be 

added to the calculated due date and you will get 1st day of following month. 

Client editing form also contain following tabs: Contacts, Relations, Price-lists, Files, Blue 

Board, and Audit trail tabs. 

The Contacts list contains the list of client's employees (managers, accountants) and their e-

mails. In addition to default data (like name, e-mail, Skype), it contacts has few additional fields. 

Invoicing matters checkbox allows to specify that this contact is used for sending invoices. 

When you use a function to send invoice by e-mail from within SDL Trados Business Manager, 



such contacts will be aromatically added to a recipients lists. Archived checkbox allows to 

exclude this contact from the PM selection list in the job editing form. 

The Price-list tab allows you to select default and additional price-lists for any jobs you do for 

the client. See Price-lists article. 

The Relations table allows you to save information about any actions, events or other stages of 

your cooperation. In addition, it is possible to set reminder time so the system will remind 

about some action planned to perform in relation to a customer. For history, it is possible to 

provide results if an action in the Results column. 

In the Blue Board tab you can link the client with ProZ.com Blue Board entry. 

In the Files tab you may attach any files to the current customer (NDAs, Contracts, other 

documents). These files are stored directly in the database and not linked with source files on 

your hard drive. Once the file is attached, it can be deleted or moved on the hard drive. Please 

use this function with care, because it leads to database file size growth. Currently, maximum 

file size in a local mode is 4 Gb. In network mode, teams which use SDL Trados Business 

Manager database server get 250 Gb of space (which may be expanded according growing 

requirements). To attach a file, select Add from file.... After selecting a file, specify its type in the 

File type column by selecting necessary value from the underlying reference table. 

The Jobs tab contains the list of jobs performed for this client. In compare to general Jobs list, 

this table is simplified: here you cannot adjust conditional formatting rules, select which 

columns to display, create invoices on the base of jobs, perform batch editing, save table state 

between sessions, etc. But it is still possible to filter, sort, group and search row here, along 

with creating, editing and deleting jobs. 

Batch change 

There is a Batch change button in the customer list. It allows to make similar edits in selected 

fields for all currently selected customers. 

To use this function, select necessary customers by holding Ctrl or Shift keys and select Batch 

change. 



The Customer batch change parameters popup window is displayed: 

 

Select the Active checkboxes of those fields you would like to apply changes to. Then provide 

corresponding values on the right of each marked checkbox. Customer batch change function 

allows to erase contact names and e-mails, as well as fully delete all customer contacts and 

entries in the Milestones table. 

Click OK. New values will be written to selected fields off all currently selected customers. 

Expense/income types 

 

The Expense/income types tab contains the list of categorized expense types. Expense type 

may be specified in the Expense document. Then, you may get a chart of expenses for any 

period of time. 

When you create an expense/income type, in addition to its name, you can optionally 

check Non-accountable box, which allows to exclude an expense/income type from the 

Ledger. This means that you can register some amount as an expense or income, but it won't be 

registered and displayed in expense/income charts. 

To manage categories, select Manage expense categories. 

To move selected expense type(s) to a specified category, select Move to category button and 

select a category. 



This list contains few predefined entries: Bank charges, Translation income, Translation 

expense, Currency difference. It is not possible to delete these entries, but it is possible to 

rename or move them to another category. These predefined entries are needed to make 

corresponding transactions in the Balance sheet and Ledger when creating different 

documents. When creating a new job, a corresponding record must be added to the Ledger, 

showing amount of the job as income from translation. 

Fuzzy types 

The Fuzzy types list is pre-filled with default fuzzy types used my famous CAT tools. You can 

create your own fuzzy types. Then, they can be used to specify default rates and to import 

analysis reports from CAT tools into new jobs. 

 

Except name, fuzzy types contain Sort, Band minimum, Band 

maximum and Synonyms fields. The Sort field allows to specify sorting order when 

performing operations of automatic filling of fuzzy tables. For example, this happens during 

importing analysis data from CAT tools. Band fields describe fuzzy type in terms of industry-

accepted match types.  Band maximum and Band minimum allow to specify lower and higher 

boundaries for fuzzy matches. Synonyms field allows to specify list of codes used in analysis 

reports generated by different CAT tools. As you can see, CAT tools use different fuzzy 

definitions in report files. Later, when importing analysis reports from CAT tools, these values 

will allow the system to pick-up matching fuzzy type and determine correct price. It is not 

mandatory to fill Synonyms in advance. If the system won’t be able to correctly determine 

fuzzy type during analysis report import operation, you will be able to choose missing values, 

and this choice will be automatically added to the Synonyms list. 

Analysis reports generated by translation software usually contain similar information (like 

band minimum and maximum for fuzzies). The system will compare values contained in such 

reports with values provided in this table and will be able to find correct fuzzy type. 

Fuzzy types schemes 



Fuzzy schemes table allows to create different sets of fuzzy weights. This will be useful when 

different clients use different fuzzy discounts. 

For example, one client may count 50-74% fuzzy as no match (100% of price), while others 

may use decreased prices for such fuzzies. 

When fuzzy type set is created, you provide all fuzzy types and their weights: 

 

Add all necessary fuzzy types to the details table. First column, Sort order, is not editable and 

displays sort value for the selected fuzzy type. 

You may have any number of such sets, and apply them to different clients. But at least there 

must be one default set, which is selected in the program Settings and used by default in all 

jobs. 

Above the table is a special button to print discounts table. 

Language pairs 

 

List of language directions you work with. You specify language direction when creating a new 

job, when specifying default rates, when filling contractor's data and specifying working pairs, 

etc. 

When you create a language pair, all you need to do is to select source and target languages 

from list of languages. This means that creation of language pair requires to create necessary 

entries in the list of languages (which can be done on fly as well). 



Languages 

List of available languages. You select languages when specifying language directions in quotes, 

projects and jobs, when filling-in language information in the CV section of user settings, and in 

many other places of the application. 

 

You can select language flag, which will be displayed in the job editing window. 

When SDL Trados Business Manager is launched for the first time, a list of default languages is 

created. You are free to delete unnecessary languages. 

Take a note on the Synonyms field, which allows to specify list of codes for a language used in 

analysis reports generated by different CAT tools. As you can see, CAT tools use different 

language definitions in report files (for example, SDL Trados Studio uses de-DE for German 

language, while MemoQ uses ger for the same language). Later, when importing analysis 

reports from CAT tools, these values will allow the system to pick-up matching language and 

determine correct price. It is not mandatory to fill Synonyms in advance. If the system won’t be 

able to correctly determine language during analysis report import operation, you will be able 

to choose missing values, and this choice will be automatically added to the Synonyms list. 

Message templates 

You may have any number of message templates and use them to quickly compose e-mail messages. 

 

Existing message templates can be found in the Reference data section of the navigation tree. When 

you compose messages, template list is displayed on the left of the message text. 



In each message template, you can specify predefined Subject and Text contents. In both fields 

you're able to use same variables. 

CC field allows to specify comma-separated list of e-mail addresses which will be automatically 

added to the CC field of all messages composed using this template. 

You can assign any message template to be used as default in certain events. Full list of such 

events when a message could be automatically generated by TBM is provided in the Automatic 

notifications article. 

To set particular template as default, open a template from the list and set a value in the Use as 

default for field. 

For example, if you select Job offer as default for a particular template, then this template will be 

automatically used click Send availability request in the Contractors pickup tab in 

the Translation assignment editing form. 

Note. Please don't select same value in the Use as default for field for different 
templates. In this case the application will choose first random template. 

Disabled checkbox allows to turn off certain type of automatic notification. When some event occurs 

(for example, new vendor registered in the system, or customer accepted a quote), TBM will look for 

a template with a corresponding value in the Use as default field and unchecked Disabled value. If 

such template can't be found, notification won't be generated and won't be sent, correspondingly. 

Payment methods 

 

The Payments methods list contains information about payment methods your clients can use 

to make payments against your invoices. When a new invoice is prepared, you can select which 

payment methods are applied to that invoice by selecting or deselecting necessary payment 



methods. Here is example how payment method selection looks like in invoice editing window: 

 

For any payment method, you can check Default option. When invoice is created, or when you 

change currency in a created invoice, the system will automatically select all payment methods 

marked as default. If there are not default payment methods for a selected currency, all 

payment methods with that currency will be pre-selected in invoices. You also can select one 

specific default payment method in the Customer editing window. 

Notes field allows to enter custom notes. This field is used for personal purposes and not 

displayed anywhere. 

Payment method can be archived (Archived checkbox marked). Such payment methods would 

not be available for selection in new invoices, but will appear in older invoices, where they 

have been used previously. 

Predefined sets of tasks 

 

This reference data table allows to create predefined sets of tasks which then can be quickly 

inserted in quotes and translation jobs instead of creating rows from scratch and entering 

units, fuzzy types, work types, etc. 

 Examples of task sets: 

 Translation no match, Proofreading, Editing 

 10 rows for Translation work type for each fuzzy type, Proofreading, DTP, 



To create a new set of tasks, select New and give a name for a newly created set. Then add 

necessary tasks into the Tasks table. Optionally, in addition to service type, you can provide 

default values for Unit, Fuzzy type and Quantity (see image above). 

When ready, click Save, open any job editing form and click Insert set of predefined 

tasks button above tasks table. Your newly created set will appear in the drop-down list: 

 
Select one of sets, and all services will be added to the Tasks table. 

Price-lists 

Price-list is a set of prices which can be applied globally, to any customer or to any vendor. 

Price-lists can be default an optional. Default price-lists are used by default to determine prices 

while you’re editing quote items, job tasks and assignment tasks. You may have multiple 

default price-lists on application level, customer level and vendor level. Optional price-lists can 

be used in individual entities (quotes, translation jobs and translation assignments) if you 

explicitly select that price-list in the Price-list field. 

To view price-lists, select Reference data > Price-lists in the navigation tree. To create a new 

price-list, click New on the ribbon (Ctrl-N on keyboard). To view/edit existing price-list, double 

click on it in the list. 

Price-list editing 

Default look of price-list window: 

 

Default checkbox specifies if a price-list should be used as default on the global level. Such 

price-lists will be used for customers and vendors who don’t have any default price-lists 

attached to them. 

Creation date is just a date when price-list was created. For reference purposes. 



Name is a short name of a price-list to quickly differentiate it when selecting price-list in 

combo-boxes. 

Archived checkbox allows to hide price-list from selection boxes. 

Description is a field where you can provide detailed information about price-list. For 

example, values of base prices per work type or language. In the list of Customers and Vendors 

you may find Default prices column. When you attach price-list to a customer or vendor and 

make it default, value of this Description field will be displayed in the Default prices column. 

It allows to quickly understand prices of particular customer or vendor when you’re selecting 

them in drop-down lists. 

Public notes and Internal notes allow to store some notes/reminders about price-list. 

Price-list items is a table where you add price values. You can specify work type, fuzzy type, 

language pair, unit, specialization category and currency values, which determine where a 

particular price should be applied. When SDL Trados Business Manager will be picking up a 

price, it will search for closest match based on values provided in a source 

quote/job/assignment. If exactly matching price can’t be found, closest match will be used. 

Example, you have two prices with identical set values, with the only difference in language (first 

price has no language pair specified, second price is for EN>DE language). If you enter a job with 

EN-DE language pair, then second price will be used. For any other language pair first price will 

be used. 

When you’re creating new price-list, you can speed-up this process by loading price-list items 

from other price-list. To do this, click Load prices from another price-list button on the 

ribbon: 

 

If you wish to create set of prices for another language pair, select price-list items and 

click Copy to another language… button on the toolbar and select new language pair in a 

popup window. In a result, selected price-list items will be cloned, and selected language pair 

will be selected in the Language pair column. Then, simply make changes in the Price column, 

as needed. 



Fuzzy type isn’t mandatory field. Empty fuzzy type means that a price is for ‘No match’ fuzzy 

(100% weight). In this case SDL Trados Business Manager will read fuzzy weight from fuzzy 

scheme used in base entity and apply its weight to a price for ‘No match’ fuzzy to automatically 

calculate new price. This mechanism can be demonstrated by Resulting price-list tab. 

Contents of this tab is built on fly, based on Price-list items table, by applying fuzzy weights of 

all fuzzy types included in a default fuzzy scheme. This means that you can add one price for 

‘No match’ fuzzy to the Price-list items table, switch to Resulting price-list and view 

automatically calculated prices for all fuzzy types. If you don’t wish the program to 

automatically calculate prices for fuzzy types, you can explicitly add price value to the Price-

list items table for each fuzzy type. In the same manner, if you’re not happy with only one 

automatically calculated price (for example, only for ’50-74% fuzzy’), then you can manually 

add price only for this fuzzy type – in this case the application will automatically calculate 

prices only for rest fuzzy types. 

For simplicity of viewing, data in the Resulting price-list table are grouped by Language pair, 

Currency and Work type: 

 

And here is base price for the above screenshot entered in the Price-list items table (for empty 

language): 

 

Such calculation works only when Unit value for a price-list item is not empty. 

Hint. You can use Resulting price-list table in custom reports to build custom price-list reports 

for printing your prices. Example of such report is already included in the application (open list 

of customer or vendors, select any customer or vendor and click Print). 



Linked customers tab shows list of customers who are linked with this price-list. To link a 

price-list with particular customer, open customer editing form, switch to Price-lists tab and 

click Add to link a price-list. When price-list was linked with a customer, that customer will 

appear on this Linked customers tab. 

Linked vendors tab is analog of previous tab, but shows linked vendors. 

Price-list list 

 

This list displays all fields described in the previous section of this article. Additionally, there 

is Usage type column, which displays one of four values: Not used, Vendors, Customers or Both. 

This column allows to quickly determine how a particular price-list is used in the system, and it 

can be used for filtering the list. 

On ribbon, you will find Open linked vendor and Open linked customer buttons. These 

buttons available only if you have one currently selected row and of selected price-list has any 

customer or vendor linked with it. As name says, this button allows to quickly open editing 

form of any customer or vendor linked with a currently selected price-list. 

Archive button on the ribbon allows to quickly mark selected price-list(s) as archived. 

Archived price-list loose Default mark, if it’s checked. 

Taxes 

 

The list of taxes which may be included in invoices. You may specify Name and Rate (in percent) 

for each tax. Later, when preparing a new invoice, you may select taxes for each row and 

corresponding amount will be added to the job amount. 



Gross-based mark allows to calculate tax amount based on the gross amount, instead of net. 

Example: invoice net amount is 900 USD, and tax rate is 10%. For net-based calculations, gross 

amount will be determined as 900 * (100 + 10) / 100 = 990. For gross-based taxes final amount will 

be determined using the following formula: 900 / (100 - 10) * 100 = 900 / 0.9 = 1000. 

In addition, you may specify default tax in the application settings, in the customer editing form (for 

particular customer) or in the contractor editing form (for particular contractor), which will be 

automatically applied to all newly created invoices. 

Test pieces 

General overview 

This table allows to create test pieces for different language pairs and specializations, select 

predefined proofreaders who will be checking submitted tests, and configure automatic 

offerings of tests pieces to vendors who add corresponding languages and specializations to 

their profiles. 

You start with navigating to Reference data > Test pieces, to open list of tests: 

 

To add or edit a test piece, click New or select any existing test piece: 

 

Name. Just short name of a test piece, which will help to select it from drop-down lists or mail 

messages. 

Language pair and Specialization. Pair of values which describes target language and domain 

of a test piece. 



Offer to new vendors. Allows to enable or disable test piece. When checked, vendors will 

receive an offer to pass this test piece once they add matching language pair or specialization to 

their profile. 

Notes. Internal notes for managers. 

Instructions for vendor. Visible notes/instructions for vendors passing this test. 

Proofreaders. This table allows to add desired vendors who will be checking submitted test 

pieces. It is not mandatory to fill this table, but if you know in advance list of persons whom 

you'd like to entrust reviewing, you can add these persons here. Additionally, if proofreader 

works on paid basis, mark Paid review box. For such proofreaders, TBM will create translation 

assignment and PO when sending a test for reviewing. 

Source text. Just a text to translate. Formatting is not supported here, so it should be plain 

multi-line text. 

Manual test piece allocation 

Manager can manually assign test piece to a vendor. It could be helpful if you don't use vendor 

portal and automatic offerings. 

To manually assign a test piece, open vendor editing form and switch to the Test pieces tab. On 

this tab, add a new test piece: click New, then select test piece from drop-down menu, and save 

changes. After new test piece appears in the table, click Send button to generate mail message.  

 

Mail message composing window opens: 

 

Check if all is correct and click Send. Then you can click OK to close a message and return to a 

vendor profile. 



Automatic test piece offerings 

If you use vendor portal, test pieces could be offered automatically. It happens in 2 situations: 

when vendors logs on into the system, or when vendor edits own profile and adds new 

languages or specializations. In both cases, if system finds any enabled test piece which still 

wasn't added to a vendor profile, it displays a dialog offering to take a new test piece(s): 

 

Vendor may accept or decline new tests. If vendor declines to take them, system won't offer 

same tests anymore. If vendor accepts them, test pieces will be added to a profile, where 

vendor can view them and process. 

Manually adding test pieces by vendors 

If vendor declined a test piece once, but later decides to take it, it's possible to do from a profile 

in the vendor portal. To do this, logon onto the system and open your profile (user name in the 

top right corner > My profile), then switch to the Test pieces tab and click Add new 

test button: 

 

A dialog will be displayed where you can choose from available test pieces. Select one or 

multiple tests and click OK to add them to a profile. After that, you can start working on them. 

Submitting tests 

Vendors can self-submit tests when they're done. To do this, open your profile, switch to the 

Test pieces tab, open any test piece with 'In work' status and enter value into the Target 

text field. Then, in the list of tests, click Submit button. Manager will get notification about 

submitted test and take appropriate action. 

Reviewing test pieces 



After getting a notification about submitted test piece, open vendor profile and find it by 

reference number. Test piece will have Submitted by vendor status. To send a test to 

proofreader, select it and click Send for review button: 

 

If you added default proofreaders, drop-down menu under this button will display list of these 

vendors. Otherwise, there will be only one option: Empty recipient. Selecting this option will 

create a new e-mail message with details of selected test piece, but with empty recipient. 

You're free to select recipient on your own. 

If you select one of predefined vendors, application may behave differently depending on 

settings: 

 If this proofreader has Paid review mark, then TBM will create translation assignment, 

one task with automatically calculated number of target words, generate PO for this 

work and e-mail message with attached PO and test piece details. Then, translation 

assignment window will be shown, where you can make any changes. Create email 

message can be found under Mail messages tab. 

 If proofreader hasn't Paid review mark, only e-mail message will be created, as 

with Empty recipient option, but proofreader's details will be added to the Recipients 

table, so you can just click Send button to quickly send a message. 

Informing vendors about test piece results 

After you get reviewed test piece from a proofreader, you can quickly find it in the system by 

reference number: 

1. Open list of vendors 

2. Click a button to view all test pieces from all vendors: 

 
3. Find test piece by reference number: 

 
 



4. Open it and provide score and comments for vendor 

5. Depending on a score, test piece will be highlighted with color: green - passed (score > 

7). yellow - average (5-7), red - not passed (<5). 

6. Click Send results button: 

 
 

7. TBM will automatically notify vendor by e-mail: 

 

Units 

This is one of the basic reference data lists, which contain all units you work with. These units 

are used to measure jobs you perform. For example, translators use words, hours, pages as 

measure units. 

 

When a new Unit is added, you specify the following attributes: 

 

Name. This is the name of the unit displayed throughout the app and printed in documents. 

Base unit. When base unit is specified, price pickup mechanism will take it into account, trying 

to determine default price for selected base unit and applying multiplier specified in the 

Adjustment factor field. For example, you may have the following units: Default page, Page 

1600 symbols, Page 1500 symbols with spaces, etc. In such case, you may select Default page as 

a base unit for Page 1600 symbols and Page 1500 symbols with spaces. And, while defining 

prices for your customers, specify prices only for Default page. In a real project, when you 



select one of dependent units, the system will pickup a price for base unit and apply adjustment 

factor to a detected price. 

General adjustment factor. Default value for this field is 1. It is used to express all volumes in 

some 'average' unit, allowing to get weighted (average) quantity for all jobs in a single table 

column regardless of units used in job tasks. When SDL Trados Business Manager calculates 

average volume, it divides quantity by this factor (so, adjustment factor is a divider in 

formula). 

In other words, no matter if you count your jobs by words or by hours. Adjustment factor 

allows to get weighted (average) volume of all jobs. You are free to choose which unit will be a 

"base unit" - it will simply be that unit whose adjustment factor is set to 1 (in a case when Base 

unit field is empty). For example, if base unit is "words", set adjustment factor for Words unit 

to 1. And then estimate adjustment factors for other units knowing that one (1) is used 

for Words. For example, if one line is 55 characters, which is approximately 11 words, set this 

value as adjustment factor for Lines unit. If you translate 300 words per hour, use this value as 

an adjustment factor for Hours units. 

When you generate charts, Adjustment factor allows to make it possible to include quantities 

in different units into a single chart. Additionally, Translation job list table contains Weighted 

volume column, which allows to summarize values in this column. 

Note. Weighted volume value, calculated using Adjustment factor, is intended only for 

estimation purposes, and shows average volumes for your convenience, allowing to quickly 

estimate how 'large' particular job is. 

Flat rate. You can check this setting when the unit supposes to enter final amount in the job 

task instead of its calculation using "Price x Quantity" formula. When this option is used, you 

enter corresponding volume in the Quantity field (for statistical purposes), Price field becomes 

un-editable, and then you enter fixed amount in the Amount column. Is time. This checkbox 

allows to specify that current unit is used to count time. Otherwise, this unit is used to measure 

volume. It affects on price list generation - SDL Trados Business Manager will apply fuzzy 

factors only to those units which are used to count volumes, not time. 

Is time. Flag which signals that a particular unit is used to measure time. 

In the unit editing window you can specify Adjustment factors per work types. As you can 

see (see image above), it is possible to apply additional or different adjustment factor for 



some service type which uses this unit. This will influence on the mechanism of weighted 

(average) volume counting. For example, we know that proofreading of the same word count is 

3 times faster than translation. Detailed adjustment factors allow to help the program to 

correctly estimate job volumes and correctly build stats data and predict work time for the 

newly created jobs. 

Vendor groups 

This table allows to create groups of vendors which then will be used by vendor 

recommendation mechanism. For each group, you can specify: 

Name. Just some descriptive short name of group which allows to understand better from 

where recommendation comes from; 

Disabled. Allows to disable a group so it will be ignored by vendor recommendation 

mechanism, without deleting it from the system (for example, if it could be used in future). 

Customer. Optional field. Allows to link a group with particular customer. 

Translation project. Optional field. Allows to link a group with particular project. 

Specialization. Optional field. Allows to link a group with particular specialization. 

Vendors table. Contains list of vendors included in a group. 

Vendor. Required field. 

Service. Also required field which specifies for which service type particular vendor is 

preferred. 

Language pair.Optional field. Since vendor could support multiple language pairs, you could 

prefer to invite them to job only in some specified language pair. 

Priority. If system will find multiple vendors for some criteria, priority allows to move some 

vendors before others. 

Vendor group editing window looks like this: 



 

To add a new row to the Vendors table, click on the New icon ( ) and select a vendor and 

service: 

 

After you finished to fill vendors, click Save changes. 

To test how the group works, create a new translation assignment which matches group 

parameters (for example, customer, project, etc.) and expand Vendor drop-down menu. 

Vendors included in a group will be recommended by the system: 

 

Vendors 

Overview 



Default look of the Contractors list: 

 

This list contains translators which can be assigned for translation jobs. 

In the vendor list, you can select multiple vendors and quickly change their type. To do this, 

click Change type button on the ribbon and then select desired target type: 

Contractor editing form allows to specify main and contact details, including person type (staff, 

freelancer, organization), state of employment, photo and web pages on popular networks for 

translators: 

 

Fields description 

Main tab 

Type specifies type of a contractor (Staff, Freelancer, Organization). Staff members can be used 

as responsible persons in quotes, translation projects and jobs. 

First and Last name are provided only for individuals. 

Company name is provided only for companies (contractor list has Full name column, which is 

filled automatically depending if Company name, First name and Last name are filled). 



Employment status allows to track candidates. Contractors with employment status other 

that Employed won't appear in selection lists in assignments. 

Contact group contains fields to provide contact details (e-mail, skype, phone, etc.). 

Address group contains fields to provide contractor's address. 

Settings group 

Default currency. It allows to select a currency which will be automatically set in all 

assignments you create for this contractor. For example, is default currency is USD, but you 

create an assignment over a job which is counted in EUR, then assignment currency will be 

automatically changed to USD. 

Value of the Default unit field will be used in translation assignments, when creating new 

tasks. 

To set default payment terms for a contractor, you can use Method of determining invoice 

due date and Day number fields. In the first field, select one of three types of invoice payment 

term determination, and enter corresponding day or number of days in the second field. 

Minimal charge field allows to specify an amount in a currency selected in the Default 

currency field, which is minimum for this vendor per assignment. If this value is specified 

(greater than zero), then the system will show warning message when you try to create an 

assignment with amount which is less than minimal charge. 

Default tax 1, Default tax 2 and Default tax 3. These fields allow to specify taxes 

automatically added to incoming invoices created for a contractor. 

Default PO template field allows to select PO template used for particular contractor (if differs 

from Default PO template selected in the global application settings). 

Time zone and Language code fields allow to convert assignment deadlines, which you set in 

your local format, into vendor's time zone and culture. For this, special variable can be used in 

e-mail messages. 



Do not offer tests. When checked, vendors won't be getting offers to pass tests when they 

logon into vendor portal or edit their profiles, even if tests which fits their languages and 

specializations are available in the system. 

Web group 

Contains link to social networks. 

Notes group 

Contains Notes field, which allows to store any notes about a contractor. 

Archive status group 

Archived contractors won't appear in selection lists. You can mark contractors as archived and 

provide Archive reason for reference. 

Milestones tab 

On the Milestones tab, you can enter important information about activities performed with 

respect to a contractor. You may save details about testing results, signed agreements, 

important received emails, etc., to be able to remember out information when it's needed. 

Price-lists tab 

On the Price-lists tab, you can view and edit price-lists linked with a vendor. See Price-lists 

article to find instructions how to work with price-lists in SDL Trados Business Manager. On 

this tab, you can link existing price-list with a currently viewed vendor. 

To do this, please do the following: 

Click Link button and select one or multiple price-lists in a popup window: 



 

In the Default column, check the box to mark added price-list as default. When adding tasks to 

translation assignments, SDL Trados Business Manager will look default rates only in default 

price-lists. 

To remove (unlink) price-list, select it and click Delete on the toolbar. 

To view detailed information (prices) from linked price-list: 

Selected a price-list and click Open price-list button on the toolbar ( ). 

Default price-list editing window will be opened: 

 

Additionally, if you switch to the Resulting price-list tab, you will notice that Built for field 

contains name of a source vendor and default fuzzy scheme of that vendor: 

 

If you open same price-list from reference data table, Built for field will be empty, and 

resulting price-list will be generated based on global default fuzzy scheme. However, in this 

case vendor’s default scheme is used. 

Hint. You can print price-list data for a selected vendor. To do this, click Print button on the 

toolbar (available both in the vendor editing window and vendor list). 



Language list tab 

Here you can specify Native language and list of Target languages. For each target language, 

you can optionally specify Fluency. 

Payment methods tab 

List of payment methods supported by a contractor. Can be selected in incoming invoices. 

Specializations tab 

List of specialization supported by a contractor. Useful for filtering purposes when selecting a 

contractor. 

Auto unit conversion settings tab 

Allows to specify rules for automatic unit conversion when a vendor is assigned to a job. By 

design, units in translation assignments must be the same as units in a source translation job 

(to correctly calculate assigned and unassigned volumes). However, according to a negotiations 

with vendors, it may be required to explicitly use particular unit and prices for that unit. This 

table allows to specify Service/Source unit pairs which will be automatically converted into a 

target unit (when such pair exists in a source job). For example, look at this screenshot: 

 

According to these settings, if this vendor is assigned to a job which contains 

any Translation service counted in Words unit, those quantities will be automatically converted 

into Lines by applying adjustment factor specified for Lines. Of course, after conversion you're 

free to correct volumes calculated by TBM. 

Test pieces tab 

This tab allows to work with test pieces: assign, receive, send for review and inform vendors 

about results. Detailed explanation can be found in the Test pieces article. 



Days of unavailability tab 

Days of unavailability table allows to specify days of absence, which, along with current 

translation assignments, allows to determine if particular contractor is currently available or 

not. 

Professional software and Other software tabs 

Allow to specify software and versions supported by a contractor. 

To add a row in the professional software and other software tables, select Link button and 

select software name in the appeared list. If necessary software is missing, 

select New or Clone button to create it. 

File attachments tab 

On this tab you may attach any files to the current vendor (like CVs, NDAs, etc). These files are 

stored directly in the database and not linked with source files on your hard drive. Once the file 

is attached, it can be deleted or moved on the hard drive. Please use this function with care, 

because it leads to database file size growth. Currently, maximum file size in a local mode is 4 

Gb. In network mode, teams which use SDL Trados Business Manager database server get 250 

Gb of space (which may be expanded according growing requirements). 

To attach a file, select on the Add from file.... After selecting a file, specify its type in the File 

type column by selecting necessary value from the underlying reference table (you may create 

additional file types on fly). 

Assignments tab 

Displays all translation assignments for a selected contractor. 

Invoices tab 

Displays all invoices from a selected contractor. 



Audit trail tab 

Displays information about all changes made in a contractor profile, include date of change, 

user name, previous and new values of individual fields. For example, this screenshot shows 

that Admin user changed Email value from empty to steven_wright@mail.com during initial 

contractor creation: 

 
 

List of contractors 

In this section, you will find description of additional functionality provided by a contractor list. 

Additional useful columns 

List of contractors contains some additional columns which may be useful when selecting them 

during assignment creation. If some of described columns isn't visible, please use Column 

chooser function to display them. 

Available column displays availability status of a contractor, depending on ongoing 

assignments and information from the Days if unavailability table. 

Date of availability column displays closest day of availability according to current 

assignments and vacations. 

Average rating is calculated based on all assignments with specified rating. 

Rates column contains information from the Default rates table for items marked as Show in 

list. 

Assignments in work column displays number of assignments which are in work and not 

delivered. 



Assign. total displays total amount of all assignments for a contractor. 

Currently in work displays description of tasks from ongoing assignments (work type and 

quantity). 

Language column displays all language pairs provided in the Language list tab. 

Services provided displays all work types provided in the Default rates tab. 

Additional commands 

Both in list form and editing form you may find Archive button. This button allows to mark 

current contractor (or multiple contractors selected in the list form) as archived. Optionally, 

you may specify archive reason. Archived contractors disappear from the main list (you still 

can view them by using Filters drop-down list on the ribbon) and from contractors' pickup 

window in translation assignments. 

You can always return archived contractors by switching to Archived filter, opening necessary 

contractor and deselecting Archive check-box in the editing form. 

Change type button allows to quickly change type of currently selected contractors. 

SDL Trados Studio button allows to link and unlink selected contractor with Studio users, as 

well as create users in Studio from within SDL Trados Business Manager. 

GroupShare button allows to link and unlink contractor with GroupShare users, import 

contractors from GroupShare and create users in GroupShare from within SDL Trados Business 

Manager. See SDL GroupShare section for additional information. 

Searching vendors 

Although list of vendors, as any list in the application, provides extensive filtering capabilities, 

sometimes using Edit filter window could be time-consuming. For example, to search vendors 

by language pairs you have to follow these steps: 

 Right click on table header and select Filter editor (or Filter Builder in web-version). 



 Configure approximately the following filter by adding conditions, selecting correct 

fields and their values: 

 

Of course, it could take a lot of time. Although this filter builder can be useful in many cases 

(especially taking into account that any filter condition could be saved for future use), there is 

more convenient way to search vendors. To access vendor search window, click Search 

vendors button on the ribbon: 

 

The following window will appear: 

 

And how it looks in web-version: 



 

In this window, you can quickly select the following search parameters (in tables you can select 

as many rows as needed using checkboxes, and system will search by ANY of selected values): 

 Language pairs 

 Native languages 

 Provided services 

 Supported specializations 

 Average rating 

 Vendor type (Staff, Freelancer, Organization, Any) 

 Archive status (Archived, Not archived, Any) 

 Employment status (Candidate, On approval, Employed, Declined, Any) 

 Cities 

 Countries 

When you make selection, click OK to apply search criteria to the list of vendors. In a contrast 

to usage of filtering features, list will be filtered on database level, which means that data is 

filtered by database engine (server), and all filtering criteria which you apply in the list will 

be added (but not override) to current search results. Please remember this, as it could be 

confusing, because data can be filtered on two levels: database (server) level, and UI level (all 

filters applied using filter icon in each column). 

To change search parameters, simply click Search vendors button again. 

To view full list of vendors, click Clear search results button on the toolbar. Database level 

filtering will be cleared, but filters applied on the UI level will be preserved. UI level filters are 

displayed below the table, as on the following screenshot: 



 

When you’re viewing search results, you can save current search parameters for future use. For 

this, click Filters > Save current filter. The following dialog will appear: 

 

In this dialog, you can view filter string which is being saved. When using search function, the 

applications performs a search (in this case, by language pairs) using ID values, not language 

pair names, because it is a faster way to find data. That’s why filter string contains codes 

instead of names. Specify filter name and click OK. Saved filter will be added to the list of filters, 

which you can select any time later: 

 

After you select saved filter from this list, you can click Search vendors button to modify 

search criteria. 

Work fields 



 

This list contains all specializations you working in. Work field is selected when you add a 

project or job. This list can be categorized to quickly finding necessary field. 

To manage categories, click View/edit categories. 

To speed-up creation of work fields, you can use Import work fields from ProZ.com database 

button. To use this function, SDL Trados Business Manager must be connected to ProZ.com. It 

allows to download default specializations from the ProZ.com database. 

When you select a work field somewhere in documents, you will be able to search by category 

or field name. 

Work fields can be used to differentiate default rates and to build extensive reports - you can 

always get information about completed jobs in particular field using a number of build-in 

reports. 

Work types (services) 

This list contains all work types you perform for your clients. It could be translation, 

proofreading, DTP, etc. 

 

Work type is used when you add a new detail row to the project. When setting default rates, 

you can select different work types as the basis for the rate. For example, translation usually 

counted on per-word basis, while proofreading tasks are counted on per-hour basis. 

You can select Default unit for each work type. This unit will be automatically pre-selected 

during creation of tasks in translation jobs. 

In addition to setting default rates, work types are used to calculate different stats of your 

performance. 



Workflows 

Workflow is a simple reference data table, which specifies minimum number of steps provided 

to a customer. List of workflows has only one column: 

 

Editing view also includes a table with steps included in a workflow: 

 

Currently, workflows are used only to help you to quickly create translation assignment in 

translation projects. This is described in the Translation assignments and translation 

assignment tasks article. 

It was mentioned that workflow defines minimum number of steps. This means that actual 

workflow (number of created assignments over a translation job) could differ and include 

additional work types, if user manually creates additional job tasks. For such tasks, which are 

not included in a workflow, translation assignments will also be created automatically, but 

these tasks will be combined with a last step of workflow and be included in the last translation 

assignment created for a particular translation job. 

Documents 

Documents correspond to operations which can be registered within SDL Trados Business 

Manager (translation projects, quotes, assignments, payments, invoices, etc.). See nested articles for 

detailed information about each document type existing in SDL Trados Business Manager. 

Quotes 



Separate quotes module allows to quickly create quotes, print them using built-in or custom 

templates, quickly create translation jobs from quotes and view reports showing effectiveness of your 

quotations. 

Quote list 

 

To view quotes, select Workspace > Quotes in the navigation tree. 

From here, you can create a new quote by clicking New button or Clone button, to copy 

existing quote. 

On the ribbon, you will find the following buttons: 

 Send a message to customer. Allows to send a message with a generated quote to a 

customer, using built-in mail sender. If Quote file field contains generated quote pdf 

file, this file will be attached to a created message (i.e., you have to generate and save 

PDF file before using this function). 

 Create translation project. Creates translation project and translation jobs inside it for 

each language pair existing in a quote. 

 Create translation job(s). Creates translation jobs for each language pair existing in a 

quote. 

For all created jobs the system will pre-fill all possible fields. You have to only make 

necessary changes, check prices and save a job. The system may behave differently, 

depending which button you clicked: 

 If you create a project, project editing window will be opened, where you can 

view created jobs. 

 If you create one job, job editing window will be opened. 

 If you create multiple jobs, you will see confirmation window with information 

about number of created jobs. Then, you can open job list and manually edit or 

delete created jobs. 



 Accept quote. Changes quote status to Accepted and creates translation project or 

translation jobs, depending on application settings. Accept action marks a quote as 

accepted and creates: 

 new translation project with batch of jobs, if a quote contains multiple language 

pairs; 

 new single translation job without a project, if a quote contains only one 

language pair. 

In any of these two cases, project or job editing form will be opened after 

pressing this button. 

 Decline quote. Changes quote status to Declined with possibility to provide 

explanation. 

 Generate PDF(s). Allows to automatically generate PDF files for selected quotes, attach 

them to corresponding quotes, and optionally save them to hard drive. 

If you use customer portal, you can send a message using in-app notification system by 

selecting Send a message to customer > Send notifications to customer's users. 

You can quickly change Status for selected quotes. To do this, select necessary quotes and 

select Change status on the ribbon. Select necessary status, and it will be immediately applied 

to your quotes. 

Quote creation 

To create a new quote, click New (Ctrl-N) in the quote list and fill-in the form. 

 

Fields description 

Date 

Date of quote. 



Sequential number 

Internal numeric sequential number of a quote. Numeration follows the same settings which 

are specified for translation job (global or per-customer). 

Document number 

Sequential number converted using translation job format number (specified in settings). 

Fuzzy scheme 

Default fuzzy scheme, if differs from customer's default fuzzy scheme or global application 

default fuzzy scheme. 

Status 

Status of a quote for easier management. Available statuses: Prepare, Sent, Accepted, Cancelled. 

Quote due date 

End date of quote validity. 

Delivery date and time 

Free text to explain your customer when particular job is going to be delivered. 

Customer 

Potential customer. Selected from general list of customers. You can create special category for 

potential customer. 

Customer contact 

Contact person of a selected customer. Can be created on fly. 

Currency 

Quote currency. 

Responsible person 

A person who created a quoted and is responsible for it. 

Price-list. Allows to explicitly specify price-list for a quote, if you wish to use non-default price-

list for a selected customer. When you select any value in this field, if a quote already contains 

some items, the system will offer you to re-determine price for all items. 



Specialization. Allows to specify specialization for a project (which may effect on applied 

prices). 

Source language 

Source language for files in quotation 

Target languages 

List of target languages selected in a form of tokens (type comma to finish entering a language 

and move to a next one) 

How it looks on Windows version: 

 
And in web-version: 

 

Quote items 

Table to describe tasks performed in this potential job, along with units, language pairs, 

quantities, prices, discounts and amounts. 

There is a button called Adjust rates ( ) above this table. It allows to increase or decrease 

Price value in the selected quote items by a specified percentage value. When this button is 

clicked, a dialog appears, where you can enter percentage value for adjustment. To increase 

price, enter positive value, and to decrease prices, enter a value with minus sign. 

File attachments 

List of attached files or links to files stored on cloud drives. Simplifies file sending when you 

create a mail message from a quote. Later, if a job or a project will be created based on a quote, 

files will be copied to that entities so you will have direct access to them from a create 

project/job. 

Additional notes 

Formatted text to include in quote printing form. 



Translation jobs 

Contains translation jobs created from a quote after its acceptance. 

Messages 

Allow to exchange messages with a customer (when web-portal is used). 

Totals 

Quote totals (amount from Quote items table). Also allows to specify taxes and additional 

charges. 

Payment policy 

Free text allowing to describe payment terms for this quote. 

Quote file 

When you print a quote, you can save generated quote as pdf and attach it to a quote using this 

field. Later this file can be attached to an e-mail sent to a customer. 

You can quickly insert set of predefined tasks into a quote. To do this, click Insert set of 

predefined tasks and select one of pre-defined sets. 

Also, quotes support analysis import, as translation jobs and assignments. To import analysis 

results from a CAT tool, select Import data from CAT tools and follow default procedure of 

importing analysis reports. This will help to generate and calculate quote amount much faster, 

as the system will automatically detect prices for each imported row. 

When you're ready, click Save or Save and close to save a quote. If customer's minimal charge 

value is provided and is less than quote amount, you will see a warning. Otherwise, quote will 

be saved without additional questions and will be ready for printing. 

Integration with SDL Trados Studio 
and GroupShare 

While creating a quote, you can leverage Business Manager’s capabilities of integration with 

other SDL Products. 



To quickly create analysis in SDL Trados Studio, click SDL Trados > Create a project in SDL 

Trados Studio, and follow procedure described in the Creating a project in SDL Trados Studio 

from SDL Trados Business Manager article. 

 

 In the result, you will quickly get wordcounts and estimation additional services (like 

proofreading) in a quote, just in few clicks. 

The same process is supported for GroupShare, but it has more workflow variants: 

1. If a project already exist in GroupShere, do the following: 

a. Click SDL Trados > Link with GroupShare project; 

b. Select a project and click OK. 

c. Click SDL Trados > Import analysis from GroupShare. 

2. If a project does not exist in GroupShare, do the following: 

a. Click SDL Trados > Create a project in SDL Trados GroupShare; 

b. Follow Creating a project in SDL Trados Studio from SDL Trados Business 

Manager article; 

Click SDL Trados > Import analysis from GroupShare. 

Quote printing 

When a quote is prepared, save it and click Print button on the ribbon. Default quote template 

will be used (customer's or global). If you have multiple quote forms, click an arrow near 

printing button and select desired template. 

By default, SDL Trados Business Manager has 2 built-in quote templates. One simple, and 

second with TM savings. Second template is a copy of first template, but contains additional 



Price and Amount columns. These columns show amounts which customer could pay of there 

were no TM applied and the whole volume was 'No match' words. And totals section at the 

bottom of a quote displays total savings thanks to applying TM. 

If quote template supports post-editing, make necessary adjustments right in the preview 

window: 

 

When done, you can: 

 simply export generated quote to any supported format (pdf, Word, Excel, image, txt, 

etc.): 

 
 click E-mail via SDL Trados Business Manager to create an e-mail message and attach 

PDF file with quote to this message; 

 click Save as PDF and attach to a current document to save generated quote in PDF 

format and put it into Quote file field. 

Automatic notifications 

Depending on actions performed in a quote, SDL Trados Business Manager could send 

automatic notifications to a company’s user (manager) or customer’s user. 



When quote is created by a customer via customer portal, SDL Trados Business Manager will 

send notification about new quote request to all application users (except vendors and 

customers) with checked Send notifications checkbox. 

When user (manager) changes status of a quote from Prepare to Sent, an automatic e-mail 

notification will be sent to: 

 A user who created quote request provided that this user has email specified and 

notification method is set to Email or Both; 

 

 
 A user linked with a customer with Email field value equal to e-mail of a contact person 

selected in a quote, provided that Notification method for that user is set 

to Email or Both; 

 

 
 All users associated with a customer with provided e-mail address and Notification 

method set to Email or Both. 

If no e-mail notifications were sent, in-app notification will be set to all users associated with a 

customer and Notification method set to In-app or Both. 

When a customer accepts a quote, notification will be sent to: 

 If a quote has responsible person selected and e-mail address is provided for that 

person, to that e-mail address (if default e-mail account exists in the system); 

 Otherwise, to all users with Receive notifications checkbox enabled (except customers 

and vendors). 

Translation jobs 



Translation jobs are the heart of the SDL Trados Business Manager. After all, it was designed to 

provide project management and invoicing features, which are closely connected. 

If translation project is just a 'shell' for jobs, each actual work should be recorded in jobs, which 

may belong or may not belong to a project. In terms of accounting, it's a transaction which 

describes actions, which should be done by our company (or by us), and amounts, which 

should be paid by a customer to our company (to us) after successful completion of this work. 

Main characteristics of a translation job is that it can be created for a single language pair. 

When a job is created, it is necessary to 'describe' it as fully as possible. In SDL Trados Business 

Manager, this description includes the following data: job status, date, deadline, client, client 

contact, currency, work field (specialization), purchase order information, project name and 

description, responsible person, instructions, main project (which aggregates a number of 

jobs), language direction and the list of tasks and receivables. List of tasks, in its turn, describes 

ALL actions you perform during this job. For example, translation, proofreading, alignment and 

other tasks. Every task is described by numbers, expressed in different units, which totally give 

final job amount. So, each task has the following attributes in SDL Trados Business Manager: 

work type (for example, 'Translation'), fuzzy type (for example, 'No match' or 'Repetitions'), 

quantity, rate (price) and amount. Optionally, it's possible to provide discounts for future 

invoicing. When needed, Receivables feature allows to split description of work and amounts. 

Additionally, you can create the following entities over any job: translation assignments (to 

record job outsourcing), outgoing and incoming invoices and additional expenses. 

See nested articles to read detailed information about viewing list of jobs, creating and editing 

jobs, and other features available for this entity. Also, check Project finishing article, which 

describes a process how to finish a project and deliver it to a client. Same concepts apply to 

jobs as well. 

Translation job list 

Job list contains a lot of useful functions to facilitate translation project management workflow. 



 

Note. Default colors can be changed using Conditional formatting feature. 

From list of jobs, you can view, filter, group, search through ALL translation jobs saved in the 

system. This list allows to perform many tasks, including tracking of delivered jobs and 

assignments, sending messages, printing confirmation, changing jobs in batch mode, creating 

invoices, etc. 

The main functions available in the list view: 

Change status 

Allows to quickly change status for the selected jobs. 

Change deadline 

Select necessary jobs, type desired deadline and select a button near date field. New deadline 

will be applied to all selected jobs. 

Create invoice 

Select uninvoiced jobs and select this button to quickly create an invoice. Invoice amount will 

correspond to selected jobs amount, and default tax will be applied. So, in ideal case, you can 

just select save and then print generated invoice. 

Create translation assignment 

This command allows to quickly create translation assignments from selected jobs. You will 

then need just to select a contractor who will perform the job. 

Add/update WIWO entry 

This is a part of ProZ.com integration. Select this button to quickly post WIWO (What I'm 

working on now) entry for the selected job. 



Batch change 

Opens a window, which allows to apply same value to some filed for all selected jobs. For 

example, you can select any number of jobs (holding Shift or Ctrl keys) and change Status, 

Deadline, Delivery date, Work field, Project, Language direction for all of them in a single 

operation. In this operation you can select which fields must be changed. In the following 

example we only change Status to Sent and Work filed to Letters for the selected jobs. 

Print 

Allows to generate confirmation report for a selected job. 

View variants 

Each list in SDL Trados Business Manager may have a number of variants. For example, you 

may have additional view variant with less columns, or with columns needed for outsourcing, 

or even transform simple table to pivot (analytical) table. 

Analysis variant allows to get analytical table, allowing to get some aggregates 

You can create own variants. This is described in the corresponding article of this manual. 

Filters 

This menu contains a number of predefined filters and a button to create and apply custom 

filters. 

Also, there is a special Quick filters button, which not only provides another way to quickly 

filter list of jobs, but also displays amounts for last 12 months and top customers: 

 

Top part contains list of months and amounts, while lower part lists top customers with 

amounts. Select any item in this list to filter list of jobs by month or by customer. 



Instead of setting up filters manually, you can use predefined filters or create your own. 

The list itself is highly customizable. You can sort it by selecting on the column name, apply 

filters, change the order of the columns, hide and display necessary columns (right click on the 

column header and select Column chooser), apply conditional formatting, perform search with 

results highlighting, group rows and get different summaries for groups and in total. 

Hidden columns 

Please note that translation job list has a lot of columns which are hidden by default. 

Other tables throughout the program also contain hidden columns which you may display, but 

the job list is an absolute leader in this area. It is recommended to check this list and display 

those data which may seem more important personally for you. 

To show hidden columns, right click on the table header (on any column) and select Column 

chooser. 

Amount per hour 

When time tracking feature is used, this column will display amount earned per tracked hour. 

Assigned volume 

Weighted volume assigned to contractors. 

Assigned amount 

Amount in the base currency of all translation assignments created for this job. 

Average volume  

Weighted volume of a job. 

Avg rate 

Average price of a job. 

Base quote 

If a job was created from a quote, it shows a link to a base quote. 



CAT Icon 

When a job is linked with a CAT project (i.e. Trados), its icon will appear in the list, to visualize 

link and help to faster find jobs linked with CAT projects. 

Contractors 

List of contractors assigned to a job. 

Created at/by 

Date of creation and user name. 

Currency rate 

Currency rate used in a job. 

Date delivered 

Date when job was marked as delivered. 

Date of rejection 

If job was cancelled, you can specify cancellation date. 

Delivery method 

Method of delivering final translation. 

Edit time 

Time spent on a job (in Days:Hours:Minutes format). 

Edit time (minutes) 

Job edit time expressed in minutes. 

Has instructions 

Check-box showing that a job has additional instructions entered in the corresponding field. 

Invoiced amount 

Amount of all invoices issued over a job (in the base currency). 

Invoices 

Numbers of invoices created over a job. 



In-work assignments 

Number of assignments created over a job, which are still not delivered. 

Margin 

Difference between job amount and assigned amount (in the base currency). 

Paid date 

When a job is invoiced in full and all invoices are paid, this column shows date of last payment. 

Progress 

Estimation of a job progress. It may be detected using several algorithms. If a job is linked with 

CAT tool project, than progress value will be gathered from that project. Otherwise, if 

Workload planner feature is turned on, progress will be calculated based on day workload and 

workday start and end times. Otherwise, simple extrapolation method will be used. For jobs 

linked with GroupShare, this column will display progress of a current phase. 

To-do 

Number of items in checklist. 

Uninvoiced amount 

Job amount minus invoiced amount. 

Volume per hour 

Average speed based on Edit time value. 

Note. The same list of hidden fields is available in the job list in the Dashboard. 

Job editing form 

This articles describes fields you will find in the default translation job editing view: 

 



Number 

Simple internal number. When a job is created, a new incremental number is assigned 

automatically. You can enter only numbers here. 

Number (f) 

Formatted number, which may be generated automatically according translation job 

numbering settings. 

Date 

Date of job creation. 

Deadline 

Deadline of the job. You can specify day and time of delivery. By default, time is set to a time 

which is specified in the program settings, under Productivity settings tab. This field is 

displayed on the dashboard. And the row color in the list of projects depends on this field. If 

delivery day is today, than this project will be marked as urgent (red color). If delivery date is 

tomorrow, than it will be marked as 'Soon' (green). Other rows would not have any colors. This 

field has few additional inline buttons: Select from predefined time values and Copy date 

delivered to deadline. 

Status (or Work st. in lists) 

Describes the work state of a job. You can choose one of the following statuses: Received, On 

hold, Processing, Partially finished, Finished, Sent, Cancelled, Rejected. 

 

Received  Used when the job arrived but still not confirmed (preparing a quote). In this case it is not included into the client's bala

Processing Job is currently in work 

Finished A job is finished but has not been sent still 

Sent A job is sent and can be invoiced and paid 

Rejected 
project is sent, invoice is issued but for some reason the client rejected to pay. In this case this amou

balance with the client. Also, Rejection date field appears to enter the date when the job was rejected.

Archived 
Allows to lock a job, as it becomes uneditable. Also, you can create custom filter which filters archived jobs out t

job list loading performance. 



When status is changed from Processing to Sent, Delivery date is set to the current date and 

time. Also you can transfer data from deadline to delivery date by pressing corresponding 

button in the Date delivered field. 

Status of payment (or Payment st. in lists) 

Displays payment state of a job. Usually it changes automatically when you create invoices over 

jobs and payments over invoices. The following statuses are available: Not invoiced, Invoiced, 

Partially invoiced, Paid and Rejected. 

Not invoiced Initially, all jobs get this status by default 

Invoiced or Partially invoiced Automatically assigned when you create full or partial invoice over a job 

Paid Assigned when you create a full payment (or payments) over all invoices issued over particular job

Partially paid When a job is invoiced and non-full payment exists for at least one invoice

Delivery method 

A simple way to save a method of delivery. This is a drop-down list which is populated on the 

base of previous values. If necessary value is missing, simply type it here. Next time it will 

appear in this list. 

Post WIWO check-box 

Allows to create WIWO (What I am working on now) entry on ProZ.com after saving a job. If to 

check this mark, then after saving a job WIWO editing window will appear with some pre-filled 

data. You ill be able to make necessary corrections and select OK to send information to the 

WIWO service. 

Customer and PM 

As expected, allow to select a customer and your project manager. After selecting particular 

customer list of PMs will allow to select only a contact which belongs to a selected customer. By 

default, when you change a customer, previously used contact will be automatically selected in 

the PM field. 

To quickly view default rates for the currently selected customer, just hover mouse pointer 

over Customer field (only Windows version). You will see a tooltip with customer's price-list. 

If tooltip is not shown, this means that this customer has no default rates defined. 



Price-list 

Allows to explicitly specify price-list for a job, if you wish to use non-default price-list for a 

selected customer. When you select any value in this field, if a job already contains some tasks, 

the system will offer you to re-determine price for all tasks. 

Currency 

Allows to select a currency used to estimate job amount. 

Specialization 

Allows to specify a specialization of the job. Dividing jobs by work fields (specializations) helps 

to generate stats and to see the fields in which you perform better. This information could be 

included in the CV to allow potential clients see statistical expression of your experience, as 

well as in many built-in and custom reports. 

PO number, PO date, Job name and Client ref. number 

Purchase order details. 

Responsible person 

Intended only for teams and allows to select staff member responsible for this job. Later it will 

be possible to generate reports showing performance of each staff member. 

Note. When Responsible person is selected, and a user exists in the system which is linked 

with that responsible person, then that user will get notifications about created job or changed 

status. 

Translation project 

Allows to select a project for this particular job. It is a common thing when a project is 

translated into many languages or implies outsourcing. Also, projects can be used when you get 

translation jobs from the same client on a regular basis (say, every week), and all of them 

belong to one big project you work during a long time. Projects are a 'shell' for jobs, allowing to 

calculate some totals and margins over included jobs and assignments.  

Job tasks and Receivables tables 

Job description with all actions required by this job, prices and amounts. See separate 

article describing these tables. When you add or edit rows in the job tasks or receivables tables, 

job total amounts (at the right of these tables) will be automatically re-calculated. If currency of 

the project differs from your base currency selected in the profile, then the system will try to 

get currency rate to convert project amount into your base currency. If the rate is missing in 



the Currency rates list, then default rate will be used (1). In this case, you can download 

currency rate by selecting corresponding button onside this field. Or you can open Currency 

rates list and add missing rate there. Then go back to a job and re-calculate amount. 

Checklist tab 

 
Allows to add to-do items needed to be done before delivering a job. When a job is created, this 

tab could be filled with contents of a default checklist, which is selected in the application 

settings. 

Instructions tab 

Allows you to specify instructions for particular job. It fully supports formatting to highlight 

important points: 

 

File attachments tab allows to attach job files (source files, reference files, glossaries, TMs, 

etc.). These files are stored directly in the database and not linked with source files on your 

hard drive. Also, they can be stored in one of supported cloud drives (Dropbox, Google Drive 

and Microsoft OneDrive). Once the file is attached, it can be deleted or moved on the hard drive. 

(but not on cloud drive). Use this function with care, because it leads to database file size 

growth. Currently, maximum file size in a local mode is 4 Gb. In network mode, file size is 

unlimited. To attach a file, select on the Add from file.... After selecting a file, specify its type in 

the File type column by selecting necessary value from the underlying reference table (you may 

create additional file types on fly). These files are stored inside database, and available to other 

users who may open this project from another computer or web-version. 

On the Files (on disk) tab you may select a local folder where project files are stored. Use this 

tab if you do not need to provide access to project files to other users. These files are stored 

only on your computer and not available to others. 

 



Workload planner 

This tab contains work periods for a job. See Workload planner article for detailed 

information.  

When Workload Planner feature is turned on in the Program Settings, this table will be 

automatically filled when you save a job. You can manually adjust entries created by default. To 

do this, mark Manual allocation checkbox and make necessary changes in created rows. 

To allow automatic planning system to include weekend days (Saturday and Sunday) while 

allocating a job, mark Allow weekends checkbox. 

Start time and End time optional columns allow you to define time period for each working 

period. By default, the program uses work day periods defined in the program settings 

under Productivity tab. When Scheduler function is used (turned on on the program settings), 

the system will create corresponding appointments in the calendar (with specified time 

periods). 

Messages 

This tab allows to exchange messages with customer (when using web-version). 

On the Linked expenses tab you can create new expense or add existing expense to a job. As a 

result, some expense will be linked with a job and this expense will be automatically included 

in an invoice created over this job. Also it will affect on margin amount. 

Book (ledger) and Book (mutual exchanges) tabs allow to view records created by a job in a 

corresponding accounting books. These tables can be edited manually and get filled only after 

saving a job. 

Job totals 

When you make any edits in Job tasks or Receivables tables, totals are updated 

correspondingly. 



 

They include job total in a job currency, currency rate (and a date below it, to which this 

currency rate belongs) and amount in the base currency. If job currency and base currency are 

identical, then you will see the same amounts. As noted previously, job amount is calculated 

from the Receivables table if this table has at least one row. Otherwise, job amount is 

calculated from the Job tasks table. 

Currency rate is applied automatically from the currency rates list. This value can be edited 

manually, but in this case it will be applied only to the current job, but not saved in the 

currency rates list. 

If edited manually, you can use Refresh button to reload currency rate from the reference data 

list. This field also contains Download button to download and immediately apply today's 

rates. 

Another field here is Edit time, which value can be calculated automatically or edited 

manually. Edit time is calculated on the base of the previous data entered in another jobs. Thus, 

when you create a new job, the program uses historical data to 'predict' time needed to 

complete a job. When the job is done, you can edit it to provide more precise value here or use 

built-in timer functionality. It will influence on the future calculations. Later this value can be 

used to build charts displaying your performance change over time. 

CAT field displays information about linkage status of a current job with any CAT system. 

To establish such link, use CAT tool integration button on the ribbon (SDL Trados Studio). Such 

link establishment allows to quickly import analysis data, manage project packages, track 

project progress right from SDL Trados Business Manager, which is displayed in the list of jobs 

using Progress column. 



Time tracking 

Work time tracking in SDL Trados Business Manager has two main goals 

 To actually count your work time for further invoicing; 

 To manually enter actual work time after finishing a project for statistical purposes 

(count and build charts for average income per hour, average speed, etc.). 

To solve these tasks, you can use the following fields in the job editing form: Work time, Fix 

work time, and Work time column in the Job tasks table. 

Each of these fields contains Start timer and Stop timer buttons: 

 
Also, you can simply enter values manually. When you make edits in the Job tasks table (change 

quantities and units), the application tries to estimate work time based on previous jobs. This 

may lead to overwriting data you manually entered in the Work time field. To prevent this, 

tick Fix work time checkbox. 

When you edit value in the Work time column of Job tasks table, the system will calculate 

total work time and write it to the job's Work time field. 

To copy job's Work time value to the current task, select Apply time tracking to the current 

row button on the table's toolbar. The system will insert work time as hours and pick-up 

correct price for the task based on existing price-lists. The simplest statistical information 

associated with work time values is available right in the job list. The following columns are 

available (they are hidden by default, use the Column chooser to show them): 

 Amount per hour 

 Volume per hour 

 Work time (minutes) 

Additionally, same columns are available in the Translation projects list. Their values are 

calculated based on similar values from all jobs included in each project. Also, these values are 

displayed right in the project editing window: 



These columns allow to view and analyze your performance right from within job list. 

Additionally, there are a number of built-in QuickReports using this data and representing it 

in a visual format: 

 Profitability by time (pivot & chart) 

 Profitability by time (tabular) 

 Productivity Dashboard 

Additional commands in the job 
editing form 

Save and invoice command allows to save currently edited job and immediately create an 

invoice over it. The procedure is the same as described in the Invoices and payments topic. The 

only difference here is that this command allows to save few clicks and do invoicing operation 

a bit faster. 

Import data from CAT tools button allows to import analysis reports generated by CAT tools 

or even import analysis data directly from a CAT tool installed on your computer. 

Create translation assignment button allows to allocate a job to external contractors. 

SDL Trados button allows to use SDL Trados Studio integration features to faster manage a 

project. 

Job tasks and receivables 

These tables are used to describe job tasks and job total price. 

This is the start of your concept. Job tasks table is used to enter all actions (works) required by 

a particular job, including service type, fuzzy type (when required), quantity (including 

quantity assigned to external collaborators), unit of measure, prices, amounts and work time. 

In other words, it fully describes all the services which must be performed. 

 

 



Receivables table allows to separate job price calculation from the job tasks list. 

 

This table is optional and is not required to use. It may be used in the following cases: 

 When you want to 'shrink' job tasks table to include limited number of records into an 

invoice which will be created on the base of this job. For example, if a job contains a lot 

of fuzzy matches, proofreading and editing, instead of full fuzzy breakdown you can 

create one single row for Translation services, one row for proofreading and one row 

for editing. In a result your invoice will contain only 3 rows. 

 When total job price differs from amount you get in job tasks table. For example, you 

have agreement with your customer to translate 5000 source words per some price. But 

in fact, with a help of own TMs or based on other factors, actual wordcount appears to 

be lower. In this case you enter actual wordcount in the Job tasks table and then agreed 

quantities and prices in the Receivables table. Later, when invoice will be created, 

correct amount and list of tasks will appear there. 

Note. When you add something into the Receivables table, the following columns in the Job 

tasks table automatically become disabled: Price, Discount, Price with 

discount and Amount. 

 

To create a new row in any of these tables, click Add (Ctrl-N) or Clone (F9) on the toolbar 

above a table. 

To edit selected row, select inside desired cell. 

Depending on selected cell, you may press F4 button to open its editor (calculator for quantity, 

list of work types for Work type, time editor for Work time, etc.). Note that when you save a 

row (finish editing it), the document would not be saved. Therefore, if you cancel editing the 

whole document (job), than all changes made in the job details and receivables tables will also 

be canceled. 

When a translation assignment is going to be created over translation job, you will be able to 

allocate only tasks listed in the Translation job tasks table. Each task has quantity, and a job is 

counted as fully allocated (outsourced) when quantities in translation assignment tasks 



created over a job equal to quantities of a job's tasks. To track this, Job tasks table has special 

columns: Assigned quantity and Unassigned quantity. These fields are hidden by default. 

Fields hidden by default 

Job tasks table contains a number of fields which are hidden by default. 

Right click on the table header and select Column Chooser to display a list of hidden fields. 

Here you will find a number of fields, which may be useful in your work. 

Amount per hour 

Amount per hour for a task, according task's tracked time. 

Amount with default tax 

In the application settings you may specify default taxes. This column shows amount of a task if 

to add default taxes to an Amount. 

Assignee 

If a task is assigned (translation assignment created over it), this column shows name of a 

contractor. 

Discount/Markup (%) 

Positive value means markup, negative - discount, 

Fuzzy weight 

Weight of a fuzzy type according to selected fuzzy scheme. 

Quantity (weighted) 

Quantity multiplied by fuzzy wights. 

Rate with discount/markup 

Price calculated from entered discount/markup value. 

Tax 1, Tax 2 

Names of default taxes. 

Notes 

Additional notes for a task. 



Quantity assigned 

If a translation assignment(s) is created over a task, this column shows quantity 'taken' by 

these assignment tasks. 

Quantity unassigned 

Quantity which is still not assigned by translation assignment(s) created over a task. 

Each of these fields can be used in invoices, custom reports or job confirmation documents. 

Job files 

SDL Trados Business Manager provides two ways of storing job files: by creating and viewing 

folders on your hard drive and by attaching files to the job. Usage of these ways depends on 

your workflow. 

File attachments 

This is another way of storing files. It allows to load and store files right inside the SDL Trados 

Business Manager database. 

Please use this function with care, because it leads to database file size growth. Currently, 

maximum file size in a local mode is 4 Gb. In network mode, teams which use the SDL Trados 

Business Manager database server get 250 Gb of space (which may be expanded according 

growing requirements). 

To attach a file, click Add from file button. 

After that, specify file type and correct date, if needed. File type is selected from the reference 

table. 

To open attached file using default program, select Open (or Ctrl-O on the keyboard while this 

file is selected). 

To add a file from cloud drive, click one of cloud drive buttons. A popup window will be 

displayed with contents of your cloud drive. 

Files on disk 



This mechanism allows to view an actual folder on your hard drive. 

In the Application settings a few parameters were introduced, which allow to specify folder 

creation rules. Actually the folder can be created from the job form, or you may create it 

manually using Windows Explorer. Since the job folder name depends on different parameters 

(project number, date, customer name, project name, etc.), then this name will be changed 

while you are changing values in different fields: 

 
If the determined folder already exists on disk drive, than its contents will be displayed on 

the Files tab. 

 

 If the folder does not exists, than you can select button 1 to create it. 

 If the folder does not exists, than you can select button 2 to create it and open in 

Windows Explorer. 

 If you wish to re-determine job's path according application settings, click button 3. 

 To select existing folder using directory picker, click button 4. 

 To choose folder manually and prevent application from determining path 

automatically, check the box 5. 

After folder creation, its contents will be displayed in the list. If you put any files into this folder 

from Windows explorer, than you can update this view by selecting on the Refresh button. 

To view any file from the file list, just double click on it. 

Also, it is possible to copy and move files to the job's folder without opening it in Windows 

explorer. To do this, just drag the file or folder (from desktop or any other location) and drop it 

on the left area (to copy) or right area (to move). The files will be copied or moved (be sure if 

the files are not opened in another application to move them) to the currently selected folder 

and displayed immediately. 

Sending files 



While viewing job list or editing a job in the job detail form, you can quickly create a mail 

message to send it to a job's project manager with a number of attached files. 

To create a message, click Write a message to PM: 

 
Take a note that this button would not be available in the job detail form if current job has 

unsaved changes. 

File selection window appears: 

 

Select necessary files by holding Ctrl or Shift keys and select OK. 

Optionally you can check As internal attachment checkbox. It means that selected files from 

the Job files on HDD group will be attached to a message and stored with it in the database. 

Otherwise, selected files will be attached as links to files on HDD. 

After clicking OK a default message composing form will be opened in a popup window, where 

you can specify message subject, apply message template, add another recipients, etc. 

Save a message and click Send to send a message. 

Select Close to close the popup window and return to a job. 

Creating jobs from CAT tools and 
analysis files 

Since SDL Trados Business Manager supports the import of analysis data to quotes, projects 

and jobs, there is a separate section in the manual to describe this tool. See Analysis file 

importing article for detailed information. 



Invoice creation on the base of 
selected jobs 

To quickly create invoice for a number of jobs, simply select necessary jobs using Shift (to 

select range of jobs) and Ctrl (to select jobs one by one) keys. 

Click Create invoice on the ribbon. To create in-advance invoice, click drop-down button and 

select In-advance invoice. 

If you selected jobs for different customers or with different currencies, than you will get a 

notification that invoice can not be created. In other case, invoice adding form will be opened, 

where it will be possible to make final changes before saving new invoice. 

Job templates 

Creating a new translation job template 

1. Open any job and find Save as a template option under Save options button: 

 
2. Select it and enter name of a new template. The system will create and save a new 

template. Please note that this button is unavailable if opened job has unsaved changes. 

Using translation job templates 

1. Find Quick job creation button in the Home tab on the ribbon. This button is always 

available, regardless which tab is selected right now. 

2. First section allows to refresh list of customers and templates (sometimes you need to 

refresh the list after creating a new template). Second part is a list of your recent 

customers you did work for. And in the bottom part you will find list of your templates. 



Select any to create a new job using that template. 

 

Managing/deleting translation job templates 

1. Select Quick job creation button and select Manage job templates option. 

2. You will see list of existing templates, which includes only two columns: template name 

and job reference. 

3. Here you can rename existing templates (double click to open editing form) or delete 

them. 

Printing an order confirmation for a 
job 

Create a job, specify all types of work and prices, then save it. 

When done, return to the job list, select the created job and select Print on the ribbon. Order 

confirmation form appears: 

 



This is a default form which may be customized. You can see drop-down button 

near Print button, which contains a list of the custom order confirmation templates. These 

templates can be found under default Reports and templates list, which is available from 

the Reports section of the navigation tree. 

To create own order confirmation form, just copy predefined one, rename it and then open in 

the designer. 

After that new printing form will appear in the drop-down menu under Print button. 

Quick job creation function 

There is Quick job creation button on the ribbon. It is available regardless currently selected 

view, and contains a sorted list of customers you have recently did work for and custom list of 

job templates: 

 

Select any customer or a template, and a new job will be created based on the most recent job 

you did for the selected customer or a selected template. 

Select Empty job to quickly create an empty job, regardless which form you are currently 

viewing. 

Select Manage job templates to open template list (to view, edit or delete them). 

List of customers and templates is updated on the program launch. 

To refresh it, select Refresh list of customers item, which is very first item in this drop-down 

list. 



Calculate amount of selected jobs 

If you need to get an amount only for the selected jobs, just select them. The amount for the 

selected jobs will be displayed in the list. 

 

Conditional formatting in job list 

It is possible to apply different conditional formatting rules in the list of jobs (as in the other 

lists). See full description of the conditional formatting feature. 

 

Example: 

1. To create a new rule, right click on the column name you like to format, 

select Conditional formatting, and then select a type of formatting you like to apply. 

2. Right-click on the Amount (base) column, select Conditional formatting > Data 

bars > Green. Example of results: 

 



Translation projects 

To account incoming work in SDL Trados Business Manager, the following 

terminology/hierarchy is used: 

 

Translation projects are placed at the top of this hierarchy and are used to aggregate 

translation jobs; however they are an optional entity which are not required to create 

translation jobs (which are the only entity type to account performed tasks). Translation jobs 

contain information relating the the work that has to be done and that has to be paid by the 

customer. Translation assignments are created (optionally and only if external contractors are 

used) over translation jobs and contain information about the work that has to be carried out 

by the contractor and what has to be paid to them. 

While translation projects are optional, it's recommended to create them when your project 

includes multiple target languages, requires to employ external vendors and perform a lot of 

management tasks, because translation projects allow to control all these objects from a single 

place. It will allow you to view, create and edit all jobs and assignments along with their tasks 

on one screen, as well as view project results (total amount of jobs and assignments, margins, 

effectiveness). 

Here is a list of translation projects: 

 

For freelance translators, projects can be used for grouping long-running project which include 

a lot of jobs paid/invoiced separately. It is fully allowed to not specify a project in a job (the 

field may be left empty). But when you specify a project in a job, job amount and quantities will 

be added to the project. As a result, you will be able to see how much jobs were included in 

particular project, how much words you translated or hours spent, when the project has been 



started and when the last job has been done. Except aggregation, projects can be used in CVs - 

you can mark which projects must be included in CV to highlight the most 

interesting/important projects in your career. 

Note: If a project is linked with a GroupShare project, you can track its status by displaying 

the Progress column in the list. To do this right-click on the table header, select Column 

chooser, and drag the Progress field to the table. If a GroupShare project contains multiple 

files (which currently could be in different phases), then progress will be calculated as average 

progress of all files in their respective phases. For example, if one file is fully completed 

in Finalization phase, and second file is fully translated in Translation phase, then average 

progress will be displayed as 100%. Please take a note on a current phase when you’re 

downloading files from GroupShare.  

Take a note on a special Quick filters button in the project list, which not only provides another 

way to quickly filter list of projects, but also displays amounts for last 12 months and top 

customers. Top part contains list of months and amounts, while lower part lists top customers 

with amounts. Select any item in this list to filter list of jobs by month or by customer. 

Note. Project list has a number of columns which are hidden by default: Additional 

expenses, Assigned amount, Created/modified at, Created/modified by, Responsible 

person, PO Number, etc.. To show them, use Column chooser function (right click on the 

table header and select Column chooser). 

For example, among these columns you will find In-work jobs and In-work assignments. 

These columns display a number of jobs and assignments which were not delivered still. 

However, if project is in work, but it doesn't have ongoing jobs and assignments, this means 

that such project could be closed (delivered), if you don't expect new jobs in future for this 

project. In such situation, a project will be highlighted with orange color in the list. 

To quickly change status for multiple projects, select them and select Change status on the 

ribbon (or right click and select it from the context menu). 

Translation project list, as other lists in SDL Trados Business Manager, also has Clone button. 

But it’s behavior is little different. When you click on this button, translation project will be 

cloned using default cloning functionality. However, this button has drop-down button, which 

also includes Clone with translation jobs option: 



 

This allows to clone selected project and create copies of all translation jobs from the selected 

project. 

Project creation and editing 

To create a project, select New in the Project list and start filling data: 

 

The form contains a number of tabs. First one, Main data, allows to enter basic information 

about a project: status, date and deadline, customer, default fuzzy scheme for project jobs, 

specialization, PO number, etc. Responsible person field is intended only for teams and allows 

to select staff member responsible for this project. Later you will be able to generate reports 

showing performance of each staff member. 

Status of a project may change automatically depending on a status of project's jobs. When all 

jobs of a project are in the processing state, finished, delivered or paid, respectively, then 

project status could change to In work, Finished, Delivered or Closed. 

Note. When Responsible person is selected, and a user exists in the system which is linked 

with that responsible person, then that user will get notifications about created project or 

changed status. 

Price-list field allows to explicitly specify price-list for a project and underlying translation 

jobs, if you wish to use non-default price-list for a selected customer. 



Base quote field allows to select a quote which was used as a base to create this project. When 

quote is accepted and project is created over it, this field is filled automatically. 

In the middle of the form you can select Source language and Target languages. Target 

languages are selected in a form of tokens: 

How it looks on Windows version: 

 
And in web-version: 

 
Target languages don't limit language pairs used in translation jobs inside a project, but allow 

to quickly create new jobs. In addition, when language pair is selected in a translation jobs, 

project's language pairs will be highlighted in the drop-down list. 

Instructions tab allows to provide instructions for a project using an editor which supports 

rich formatting. When you will be creating jobs under a project, these instructions will be 

copied to all created jobs (with possibility to make individual edits in each job). 

Work time section allows to view summary of time tracking data from all jobs belonging to a 

project. Data displayed in this group will be correct only if you correctly fill corresponding 

fields in jobs. Here you can get some statistical information, like total work time in minutes, 

processed volume per hour and income per hour. 

Totals section displays project totals (amount, assigned amount, margins, etc.). This group is 

visible no matter which tab is currently selected, and values here are updated each time you 

make any changes in a project (for example, edit job task or create a new assignment). 

Translation jobs and translation job 
tasks 

On these tabs you can view, create and edit project jobs. 



The Translation jobs list is a standard job list, but it only shows the jobs for the current 

Project view: 

 

From here you can double click any job to open it's editing form. To create a new job, 

click New, which is default way of creating entries in SDL Trados Business Manager. Job 

creation form will be opened. Also, above this table you will find Create jobs button. This 

button will create a number of empty jobs according to language pairs of a project. For 

example, if your project contains three target languages, and for one of those language a job is 

already created, then this command will create only two jobs for rest language pairs. New jobs 

will be numerated and their data will be filled from a project. Amounts and quantities will be 

zero, so you can manually add them (import from CAT tool) or do it in batch mode from 

the Translation job tasks tab: 

 

This tab contains all tasks of all jobs from a current project, grouped by translation job and 

language pair. In addition, this table supports inline editing, which means that you can make 

direct changes in this table without opening separate job editing forms (of course, you can 

make changes only in displayed columns). However, you can still open full job editing form 

from a Translation jobs tab. 

Note: Sometimes you may select a cell with a drop-down button, and then immediately select 

this same drop-down button. If you double-clicked too fast the system may open the job editing 

form instead of expanding the drop-down list. To avoid this leave a short pause between clicks 

before attempting to expand the drop-down list. 

From here, you can not only edit all tasks, but apply batch changes to all jobs, by clicking Add a 

new service to all jobs and Add a new service to the selected job buttons. Click Add a new 



service to all jobs to add the same tasks into all project jobs. A dialog will appear: 

 
If volume differs from job to job, you will be able to edit it after clicking OK. 

To add a task explicitly to one job, select any task which belongs to a desired job and click Add 

a new service to a selected job. Take a note that if a job does not contain any tasks, this 

button would not be available. 

If you wish to create an assignment over selected job task(s) (not over the whole translation 

job), you can select these tasks and click Create assignment button on the toolbar. It provides 

the following options to create assignments over selected job tasks: 

 

 Single assignment for all selected tasks - one assignment for all selected tasks. If 

selected tasks belong to several jobs, number of created assignments will equal to a 

number of jobs; 

 Individual assignment per each selected work type - one assignment per each 

service type will be created. If selected tasks belong to several jobs, assignments will be 

created per each work type in each job; 

 Individual assignment per each selected task - one assignment per each task will be 

created. 



Translation assignments and 
translation assignment tasks 

On these tabs you can view, create and edit project assignments.  

Translation assignments tab: 

 
It's a standard assignment list, but shows only assignments which belong to a currently viewed 

project. From here you can double click any assignment to open it's editing form. To create a 

new translation assignment, click New, which is the default way of creating entries in SDL 

Trados Business Manager. The job creation form will be opened. Also, above this table you will 

find the Create assignments button. This button will create a number of 

empty assignments according to a Workflow and Automation rule (optionally), selected 

above this table. Workflow value defines the number of steps (contractors). When you create a 

new workflow, you only have to specify which service types it includes and in which order. If 

the source order contains a step defined in a workflow, a new translation assignment will be 

created. If a job contains a service which is not defined in a workflow, this service will be 

included in the last assignment. If workflow is not selected, then application will create one 

assignment per each job which contains any unassigned volumes. It does not depend on service 

types (for example, if job contains multiple services, like translation, proofreading, editing, then 

all these services will be included in a single assignment). 

Example: You have a job with Translation, Proofreading and Editing services. If you wish to 

create three assignments (assign a job to three contractors), then the selected workflow must 

include all these three service types. However, if your workflow only 

contains the Translation work type, then the system will create one assignment for such job, 

and include all three services there. If your workflow contains 

only Translation and Proofreading, then the system will create 2 assignments: first for 

translation, and second for proofreading and editing. 



Automation rule determines if next assignment in a sequence should be started automatically 

after delivery of a previous assignment. 

As a result of this action (Create assignments), the system will create assignments with 

necessary tasks, with zero amounts and empty Contractor field. Deadlines of assignments will 

be determined automatically (based on workflow step, project deadline, and assignment 

volume, comparing to other assignments in a row). When necessary, change deadlines 

manually when assignments will be created. 

If you already know who will performing tasks, select necessary contractors in 

the Contractor column of the list. It is not even obligatory to open assignment editing window, 

because after selecting a contractor the system will immediately calculate assignment amount 

based on contractor's price list. 

To confirm this, you will see some value in the Amount column, and you can switch to 

the Assignment tasks tab to view which prices have been automatically applied to an 

assignment: 

 

Such approach allows to simultaneously work with a lot of entities and minimize amount of 

clicks/window switches while managing a project. 

Incoming and outgoing invoices 

When you create an invoice over any job or any assignment, these invoices will automatically 

appear in corresponding tabs, so you can quickly access them, view, print, register payments, 

etc. 

 

Instructions 



On this tab you can provide formatted instructions for a project. These instructions will be 

automatically transferred to all jobs created inside a project (with possibility to firther edit 

them in each individual job, when necessary). 

 

To format a text, use formatting buttons on the Editing and Insert tabs on the ribbon. 

Mail messages 

 

On this tab, you can view all messages create from project's jobs and assignments, as well as 

from a project itself. From here, you can create new messages (New button) and send messages 

(select one or multiple messages and click Send on the toolbar). 

Checklist tab 

This tab allows to create a list of items which should be marked as Completed before project 

delivery. You may define predefined sets of checklist items and add them automatically when a 

project is created. 

 

Additional expenses 

Additional expenses tab contains expenses linked with this project. When the system calculates 

margin, additional expenses are taken into account as well. 

 

File attachments and Files 



On the File attachments tab you can add project files (source files, reference files, glossaries, 

TMs, etc.). These files are stored directly in the database and not linked with source files on 

your hard drive: 

 

Also, they can be stored in one of supported cloud drives (Dropbox, Google Drive and Microsoft 

OneDrive). Once the file is attached, it can be deleted or moved on the hard drive. (but not on 

cloud drive). Use this function with care, because it leads to database file size growth. 

Currently, maximum file size in a local mode is 4 Gb. In network mode, file size is unlimited. 

To attach a file, select on the Add from file.... After selecting a file, specify its type in the File 

type column by selecting necessary value from the underlying reference table (you may create 

additional file types on fly). These files are stored inside database, and available to other users 

who may open this project from another computer or web-version. 

On the Files (on disk) tab you may select a local folder where project files are stored: 

 
Use this tab if you do not need to provide access to project files to other users. These files are 

stored only on your computer and not available to others. 

Project templates 

You can turn any project to a template and then use it to quickly create new identical projects. 

How to create a template: 

1. Open any translation project. 

2. Click Project templates > Save as a template… 

 
3. In the dialog, provide a name for a new template and optionally check Include jobs box. 

When this box is checked,  a new project created using this template will also contain 



copies of translation jobs from a source project. 

 
4. Click OK to save a template. 

How to use a template: 

1. Open list of projects. 

2. Click Project templates and select any previously save project template. 

3. Project creation window will be opened, with all fields copied from a base project. 

How to delete a template: 

1. Open list of projects. 

2. Click Project templates > Manage templates…. 

3. In the opened view, select necessary template and click Delete. 

Project finishing 

You have few ways to finish a project. 

Manually sending notification message and files 

When all jobs and assignments will be marked as finished, project status will also be changed 

to Finished, which signals about the need to deliver a project. 

You can open such project and click Send an e-mail to selected customer contact button to 

create a message. File attachments dialog will open, where you can select all files you wish to 

attach to a message: 



 

If you use automatic uploading to cloud drives, you can select files regardless their size. 

Otherwise, take a note on the File size column. Click OK, and system will display e-mail 

composing window. By default, Project delivery message template will be applied, so in ideal 

case you'll only need to check the text, recipients and files, and click Send to send a message. 

Otherwise, you can freely change anything in a created message before sending it. 

In the result, when you return to a project, its status will be changed to Delivered. 

Automatic notification about completed project 

If you use customer portal, application can send notifications about completed projects to 

customers automatically. This happens when project status changes to Delivered. To make 

this function working, you need to have a message template with Use as default for value set 

to Project delivery and non-checked Disabled box. 

Automatically created message will have attached all project files with type set to "Translated 

file', 'Proofread file' or 'Deliverable'. If total size of files which were automatically attached 

exceeds limit set in the application settings, then files won't be attached at all, and customer 

will receive only text message. Taking this into account, it's always recommended to include 

link to a project in the message template. Also, if you expect large files to be delivered, you can 

configure automatic files uploading to a cloud drive. In this case, despite the size of attached 

files, they will be uploaded to a cloud drive and link will be inserted into a message. However, 

take a note that corresponding variable should present in a message template. 

To know that message was automatically sent and delivered, you can switch to the mail 

messages tab: 

 

Invoices and payments 



Invoicing is one of the main tasks which SDL Trados Business Manager allows to solve. 

Here is the list of goals, which need a solution to handle this task: 

 Set invoice rules, which include customer requirements for issuing invoices, standard 

terms, etc. 

 Provide capabilities to create invoices on a base of uninvoiced completed jobs. 

 Print invoice or send it to the customer 

 Control payments against invoices 

 See unpaid overdue invoices and take corresponding measures 

 Archive paid invoices and mark corresponding translation projects as paid too 

Nested articles of this section describe all these tasks in detail. 

Invoicing rules 

When you edit a client, there are a number of fields intended to store information about invoicing. 

These fields include Default payment term, which specifies how invoice due date is 

determined, and Invoicing threshold field, which allows to set a limit, upon reaching of which the 

system will offer to create an invoice for a customer. Also, Comments field allows to add a free text 

describing invoicing process for the particular client. 

In addition to this data, each customer's contact has an Invoicing matters checkbox, which tells the 

system that this person may be contacted for invoicing matters. Such, there could be a number of 

invoicing emails for each client. In this case, when you intend to send an e-mail, these contacts will 

be automatically added to the To filed of any composed message. Of course, it is possible to edit 

them before actually sending an e-mail. 

A dozen of settings which affect invoice creation process can be found in the program Settings, on 

the Invoice settings tab. Here you can setup default invoice file names, default tax used in a newly 

created invoices, different numbering options, logo for your invoices and signature text. Also, 

information about unpaid invoices can be added to a Google Calendar. 

Invoice creation and invoice editing 
form 



After setting up invoicing settings, e-mails, default terms we can start to prepare invoices. 

There are a number of ways to prepare invoices. 

Invoice creation from list of jobs 

To automatically prepare an invoice, open Translation jobs list. Select necessary jobs and 

click Create invoice. In a result a new invoice form will be opened with pre-filled data from 

selected jobs. 

Note. The selected jobs must belong to one customer and have one common currency (you 

have to repeat invoice creation operation for all existing customer/currency pairs when 

creating invoices in a such way). 

A new invoice will be created, and you will see some details of the included jobs: 

 

The program generates next invoice number based on the program settings, automatically 

selects Customer, Currency and Payment method. Program also automatically 

detects Payment term on the base of a customer's settings. Do not forget to check if a term 

was detected correctly. 

Invoice status field determines invoice state. It can 

be Proforma, Created, Sent, Approved, Partially paid, Paid, Partially rejected and Rejected. If you 

enabled invoice protection in the invoice settings, then it won't be possible to edit or delete an 

invoice if it's status differs from Proforma or Created. 

Each row in Invoice details table is linked with a job. It allows to track invoiced and 

uninvoiced amounts for each job. This means that you can create multiple invoices over a 

single job (for example, for long jobs which require partial invoicing). However, it is not 

necessary to link each invoice row with any job. 



You can manually add new rows to the Invoice details table and leave Job column empty. In 

this case you can manually provide description and amount for a service included in an invoice. 

This could be additional expenses or special corrections. If you wish to charge your customer 

with additional expenses linked with some activity (provided that this expense is entered in 

the Expenses table). 

You can use Add expense button above this table to add an expenses from the list of expenses. 

Popup window will be opened, allowing you to select necessary expense(s). Select OK and 

selected expense will be added to an invoice. 

In the same manner, you can click Add job(s) button to add uninvoiced jobs for a selected 

customer. 

To understand if invoice item is linked with a job or not, see first column in the table: 

 

In the example above, Invoice details table contains information about 2 selected jobs 

(Description column is populated in the base of the Job name field). The Job contents column 

shows a source of job amount and a number of included rows (job tasks or job receivables). 

This number corresponds to a number of rows per each job which will be actually printed in 

the generated invoice. To preview these rows, switch to the Rows to print tab: 

 

Here you can see detailed information about each job included in an invoice. And now it shows 

4 rows, not 2 rows. This is because each of included jobs contains 2 tasks. So, in total we get 4 

rows for printing in an actual invoice. Job group column helps to find out corresponding row in 

the Invoice details table. 

Please remember this concept: you may add multiple jobs to an invoice, and each job may have 

multiple tasks/receivables. Because of this, Invoice details table shows only total amounts of 

each job, while Rows to print table shows full breakdown with services an prices. 



Sort column in the table is used to sort invoice rows in the invoice printing form. You can 

use Move Up and Move down buttons on the toolbar to change the order. Alternatively, you 

can manually type sort order in the corresponding cell. 

Partial factor column allow to issue partial invoices. Here you specify percentage of the total 

job's amount which must be included in an invoice. In this case corresponding jobs will be 

marked as Partially-invoiced. Quantity and Amount values will be decreased correspondingly. 

To see how this feature works, try to change a factor and then switch to the Rows to print tab 

to see that Quantity and Amount were correspondingly decreased. If a customer uses few 

currencies to estimate jobs, then it's needed to issue separate invoice for each currency. 

Before saving an invoice, make necessary corrections: edit Description and Notes fields in 

the Invoice details table. Select taxes and discounts when needed, and check final amount. 

Taxes may be filled automatically if Default tax 1, Default tax 2 and Default tax 3 fields are 

filled for a selected customer (or if corresponding fields are filled in general application 

settings). Of course, you can change taxes selected by default or simply clear them. 

Currency rate field contains a button to apply this rate to all jobs included in the invoice. This 

allows to recalculate amount in base currency in all jobs using one single currency rate. In the 

result, total sum of jobs expressed in the base currency will equal to the invoice amount in the 

base currency. 

Select Save or Save and close button to save an invoice. In a result, included jobs will be 

marked as Invoiced. 

When you create invoice for the first time, short interactive tutorial will show main elements 

on the invoice editing form: 

 

To manually open this tutorial later, select Show hints button on the ribbon. 



Invoice creation on the base of invoicing 
threshold 

Another way to automatically prepare an invoice is to set invoicing threshold for the customer. 

 

When jobs amount will reach this threshold, you will see a notification on the dashboard 

(Ready to invoice widget) that it is possible to create an invoice. 

 

 
Double click on it and you will be switched to the invoice creation form with all uninvoiced jobs 

included for the particular client. When you double click on any row, default invoice editing 

form will be opened, where you can make final edits of a created invoice. 

Credit notes and cancelling invoices 

Introduction 

Sometimes you need to correct invoices, which were already sent to customers. For such situations, 

SDL Trados Business Managers provides a specific workflow, which allows to quickly adjust sent 

invoices. There are two ways of making changes in invoices: cancel invoices and issue credit notes. 

Cancelling invoices 

If you don't use e-invoicing functionality, you can simply cancel invoice and issue and new one. To 

do this, simply select an invoice in the invoice list, then click or hover mouse pointer over Change 

status button, and select Cancelled. 



 

If nothing prevents from cancelling an invoice (for example, invoice has already been partially or 

fully paid), then invoice status will be changed, which will be reflected in the invoice list (crossed 

values in a row): 

 

From now, you can simply create a new invoice with correct values. 

Credit notes 

If invoice can't be cancelled or if it is necessary to issue official credit note paper, then you can create 

a credit note over an existing invoice. Credit notes can be issued over invoices whose status is 

not one of the following: Proforma, Draft, Cancelled, Credit note. 

In online version, this is reflected by muted button in the invoice list: 



 

To create a credit note, click corresponding button. In fact, credit note is also an invoice (so you see 

invoices and credit notes in a single list), but when you open it, instead of Invoice items table you 

will see Invoice item corrections table. This table contains all items from original invoice, and you 

can't add or remove records here. It is only possible to change values in 

the Quantity and Price columns, thus decreasing amount of original invoice item: 

 



By default, when you create a credit note, values in the Quantity column are set to zero. For 

reference, you can see initial quantities and amounts nearby (Initial quantity and Initial 

amount columns). If you wish to deduct something from original invoice, just type necessary values 

in the Quantity and Price column. Resulting amount will give you a credited amount. Then, you can 

apply same taxes to this amount, as were used in original invoice. 

Additionally, you can provide Correction reason in the corresponding field. 

For credit notes, a new special invoice template was created. You can find it under Print button: 

 

Use it to preview your credit note: 

 



Credit notes are always created over a single base invoice, which number is mentioned in 

the Corrected invoice field. When you save a credit note, Due amount of that invoice will be 

decreased by amount of a credit note. This means that all payments should be registered over original 

invoice, not over credit note. Sequentially, credit notes won't be available in selection lists when you 

create payments and choose invoices covered by that payment. 

Quick filter in the list of invoices 

Take a note on a special Quick filters button in the project list, which not only provides 

another way to quickly filter list of invoices, but also displays amounts for last 12 months and 

top customers: 

 

Top part contains list of months and amounts, while lower part lists top customers with 

amounts. Select any item in this list to filter list of jobs by month or by customer. 

Invoice printing 

You can print invoices from invoice list or from invoice editing form. 

In the invoice list, select one or multiple invoices and click Print. The same button is available 

in the invoice editing form, but it allows to print only one currently opened invoice. When you 

simply click on Print button, invoice will be printed using automatically determined template 

(customer default template or global default template). If you click drop-down button and 

select explicit template, then all selected invoices will be printed using selected template. 

Note. Before printing an invoice from invoice editing window, you have to save it, otherwise 

you would not see unsaved changes in the generated invoice 

Note. If you selected multiple invoices and clicked Print button, the system will detect default 

template for a customer of the first selected invoice. 



One of main functions of the preview page is possibility to make final edits in the invoice. Yes, 

you can edit generated invoice almost as in text editor (for custom templates, this feature must 

be turned on in the invoice template designer). To highlight fields which support final editing, 

select Editing fields button on the ribbon: 

 

On the preview page you can also change page settings, print invoice, export (save) it in a 

number of different formats (PDF, XLSX, RTF, HTML, TXT and even PNG) or send by e-mail. 

To change look settings, select parameters on the left pane. For the templates which support 

color accents you can select one of supported colors. Simply make desired selections on the 

Parameters panel and select Submit to see the results. To print, export or change view scale, 

simply use buttons above the preview area. 

To send invoice by e-mail, select E-mail via SDL Trados Business Manager in the preview 

window. A message composing window will be opened with pre-filled recipient, message 

header and file attachment. A message will be sent and appear in the Sent folder of your 

mailbox. Also, it will be saved in the Mail sender list along with attached invoice. 

You can also select Save as PDF and attach to a current document to save generated invoice 

in PDF format and put it into Invoice file field. Later you will able to send a message to your 

customer with a file saved in this field. To do this, find an invoice in the invoice list, select 

customer contact below the table and select Write e-mail message button. Invoice file will be 

automatically attached to a created message. 

You can also generate PDF files and send them without showing invoice preview window. For 

this, select necessary invoices in the Invoice list and click Generate PDFs. The system will 

generate invoices according customer settings and attach PDF files to the selected invoices. 

Also, you will get a question about saving PDF files on your hard drive. Select Yes and select 



destination, if needed. After generating of PDF files you will see marks in the PDF column, 

which means that these invoices has invoice files attached. 

To send invoices, select necessary invoices and select Message to customer(s). To send 

invoice files, select Invoice(s); to send payment reminders, select Payment reminder(s). The 

system will generate necessary mail messages. If only one invoice has been selected, message 

composing window will be opened. Otherwise, you will be redirected to the message list, from 

where you can view, edit and send generated messages. 

Built-in invoice templates 

The system includes 8 predefined invoice templates, which cannot be deleted (but can be used 

as a base to create your own templates). 

These templates are always available when you select system default invoice template 

(Settings > Invoice settings > Default template), or default invoice for a customer 

(Customer editing form > Main customer settings > Default invoice template). 

Examples of default invoice templates: 

Invoice_v1 

 



Invoice_v2 

 
 

Invoice_v3 

 
 

Invoice_v4 

 
 



Invoice_v5 

 
 

Invoice_v6 

 
 

Invoice_v7 

 
 



Invoice_v8 

 

Invoice forms localization 

SDL Trados Business Manager allows to localize printing templates. In this topic you will find 

out how to easily localize invoice and prepare bilingual templates. 

Information contained here explains how to localize invoice templates, but the same rules can 

be applied to other printing forms (quotes, purchase orders). 

To start with localization, open corresponding reference data tables and provide localized 

values for entry names. 

Each entry has three fields for localization, named as Name localized 1, Name localized 2 and 

Name localized 3. No need to link first and second value with some language - you are free to 

decide which language will correspond to each number. Here is example for Units: 

 

When localized values are provided, you are free to use these variables in your invoice 

templates. 

Open invoice template in the designer and find any field which you want to localize. For 

example, you want to localize Work type. Select it in the Designer and find out linked field in 

the Field list: 



 
You can see localized variables below Name field in the field list. Drag necessary field and put it 

over selected label. The label will become linked with localized name instead of source name. 

If you wish to get bilingual invoice, to the following: 

1. Select a label on the design surface. Open helper menu and select None in the Data 

binding property: 

 
2. Double click on a label to edit its contents, type [] and drag Name field inside these 

square brackets. 

3. Then type another pair of square brackets and drag Name localized inside second pair 

of square brackets. You will get a string like that: 

[Work type.Name] / [Work type.Name localized 1] 

Making changes in invoices 

Sometimes it is required to edit a job which has already been invoiced. In such cases, you have 

few options to reflect these changes in an existing invoice. 



1. Open an invoice, select a job in the Invoice details table, and click Reload job 

data button on the toolbar. New amount will be loaded from a job, and invoice total 

amount will be automatically re-calculated. 

2. When editing a job, select drop-down button near Save options button and select Save 

and add to existing invoice. If a job has multiple invoices, you will see a list to select 

which invoice you wish to update. After that, a job will be saved and underlying invoice 

will be updated. It is recommended to open an invoice and check if new amount is 

correct. 

3. After editing a job, just select Save. If this job has been previously invoiced in full (and if 

only one invoice exists for that job) and the job amount has been changed, the system 

will offer to make corresponding changes in an linked invoice. Select Yes, and amount of 

invoice will b updated. Again, after such automatic change it is recommended to open 

an invoice to confirm that everything is correct. 

Batch invoicing 

SDL Trados Business Manager allows to create invoices in a batch mode. To do this, click Batch 

invoicing button on the main ribbon from the list of invoices. In the Batch invoicing window you 

can see a list of all uninvoiced or partially invoiced jobs, which are ready to be invoiced (status is 

sent or finished, but not received, quote, processing, rejected or paid), along with amount, customer 

name, currency and number of jobs which will be included in each invoice. 

 

You can limit a number of jobs included in the batch invoicing process by specifying a date in the 

Limit included jobs by latest date field above the table. As an example, you can use this date when 

want to create invoice for the whole previous month, but do not want to include jobs from the current 

month. Also you can change a date of all invoices which will be created using this function. 

To exclude a customer from invoice creation, simply delete corresponding row(s). 

In the last column (Term) you can specify invoice payment term. 



There is a Save PDFs checkbox under the table and a field to provide a path where PDF files will be 

stored. If this checkbox is marked, than each created invoice will be exported to the PDF format and 

placed to the specified folder, which will be automatically opened after operation is complete. 

When you are done, click OK button. Operation will be started and you will see progress bar. 

After completion, please go to the invoice list and confirm that necessary invoices are created. Make 

necessary corrections, if needed. If Save PDFs checkbox was checked, than you will get 

corresponding number of exported invoices. PDF files are created per customer and application 

settings, i.e. if you specified different invoice templates and localization languages for different 

customers, than these settings will be reflected in the generated PDF files. In ideal case it would not 

even be needed to open invoices list - PDFs are created and ready to be sent, while corresponding 

jobs in the job list are marked as invoiced. 

Sending a message to a customer 

You have a number of options to send a message with invoice file attached to a customer. 

Select invoice and click Print to show invoice preview. In the print preview window, select 

Email via SDL Trados Business Manager: 

 
Currently viewed invoice will be saved as PDF, new mail message will be created with attached 

PDF file. All customer contacts with Invoicing matters option marked will be added to 

the Recipients list. 

If you have message template defined as used by default for sending invoices, its text will be 

automatically applied in a new message: 

 



From the invoice list or invoice editing form, select necessary invoices and click Message to 

customer(s) button. 

 
Select what you want to send: New invoice, Payment reminder, or Other. Depending on 

selection, different message template will be used. Again, email composing window will be 

opened with invoice file attached. Difference of this approach is in a moment of sending a 

message and possibility to send payment reminder. After saving a file to PDF and attaching it to 

an invoice, you can send it later, when needed. 

Another way to send payment reminder is to switch to Main (with details) view in the invoice 

list: 

 
This view contains details of a selected invoice at bottom. This details view also contains 

Contacts tab, which contains all contacts of a selected customer. From this list, click Write e-

mail message button: 

 
When you click this button, the File attachment dialog appears, where you have to select files 

attached to a created message. This approach allows to create a message not to all customer 

contacts with Invoicing matters option, but to a specific selected customer contact. 

Payments over invoices 

Overview 

After invoice issuance, it must be paid until the due date. 



There are a few options to control invoice payments: using invoice list and using the 

dashboard. Invoice list offers more features thanks to rich filtering system. As in other 

documents, each column of the invoice table contains filter button. It gives you a full control 

over displayed invoices. You can filter by clients, due date, currencies, amounts and due 

amounts, combining these filters in any possible way. To show overdue or unpaid invoices, 

simply use one of predefined filters: 

 

Also, it is possible to control unpaid invoices in the Dashboard. There is a separate section 

with the list of all unpaid invoices. Overdue invoices are marked with red color. 

In the list of invoices there is a panel with description of the selected invoice (when Main (with 

details) view is used. This panel contains main invoicing data for the selected client and 

selected invoice. It includes current due amount for the invoice, invoicing e-mails, links to 

compose an e-mail (to send an invoice or to send reminder), and client's invoicing 

requirements, including default term, client's web-portal details and additional comments. So, 

there is no need to open some notepad to recall the most important information. 

Create payments from invoices list 

The easiest way to create a payment is to use invoice list. 

1. Select necessary invoice or a number of invoices. Selection could contain invoices issued 

to any customers and in any currencies. 

2. Click Create payment button on the ribbon. Here, two different behaviors are possible: 

a. If you selected invoices only for one customer and currency, a payment form will 

be opened, and all fields will be filled automatically: client, currency, amount 

(which corresponds to amount of the selected invoices), payment method 

(default payment method for the client or, if not specified, all payment methods 

for the selected currency), and a list of linked invoices. 

A. Confirm the data and select Save to register a payment. 

b. System will create multiple payments, with amounts corresponding to each 

customer-currency pair in a selection. All created payments will saved and you 

will be moved to the Payment list to view created payments. From that list, you 

can open individual payments and make necessary changes in them, if needed. 



3. Status of all selected invoices will be changed (to Paid or Partially paid, depending on 

amount of payment). 

Manual payment creation 

When you create a payment manually (not from the invoice list by selecting invoices and 

selecting Create a payment button), you can add (link) invoices to a payment by pressing Add 

invoice(s) button above the Payment details table: 

 
You will see a list of unpaid invoices for the currently selected customer. Select necessary 

invoices and select OK. They will be added to the Payment details table. 

If payment currency differs from invoice currency, you can reflect this with the help of Amount 

(invoice currency) column. The program automatically converts amounts according entered 

currency rates, but you can correct applied amount manually, when needed. 

To open linked invoice, select on the invoice number with Ctrl and Shift buttons pressed. 

Underlining, following these basic rules of invoice and payments creation, you will always have 

a clear picture of paid, partially paid and overdue invoices. 

Partial payments 

SDL Trados Business Manager has a mechanism of partial payments over invoices. 

To add a payment, select Payments on the Workspace group of the navigation tree. 

Click New or Clone buttons to start creating a new payment. 

Then, fill the details of the Payment document. Start from specifying a client and amount. 

Then, if you amount actually received is less than instructed amount, specify bank charges 

(bank fee). This amount will be accounted as expenses. Also, if payment currency differs from 

your base currency, you can specify currency rate used to recalculate payment amount into 

amount in your base currency. Currency rate field contains Refresh button (to re-detect 

currency rate from currency rates list) and Download rates button (to download new rates). 

When done, you can start edit details table. This table allows to link the payment with invoices. 

You can manually select invoices or use Add invoice(s) button to select from available unpaid 

invoices. You can add one invoice (if this payment is made against one invoice) or multiple 



invoices. In the Amount column of this table you specify an amount (part of full payment 

amount) which should be assigned for a selected invoice. If invoice is not paid in full, you will 

see that in the list of invoices. The invoice and corresponding jobs will be marked as paid only 

when paid amount will correspond to invoice amount. 

Payment reminders 

Using built-in e-mail sender, you can send payment reminders for overdue invoices. 

1. Open invoice list 

a. Click Message to customer(s) > Payment reminder, or 

b. Select Main (with details) view variant, select an invoice and double click on 

any contact in the Contacts tab below the list. 

2. The File attachment dialog appears, where you have to select files attached to a created 

message. 

3. A message composing window will be opened, with default payment reminder template 

applied. Here you can edit default text, save a message and click Send to send a 

message. 

4. A message will be sent and appear in the Sent folder of your mailbox. 

Payments over invoices in different 
currencies 

This topic explains how to add a payment over invoice, which currency differs from payment 

currency. 

1. Create a payment and specify amount in EUR (actual income amount). 

2. Add necessary invoice (in any currency) to the Payment details table. 

3. If currency of any invoice differs from the currency of payment, specify currency rates 

(manually or automatic). 

4. Check if amount in invoice currency corresponds to desired amount. 

Using these simply actions you can easily link payments with invoices no matter which 

currencies are used there. 



When invoice-based accounting method is used (selected in the Program settings), and if 

payment (invoice) currency differs from your base currency, then the program will crate 

corresponding currency rate difference transactions. Depending on a direction of exchange rate 

change, additional income or expense may be registered in the Ledger. 

Translation assignments and 
outsourcing 

Overview 

This document allows to register assignments on the base of incoming jobs. When created, 

corresponding transactions are created in the Ledger (correspond to expenses for the amount of the 

job according translator’s rates) and in the Balance sheet (i.e. increasing of the debt). 

Assignment is created over single translation job, and each assignment task MUST use one of base 

job's tasks as a base. Value in Quantity column deducts available quantity for assignment from a 

base job's task. 

There are few ways to create assignments. 

Translation assignment from list of jobs 

The first is semi-automatic, when you select any job in the job list and select Create translation 

assignment button: 

 

This button provides two choices: One assignment for all unassigned tasks (this option is used by 

default when you click explicitly on a button icon, not on drop-down button) or Separate 

assignment per each unassigned task (for example, if a job contains multiple translation tasks, 



proofreading and review tasks, then the system will create three assignments - one per each work 

type). 

After pressing this button new assignment(s) will be created. Here is default look of the translation 

assignment editing form: 

 

The list of Assignment tasks will be automatically filled based on a job's list list of tasks. Since each 

job task can be assigned to different vendors, by default the system will put currently unassigned 

quantity to the Quantity column. If you split some task between different vendors, decrease a 

number in the Quantity column. 

Select a value in the Vendor field. When a collaborator is selected, the system will offer to 

automatically detect rates in each row of the tasks table. When information from base job is read, all 

prices in this table are automatically set to zero. If you change any prices manually in the tasks table, 

you can always use Re-detect prices button to load default prices of the currently selected vendor. 

In the Vendor field, in addition to drop-down button for quick selection of vendors, you can use a 

button with three dots icon, which allows to open popup window to select a vendor. Advantage of 

this window is that it contains additional live filters on the right panel, as well as list of recent 

assignments for a selected vendor at the bottom. This all gives more flexibility and visibility while 

choosing a vendor for a project. 

Take a note that list of vendors in the drop-down list of the Vendor field will not 
include vendors with employment status other than Employed. 

Take a note that the selection list won't show vendors marked as Archived. The 
Archive status of vendors can be changed from a list of vendors. 

To quickly view default rates for the currently selected vendor, just hover mouse pointer over the 

Vendor field. You will see a tooltip with vendor's price-list. If tooltip is not shown, this means that 

this vendor has no default rates defined. 



When SDL Trados Business Manager tries to detect vendor's prices, it uses advanced algorithms. 

Even if exact price is not found, the program may try to calculate a price for another unit or fuzzy 

type based on a base price. For example, if you have entered default price for Words unit, but create 

an assignment with Lines unit (with adjustment factor set to 10), then the system will take base price 

per word and calculate price per line by multiplying existing price by 10. 

Manual creation of translation assignment 

To manually create an assignment, open list of translation assignments and click New. There are two 

options to create an assignment: 

1. On the base of a translation job. Select a value in the Translation job field, and the system 

will offer to load tasks from the selected job. Language 

pair, Specialization and Translation project fields, as well as Service 

type, Unit and Fuzzy type columns in the Assignment tasks table, will become uneditable. 

2. Manually. In this case, Translation job field remains empty, and you manually select values 

in the Language pair, Specialization and Translation project fields, as well as Service 

type, Unit and Fuzzy type columns in the Assignment tasks table. This approach allows to 

create assignments without linking them to base "incoming" job, which could be useful when 

you translate a content created by yourself, for example. 

After selecting a job, select a Vendor. When vendor list is expanded, it will be automatically 

filtered by the job's language pair. To view all vendors, remove default filter or edit it to filter a 

list according your preferences. Of course, you can still use quick filters which are available in 

each column header of this table. 

In Online version, list of vendors includes icons if a vendor is approved in a current language pair or 

specialization: 



 

Translation assignment editing window: fields and buttons 

As translation jobs, assignments has two statuses - Status of work and Status of payment. You can 

quickly change status of work via context menu (or Change status button on the ribbon) in the list of 

assignments. Also, it could be changed automatically when vendors deliver translations (through 

web-portal, if used). Status of payment also gets changed automatically when you (or vendor) create 

an invoice over assignment, and sub-sequentially when you create a payment over incoming invoice. 

Depending on status, assignments has different colors in the list. These colors may be changed 

according your preferences using conditional formatting feature. 

The Deadline value is determined automatically from a base job, but you can adjust it as needed. 

The Deadline (vendor's timezone) is determined by using the Time Zone value provided in 

the vendor's settings. 

Rating allows you to save an evaluation of the job quality. In future this rating will be used to 

recommend one or another translator for the assigned job.  

The PO Number field can be generated automatically according to a pattern specified in 

the application settings. 

The Language pair field is not editable and it depends on a selected translation job. 

The Fuzzy scheme field allows you to change a fuzzy scheme that has been determined 

automatically (from vendor's settings, from a base job, or from the global application settings). The 

Fuzzy scheme affects average volume calculation and price calculation mechanisms. 



Price-list. Allows to explicitly specify price-list for an assignment, if you wish to use non-default 

price-list for a selected vendor. When you select any value in this field, if an assignment already 

contains some tasks, the system will offer you to re-determine price for all tasks. 

Instructions tab gets filled automatically from a base job. Here you can provide additional 

instructions (with formatting support) to a vendor, which may be included in the Purchase order or 

mail message. 

Files tab allows to attach files to assignment (source files, reference files, glossaries, TMs, etc.). 

See this article which describes how to work with file attachments. 

On the ribbon toolbar, you will find GroupShare button, which allows to link current assignment 

with particular files in GroupShare project. To establish a link, click this button and then select Link 

with files. If base job (or job’s project) is linked with a GroupShare project, a popup dialog will 

appear, allowing you to select one or multiple files from a project. Otherwise, error message will be 

shown. After establishing a link with files, Progress column in the list of assignments will be 

displaying current progress of an assignment. 

To break a link with all linked files, select GroupShare > Unlink from all files. 

List of assignments 

In the list of assignments, you can find Progress column (which is hidden by default and can be 

displayed using Column chooser). This column displays information about current progress of an 

assignment in SDL GroupShare. See Linking and syncing projects/jobs article for details. 

Also, in the list of assignments, there is the Apply vendor… button available, which allows to select 

and apply same vendor to multiple selected assignments. This function is particularly useful when 

you are viewing list of assignments inside a project with many files, and you create separate 

assignment for each file. In such case, you may select multiple assignments with same target 

language and apply same translator to them all. 

Printing purchase orders 

To print a PO for the selected assignment, click the Print button. The system will determine the 

default PO template for a selected vendor and display the Print preview window. To explicitly 

choose the desired PO template, click the drop-down button and select a template from the list. 



As with any templates, you are free to create own PO templates. You can start creating own template 

by cloning built-in template (open Reports - Reports, and find PO template in the list). 

You can also generate purchase orders in a batch mode. To do this, select multiple assignments and 

click Generate POs button. The system will create purchase orders (without previewing) for each 

selected assignment, attach it as an internal file to each assignment, and then offer user to save all 

generated POs to hard drive. 

Sending purchase orders 

1. Select assignment(s) and Click the Generate POs button to generate a PO and attach it to 

assignments. 

2. Click Create a message to vendor and select: 

a. Individual confirmation messages to selected vendors - this will create a separate 

message for each assignment and will change the status of assignments to In work. 

b. Single group confirmation message to all vendors - this will create one single 

message to all vendors, where the text will contain list of languages 

and vendor names for each language; status of all assignments will also be changed 

to In work. 

3. Go to the message list, select the created message(s), optionally check the text and attached 

files, click Send. 

Invoice and payment creation 

To create an incoming invoice and payment in a single action, select necessary translation 

assignment(s) and select Create payment. A new invoice and payment will be created for the 

amount of the selected assignments. When this payment will be saved, corresponding assignments 

will be marked as paid. 

To register invoice from one vendor for a number of assignments (or to register invoice by Vendor), 

select these assignment and select Register invoice button. 

Quick filtering in the list of assignments 

In the list of assignments, you can use Quick filter button to quickly display limited set of 

assignments: 



 

This button has three separate sections. First section allows to filter list by last 12 months. Second 

section allows to display assignments for one of top 15 vendors (vendors with largest amounts for all 

time). And third section allows to display ongoing assignments for selected vendor. Drop-down list 

of this option will contain names of all vendors who currently has ongoing (undelivered) jobs. In 

addition, each item in this list provides displays amount of assignments which will be shown when a 

filter is applied. 

Main highlight of this feature is that filter is applied on a database level, which means that only 

filtered assignments will be retrieved from a database. In network environments, it allows to save 

traffic and improve performance of this table. If you apply additional filters in the grid itself, then 

this filter will be applied over current quick filter. Don’t forget about this. If you wish to view all 

assignments, click Quick filter > Clear filter. 

Hidden columns in the list of assignments 

By default, a number of columns in the list of assignments is hidden, to keep list simple and not 

overloaded with information. However, some of hidden columns may be more useful for you 

comparing to default ones. Here is a list of additional columns which you can display using Column 

chooser (right click on table header and select Column chooser): 

 Candidate statuses – displays statuses and number of vendors from the Vendor’s 

pickup table, providing overview about vendor pickup process; 

 Notes and Notes from vendor – text notes provided by manager and vendor; 

 Progress – if assignment is linked with GroupShare project, this column will display current 

progress of work; 

 Services – comma-separated list of work types listed in assignment tasks; 

 To-do – number of unchecked items in the Checklist table; 



All other columns – default fields of translation assignment, which don’t require additional 

description here (Automation rule, Created at/by, Modified at/by, PO number, Price-list, etc.). 

Tasks and payables 

In translation assignment you can "describe" work using two tables: Assignment 

tasks and Payables. 

Assignment tasks table is obligatory, as it determines volumes of a base translation job which 

are assigned to a selected vendor. It is required to use the same Units which were used in a 

base job tasks. 

 

In the Quantity column you specify a volume which will be assigned to a selected vendor. This 

volume should not be greater than volume of a base job task. 

You can use Quantity unassigned column as a reference to know how much is still possible to 

assign to vendors. This is particularly useful when you assign the same job task to multiple 

vendors. When you change a number in the Quantity column, value in the Quantity 

unassigned column will be immediately changed. 

In situations when it is not possible to assign work to a contractor using same Units as 

specified in base tasks, or when you wish to join few tasks into one (for example, when you 

wish to show single row in a purchase order instead of full fuzzy break down), please 

use Payables table: 

 

It allows to "override" data entered in the Assignment tasks table to separate actual tasks 

from tasks specified in a base job. As hint shown on the screenshot above says, this table can be 

used in following cases: 

 when a contractor uses a unit which differs from a unit of base task (example: base job 

is in Words, while you must issue PO in Lines unit); 

 to join multiple tasks into one task (multiple fuzzy types into one "average" volume); 



 to enter specific calculation of task (for example, when job is very small and contractor 

has minimal charge). 

Underlining, the following workflow is used when translation assignment is created: 

1. You add all job tasks which will be assigned to a contractor and enter assigned 

quantities in units which are specified in base job tasks. 

a. If possible, you just specify contractor's prices for each task, save an assignment 

and print PO. Payables table is not used. 

b. If point a does not fit requirements of a current assignment, you switch 

to Payables tab and create necessary rows to describe all tasks performed by a 

contractor. In this case, amount of assignment is calculated from Payables table, 

instead of Assignment tasks table. 

Translator pick-up 

While creating a translation assignment, SDL Trados Business Manager may help with picking 

up the right contractor to do particular job. 

To use this function, switch to the Vendors pickup tab: 

 



Click Add candidates button to open a list of contractors who fits this job: 

 

Here you can see rates and supported languages, as well as average rating of previous 

translations. Additionally, you can view estimated amounts and margins for each vendor. But 

please take a note that these values are calculated in a single currency which is currently 

selected in an assignment. If different vendors use different currencies, estimation could be 

incorrect, because necessary prices in an assignment currency could be simply missing in a 

vendor's profile. However, after adding a candidate to the candidates table, estimated amount 

will be calculated in a default vendor currency, and margin will also be calculated correctly. By 

default, this list is filtered by language pair selected in the assignment (which is determined by 

a base job). You can see this by descriptive filter string below the list (see a red arrow on the 

screenshot above). On the right of this list you can find live filters (only in desktop version), 

which allows you to quickly filter the list of contractors to narrow your search. 

When you select (single click) any contractor, you can view assignment history at the bottom. 

Select desired contractors and click OK. Selected contractors will be added to the Candidates 

list with Possible candidate status. 

The system will calculate Estimated amount for each candidate. However, it can be manually 

edited. To revert to automatically calculated amount, select candidate(s) and click Calculate 

estimated amount button above the table. The system will attempt to calculate assignment 

amount for each selected candidate based on their price-lists. These amounts can be used in 

the job offer messages sent to candidates. 

Last column in this table, Acceptance behavior, allows to specify Business Manager behavior 

when a vendor accepts an offer via vendor portal. Default value is Require approval from PM. 



When this behavior is used, job offer will be removed from a portal after vendor accepts an 

offer. Project manager will get notification about this, and will be required to manually assign 

this work to a vendor. Second possible value is Immediately assign. When a candidate with 

this type of behavior accepts an offer via vendor portal, the following actions will be performed 

automatically: 

 Vendor will be selected in the Vendor field of an assignment; 

 Assignment status will be changed to In work; 

 Other candidates won’t have access to this offer anymore; 

 Business Manager will generate purchase order for that vendor using default PO 

template and attach generated PDF file to an assignment (only if purchase order wasn’t 

created and attached manually); 

After accepting an offer, vendor will be redirected to a detail page of accepted assignment, to 

download files and view PO. 

Sending e-mails to candidates 

1. To select desired contractors. Use Ctrl and Shift buttons (or simply press Ctrl-A to select 

all rows). 

2. When necessary contractors are selected, click Send availability request button on the 

toolbar. 

3. If assignment, base job or base project has attached files, the File attachment 

dialog appears, where you have to select files attached to a created message. 

4. You will see an e-mail compose window (if single message was created) or a 

confirmation (if multiple messages were created). Recipients table of each message 

will be filled with details of the selected contractors. 

5. For each of created messages, default Job offer message template will be used. 

6. If needed, correct text of each message and click Send. After some time you will see a 

message with the status of operation. 

When a candidate should be assigned to an assignment, select in the Contractors pickup list 

and click Assign contractor button above the table: 

 



Selected contractor will be selected for an assignment, the system will detect default prices of 

the selected vendor, and change status in the pickup list to Assigned. 

Displaying job tasks nearby 
assignment tasks 

By default, translation assignment editing form contains a list of assignment tasks where you 

can add new rows and select base job tasks which are assigned to a currently selected 

contractor. 

Base job task drop down list shows assigned and unassigned quantities per each task. 

However, when you make selection, you cannot see which tasks from base job can still be 

added to a current assignment until you open drop-down list again. As a result, you may wish 

to constantly see this list, which will help to make a decision about adding another task to a 

current contractor. 

To display such table, do the following: 

1. Enter form layout customization mode (right click on empty space - Customize layout). 

2. In the list of hidden items, select Add.... 

3. Select Job > Job tasks and click OK. 

4. Drag new item to a form, for example on the right of assignment tasks. 

5. Change size of a new table per your needs. 

6. Exit customization mode, hide unwanted columns from a newly created table, and then 

use Column chooser to display columns which are hidden by default (for example, Qty 

assigned and Qty unassigned). 

7. Make some change in the Assignment tasks table to see that this change is reflected in 

the Base job tasks table (maybe it will be needed to move focus to a table to get it 

refreshed). 

Automated assignments 

Overview 

SDL Trados Business Manager allows to automatically send jobs to vendors when specified 

master assignments are delivered. 



This allows to automatically move assignments from translators to proofreaders, then from 

proofreaders to reviewers, etc. Automation allows to send messages using specified template 

to vendors with specified attached files. Managers always get notifications about automatic 

action performed by the software. 

Setup automation rules 

1. Start with creating necessary automation rules using Reference data > Automation 

rules table. 

2. Create a new rule and specify the data. 

Default rule behavior - allows to select automatically send messages (manager gets 

notification about sent messages and assignments switched to In work status), or 

manually (manager gets notifications about assignments which can be started after 

delivered master assignments). 

Message template and Message subject - these fields specify which e-mail template 

will be used to generate message, when Send messages automatically is selected in 

the Default rule behavior field. Message subject can be left empty - in this case the 

system will use a subject specified in a selected template. 

E-mail account - account used to send messages. 

File types - in this table you can specify file types which will be automatically attached 

to generated e-mail messages. In the File type column select file type, and in the File 

source column you can select a source of attaching files: Target assignment, Base 

assignment or Both. Target assignment means that the system will attach files from 

master assignments of an assignment which is going to be started. Base 

assignment means that files will be attached from an assignment which is going to be 

started. 

3. When automation rules are created, you can start using them in assignments. 

Apply automation rules 

1. To apply automation rule, open an assignment, switch to Automation tab, select 

automation rule, and add master assignments by selecting Add button. 

2. Save an assignment. From now, when all master assignments will be delivered (status 

changes to Delivered), and if automation rule allows to automatically generate and 

send messages, the system will automatically set status of target assignment to In 

work, generate an e-mail message, attach specified files and send it to a vendor (with 

optional copy of the application owner). Also, the system will generate notification for 

managers (for all users with Receive notifications checkbox). Otherwise (if manual 



sending is selected in an automation rule), only notifications about possibility to start 

an assignment will be generated, which is also useful feature, as it allows manager not 

to forget about moving a project to a next phase. 

Vendor recommendations 

SDL Trados Business Manager can recommend vendors by applying different recommendation 

mechanisms: 

1. Vendor groups 

2. Machine learning 

3. Previous work completed by vendors for particular customer, project and specialization 

4. Vendor's willingness to work. 

How to get recommendations 

You can get recommendations in the following three places from the translation assignment 

editing window: 

 Open drop-down menu in the Vendor field; 

 Click Search icon in the Vendor field to open vendor selection popup window; 

 Switch to the Candidates tab and click Add candidate button. 

Depending which recommendation features are enabled, you could get four types of 

recommendation, each of which has own color code: 



 

Orange - recommendation from vendor group; 

Violet - recommendation by machine learning system; 

Yellow - recommendation based on previous work completed by vendor; 

Green - recommendation based on vendor's willingness to work. 

Vendor groups 

You can read detailed information about vendor groups in a separate article: Vendor groups. 

Machine learning 

You can enable and disable machine learning functionality from the application Settings > 

Translation assignments tab > Recommendations group > Disable machine learning for 

recommendations. 

When enabled, application will be tracking vendors you select in translation assignments and 

build history model which will be used to predict vendors in new assignments. As you train the 

system (more assignments you create), you will be getting more accurate predictions. For 

predictions, system takes into account customer name, translation project, specialization, 

language pair, responsible person (manager), etc. 



When you're viewing machine learning recommendations (violet), take a note on 

the Recommendation reason column. In this column, for machine learning recommendations, 

a score value is displayed, like this: 72.21/72.21. First part of this value is vendor's score, and 

second part is maximum score among all vendors. If score value equals or close to maximum 

score, and value is below 80, then such recommendation could be considered as not reliable. 

Recommendation with high probability of accuracy should be higher than 90. 

Recommendations based on previous work 

You can enable and disable machine learning functionality from the application Settings > 

Translation assignments tab > Recommendations group > Disable recommendations based on 

previous work. 

Idea is simple - if particular vendor was already ever used for a current translation project, 

customer or specialization, this vendor will be recommended. 

Willingness to work 

In the vendor editing form, on the Settings tab, you can find a field called Willingness to work. 

This field allows to enter a value from 0 to 10. Zero value means that willingness to work isn't 

rated. Manager, depending on conversations with vendors, could rate their willingness to work 

using 1-10 scale. When deciding how to rate this, you could take into account different aspects: 

expressed intention to work with you, overall culture of communication, speed of replies, etc. 

Depending on translation assignment parameters and number of found vendors with specified 

willingness to work, TBM could include up to 3 vendors into this recommendation group. 

Incoming invoices 

All incoming invoices from vendors are stored in a separate table. As with outgoing invoices, 

you can track due dates, amounts, view unpaid invoices, check VAT amounts of incoming 

invoices, etc. 

 

You can enter new invoices manually, but it is recommended to do it from assignment list. 



Open assignment list, select necessary assignments (for one vendor), and select Register 

invoice. If you use web-version, vendors can create invoices for delivered assignments using 

web-portal. 

Incoming invoices has Approved checkbox. To create a payment, this checkbox must be 

checked. If during payment creation this box is not checked, then you will see a confirmation to 

approve selected invoice for payment. This feature will be particularly useful when different 

users of the system register invoices and payments. 

In the invoice incoming window you can specify invoice number and payment term, attach 

invoice file by dragging and dropping it into the browser window, add notes and taxes: 

 

Click Save to finish invoice registration. If invoice is created by a vendor, system administrator 

will receive notification about added invoice. Linked assignments will be marked as invoiced, 

and vendors would not be able to issue new invoices over them. 

Note. If invoice has been created by mistake, only system administrator (manager) will be able 

to delete it. 

To create a payment over invoice, user with corresponding right has to select it in the list of 

incoming invoices and click Create a payment. Fill information about the payment and save it 

to mark linked invoices and assignments as paid. 

Invoices from external parties 

Incoming invoices section allows to register invoices coming not only from freelancers, but 

from external parties. 

It allows to track payments over such invoices without linking them with any translation 

assignments. Instead, such invoices can be linked with expenses. 

To create invoice from external supplier: 



Select External value in the Invoice type field. Contractor field will be disabled, 

and Party field will be enabled: 

 

Party name cannot be selected from reference data list. Instead, you can directly type supplier 

name in this field. However, when you create invoice next time, it will be possible to select a 

party from a list of previously entered parties. In the Invoice items table, you can add rows 

manually or from expenses, if it already exists. 

To mark invoice as paid, click Create a payment, as it happens with regular invoices from 

contractors. The only difference is that Contractor field in a payment must be left empty. And 

invoice will be automatically added to the Payment details table. 

Click Save and close to save a payment: invoice will be marked as paid (Due value will be 

zero) and a payment will appear in the Linked payments tab. 

Payments outgoing 

Outgoing payments allow to account payments made in address of contractors. You can create 

payments manually (from the Payment (outgoing) table) or automatically. 

 

To create a payment automatically: 

1. Select necessary assignments in the Translation assignments list and select Create a 

payment. A new payment will be created for the amount which corresponds to the amount of 

the selected assignments. 

2. Check/select a contractor, amount and currency, and then fill table of paid assignments. One 

payment document may cover any number of assignments. Just keep in mind that amount of 

the distribution table cannot be greater than amount of the payment. Otherwise program will 

show error message. 

3. When you create a payment manually (not from the assignment list by selecting assignments 

and selecting Create a payment button), you can add (link) assignment to a payment by 

pressing Add invoice(s) button above the Payment details table. You will see a list of 

unpaid jobs for the currently selected contractor: 

 



4. From popup window, select one or multiple invoices and select OK. 

5. They will be added to a payment. 

Recipient in the Outgoing payment can be selected in 2 fields: Contractor or External party. 

Only one of these fields can be filled at the same time. If you select some value in 

the Contractor field, External party becomes disabled, and vice-versa. External party should be 

filled if a payment is created over invoice which comes from external party. 

List of outgoing payments has Party column, which displays Contractor or External party value, 

depending on which one is filled in a payment. At the same time, you are free to 

display Contractor or External party columns in this list (which are hidden by default) 

using Column chooser feature. 

Multi-currency payments 

As with incoming payments, it is possible to link a payment issued in one currency with translation 

assignments created in other currencies. To do this, follow this procedure: 

1. Create a payment and specify amount and currency. 

2. Add necessary invoices to the details table (in any currency). 

3. If currency of any invoice differs from the currency of payment, specify currency rates 

(manually or automatic). Amount column contains amount deducted from the payment 

amount, while Amount (invoice currency) must contain amount converted into a currency 

of the invoice. 

Credit notes 

Credit notes allow to register balance deduction transaction over some invoice. 

To create a credit note, you can click New in the list of credit notes, or click Create credit 

note button in the list if invoices. When editing view appears, fill-in necessary details: 

 



Click Save, and you will be returned to the credit notes list, from where it is possible to print a 

note form. 

Expenses 

Expenses document allows to register expenses, which are accounted when calculating your 

monthly results. You may specify expense type and then generate a chart of expenses. 

 

For future reporting matters, you can specify tax amount, payee (entered manually) and notes. 

Any expense can be linked with some project or job, which adds additional slice for future 

analysis of your projects. 

If expense must be distributed between a number of months, than you may do it using 

corresponding field. In this case, amount will be evenly divided between specified number of 

months and respectively included to the expenses of each month. Examples of expenses: 

Internet connection - 10 USD (1 month) 

CAT tool license - 500 USD (12 months, cause we may expect license updating after 1 year) 

Taxes - 100 USD (3 months, if pay taxes quarterly) 

Income 

 

 

This document allows to register another income in the Ledger, which is not linked with 

translation activity, but is desired to be included in the reports showing total earnings. 



When creating a document, you can specify date, amount, currency and payer of the additional 

income. This document is registered in the Ledger book. 

Reports and analytics 

SDL Trados Business Manager provides extensive tools to generate reports. To cover a wide 

range of requirements the application has two separate reporting engines: 

QuickReports - an engine for simpler usage scenarios, which saves time and provides visually 

attractive reports. 

Custom reports - an engine for advanced usage and for creating printing templates (quotes, 

invoices, purchase orders, CVs, etc.). This supports the creation of reports with increased 

complexity, when a task can not be solved with the QuickReports module. 

Balance statement 

 

Balance statement (Mutual statement) report allows to view a table which can be used to 

reconcile balance with the customer. 

It contains all transactions between user and customer sorted by date of their execution. 

This report is based on a simple table, which means that you can use all its features, including 

filtering, grouping, conditional formatting and printing. By default, this list is grouped by the 

customer and currency, but it can be changed if needed. 

If to double click on any row, the corresponding document will be shown. 

Book of accounts 



This list shows movement of money, registered by different documents, including incoming 

and outgoing payments, in a single view. 

 

Green rows show incoming amounts, and red rows correspond to outgoing amounts. 

To open a document which registered a particular movement, simply double click on any row. 

You can quickly filter this list by document type or party name (this column shows name of 

customer or contractor from an underlying document). 

Custom reports 

Custom reports feature allows to create own reports using data contained in the database. 

The process of creation of a custom report is similar to editing of the invoice template, but 

instead of invoices table you can use any other table from the application database as a data 

source. 

Custom reports can be found in the same table where invoice/quote/purchase orders/cv 

templates are located. 

Select Reports section in the navigation tree and then select Reports and templates item. 

This list is grouped by report type: 

 

To view custom reports, simply expand Custom report category. Predefined reports are 

highlighted with blue color - such reports cannot be modified, but they can be cloned to serve 

as a base for your custom reports. 

To build a report, double click on it. 



To edit report design, select it an click Edit in the Designer. If you wish to edit one of 

predefined reports, you will need to clone them first (select and click Copy predefined 

report), and then edit cloned copy. Detailed description of the designer can be found in 

the Invoice templates and custom reports section. 

You can change report category by selecting necessary reports and clicking Set category (on 

the ribbon or from context menu): 

 

Built-in custom reports 

SDL Trados Business Manager is supplied with a number of predefined custom reports, which 

may serve as a source to learn how to compose reports. 

Customers - list of contacts 

 

Allows to display main information (logo, name, address, phone) about customers and their 

contacts (photo, name, e-mail, skype, etc.) 

Before creating a report, provide a value for the Customer parameter. Select any customers in 

the list or select Select All to build a report for all customers. 

Customers - List of jobs 



 
Allows to view all jobs for a specified customer (or all customers) in a specified period of time. 

Displays date of job creation and delivery, PO number, services, amounts, language pair, 

invoicing status. Optionally, you can filter list of jobs by job's status. 

Contractors - List of jobs with ratings 

 

Allows to list translation assignments for all or selected contractor for specified period. 

Displays all assignments, amounts, ratings, average ratings for period, due amounts both in 

assignment and base currencies. 

Invoices - Tax report 

 
This report allows to view invoices and included taxes in a specified period for all or one 

selected customer. 



In the parameters panel you can check Only invoices with taxes box to display only invoices 

where Tax 1 or Tax 2 is specified. 

Invoices - Unpaid invoices 

 
List of unpaid invoices for all or particular customer, which contains only main information 

from invoices: number, date, customer, amount, currency, amount paid and amount due. 

Useful for exporting and sending to your customers. 

Examples of another reports you may create using custom reports: price lists, lists of jobs or 

invoice to create own backup system, different charts, cross-tab reports to interpret complex 

data, such as summary statistics, etc. Possibilities are really wide, and only limited by the data 

present in the system. 

TM leverage report 

 

This reports allows to view savings thanks to applying TM to a project. It compares amount 

that customer could pay of all volumes in a job were 'No match' values with actual amounts 

calculated with fuzzy discounts. Parameters window allow to select particular projects or 

customers, as well as time period for displaying jobs. 



Per each project, data is grouped by currencies, because a project could contain jobs in 

different currencies. And per each group you can view total savings for all jobs in that group. 

Global book 

Global book can be opened from navigation tree by selecting Workspace > All documents. 

Global book allows to view ALL documents registered in the system in a single list: 

 

Documents include: translation projects, translation jobs, translation assignments, incoming 

and outgoing invoices, incoming and outgoing payments, other income, other expenses, credit 

notes, quotes. This list displays common data of documents, like date, number, term (only for 

jobs/projects/assignments/invoices), amounts, currency, party (customer or contractor), 

average volume (only for jobs/projects/assignments), responsible person. 

In addition, there is Document type column which specifies linked document. On the 

screenshot below, the list is grouped by document type. However, initially this grouping is 

turned off, and document type is displayed in a separate column: 

 

There are few hidden columns in this list, which can be displayed by right clicking on the table 

header and selecting Column chooser. These fields are: 

 Created by 

 Created at 

 Modified by 

 Modified at 



These fields allow to view, sort and filter by user names and dates when records were created 

or modified. 

To group by document type, right click on the table header and select Show group by box. 

Then drag the column to the group area. 

To open underlying document in a new tab, simply double click on any row. 

One of main advantages of this table is possibility to use it in QuickReports and Custom 

reports. Simply select Global book as data source in your report, and process data according 

your tasks. 

In a report, you have access to data of underlying documents by using corresponding reference 

properties (Translation job for translation jobs, Quote for quotes, etc.). 

Such table allows to solve calculation tasks whose results are based on data from different 

tables. Since you have all documents in one table, you can easily calculate values based on value 

of Document type column. 

For example, calculation task of following type can be easily solved: calculate total amount of 

jobs and translation assignments per certain period and then get final result by deducting 

second value from the first one. 

Ledger 

Ledger is a place where all your income and expense transactions are stored. 

When you create a job, or invoice, or translation assignment, SDL Trados Business Manager 

register income or expense, depending on the program settings. If you use job-based 

accounting type, then income transaction is created upon creation of a job (on a job's date). 

Switching to invoice-based accounting will lead to income transaction generation by creating 

an invoice over jobs. 



By default, income transactions (amount with plus sign) are highlighted by green color, while 

expenses (amount with minus sign) has red color. 

 

The list contains a number of columns which help you to determine when and how particular 

transaction was created. Here you can see document (operation) type and number and date of 

that operation. In addition, party name is displayed (customer's or contractor's name), as well 

as expense/income type. 

Double clicking on any row allows to open corresponding document editing form. 

Since the Ledger usually contains a lot of records, it is recommended to group the list by time 

intervals. To do this, please follow these steps: 

1. Right click on the table header and select Show group by box. 

2. Drag Date column to the group box. 

3. Right click on the grouped Date column and select Group Interval - Month or Smart. 

4. In the result, the list will be grouped by months. 

 

To add monthly summary, do the following: 

1. Right click on the grouped Date column. 

2. Select Group summary editor. 

3. In the pop-up window, select Amount (base cur.) and tick Sum checkbox on the right. 

QuickReports 



QuickReports module is one of the most interesting SDL Trados Business Manager features. It 

allows to quickly and effectively create nice looking information panels using different types of 

elements: tables, pivot grids, charts, scatter charts, pie charts, gauges, cards, treemaps, 

choropleth maps, geopoint maps and images. 

QuickReports module allows to get and combine data from different tables. This allows, for 

example, to put information about jobs, assignments and invoices into one large panel, 

presenting essential data on one screen. One of highlights of this QuickReports module is a 

catchy design of the resulting view. Here is an example: 

 

You can expand any individual element to full screen, export any widget of a QuickReport, or 

the whole QuickReport. 

To export individual element, click Export button in the top right corner of a widget and 

select Export to PDF, Export to Image or Export to Excel options: 

 

To export the whole QuickReport, click Export button in the top right corner of a report. 

When exporting to Excel, a separate sheet will be created for each QuickReport element. 



To access QuickReports module, select Reports in the navigation tree, and then 

select QuickReports. By default, you will see a list of predefined reports: 

 

This list can be categorized. To do this, use Change category button, which allows to move 

selected report(s) to another category. Grouping in this list allows to find necessary reports 

faster in future. By default, all reports has no group. 

To generate a report, simply double click on it. To create a new report, click New. 

You may have any number of QuickReports, intended for different situations. For example, you 

may create reports for project managers, executive managers, finance department, etc. 

When you start creating a new report, you will see Data source wizard to select Data type: 

 
Here you have to select a data table, which contains base data you wish to build a report on. 

This will be just only the first source of data for the created report. Later you will be able to 

remove a source, as well as add new sources. So it's not critical to make a mistake in this dialog. 

Select Translation job, for example. Finish the wizard. 

To add new elements to the workplace, use corresponding buttons on the ribbon: 

 



In the nested articles all those elements are described in detail. 

To save QuickReport, click Save. To export QuickReport for external editing (for example, to 

send to support team), use Save as button. This allows to save a template as xml file. 

Built-in QuickReports 

To help you get familiarized with QuickReports feature, SDL Trados Business Manager contains 

a number of pre-defined reports. You are free to delete them or edit as you wish - these reports 

are created using default means and are not the part of the software. 

Here is a list of pre-defined QuickReports: 

Dashboard (customers) 

 
Time range control to quickly change report period, top customers table, volumes by customer, 

colored map showing world map with highlighted countries, pivot table to analyze margin by 

tears and customers, total amount of unpaid invoices by customers and amount of uninvoiced 

jobs. 

Performance report 

 
Allows to analyze your performance in terms of yeas and customers, showing total amount and 

average volumes in table and chat forms. In addition, contains interactive chart to analyze 

translation volumes by customers with year-quarter-month detalization. 



Number of jobs 

 
Simple report containing interactive chat displaying number of jobs you did in different 

periods. 

Number of projects 

 
Simple report containing a chat displaying number of projects in a specified period. 

Available filters: customers, managers (responsible persons). 

Time analysis 

 
Displays different information about time you spend working on jobs. Charts display info by 

specializations and customers, as long as your performance by years. Pie chart is clickable and 

allows to view detailed data about each specialization category. 



Earnings analysis 

 
Allows to display and compare income/expenses for a selected period of time, along with 

average earnings and income/expense structure. 

Profitability by time (pivot) 

 
Allows to analyze time effectiveness and see earnings per hour for different languages, 

specializations, customers. Data is represented by expandable pivot table and two charts. You 

can quickly filter data using time range filter at top and a number of filter on the right. 

Profitability by time(tabular) 

 
Allows to analyze time effectiveness and see earnings per hour for all your jobs. Data is 

represented by simple table with applied formatting rules for better visualization of your 

results. You can quickly filter data using time range filter at top and a number of filter on the 

right. 



Jobs-Quotes conversion analysis 

 
Allows to analyze how quotes are converted into real jobs. You can determine best and worst 

convertible customers, view amounts, conversion factor, number of jobs. Embedded bars and 

colorful icons highlight largest and smallest amounts for easier navigation in results. 

Vendor performance 

 
This report allow to view performance data of all or individual vendors, and contains the 

following widgets: Number of jobs (show number of assigned jobs with statuses over selected 

time period), Unpaid assignments (list of unpaid assignments along with statuses, amounts and 

other data), Top specializations (shows average volume by specializations), Amounts by 

currencies chart (shows full amounts, due and paid amounts in each assignment currency), 

Average rating (shows average rating in a specified period). By default, Vendor role allows 

translators to view this report from their account. The only difference is that vendors can only 

view their own data, not data of other vendors. 

Customers - List of jobs 

 
Allows to quickly view jobs for a selected customer in a specified time period. 



Built-in graphs visualize job amounts and volumes for easier navigation. 

Performance of responsible persons 

 
Displays amounts and volumes processed by selected managers in a specified period of time. 

Allows to calculate manager's commission based on percentage specified in the report settings. 

Contractors - Due amounts 

 
Allows to display due and full amounts earned by vendors in a specified period of time. 

Possible to filter by assignment statuses, language pairs and vendors. 

Costs (by customers, projects, languages, PMs) 

 
This report displays amounts, expenses and total margin by customers in a form of pivot table 

and linear chart. Pivot table allows to additionally analyze data by customer projects, managers 

and specializations. 



Available filters: time period, customers, projects, managers (responsible persons) and 

language pairs. 

Costs (by vendors) 

 
This report displays amounts of source jobs and assignments, as well as margin amount per 

vendors. Pivot table allows highlights highest and lowest amounts and margins. 

Available filters: time period, vendors, managers (responsible persons) and language pairs. 

Projects (amounts by languages) 

 
Allows to select a report and analyze project amounts, assigned amounts and margins by 

managers in a certain period of time. 

Additional chart displays same values by months. 



Projects (amounts/volumes analysis) 

 
One of the most powerful and flexible reports. Main goal is to analyze project effectiveness by 

managers. It contains two widgets: chart and table. Chart displays amounts and margins of 

projects, as well as effectiveness expressed in percents. Table contains total data by managers 

and average margin, highlighting better performing managers. 

Available filters: projects, customers, managers, project amount range and volume range. 

Volumes (by customers) 

 
This report displays volumes (total and average) by languages, units and services for a selected 

customer. Additional linear chart displays average volume change over time. 

Available filters: time period, customers, units, services. 



Volumes (by managers) 

 
This report displays volumes (total and average) by customers and units for a selected vendor. 

Additional linear chart displays average volume change over time. 

Available filters: time period, managers, units, services. 

Volumes (by project) 

 
This report displays volumes (total and average) by units, languages and services for a selected 

project. Additional linear chart displays average volume change over time. 

Available filters: time period, projects, units, services. 

Volumes (by vendors) 

 
This report displays volumes (total and average) by units, languages and services for a selected 

vendor. Additional linear chart displays average volume change over time. 



Available filters: time period, vendors, units, services. 

Translation project management system - Vendor performance 

Volumes (tree map) 

 
This report displays best customer and language pairs in terms of volumes. Additional chart 

displays average volume change over time by customers. 

Available filters: time period, customers, projects, languages, units and services. 

Productivity dashboard 

 
This report is about time tracking and performance. It allows to view translation volumes over 

certain period, speed an income per hour, top specializations and language pairs. Four filters 

(by date, unit, work type and language pair) allow to control displayable data. 

Average volume chart is interactive and allows to click on pies to view detailed chard by 

specialization category. 



Jobs (amounts/volumes analysis) 

 
Displays aggregate amounts and volumes by jobs during specified period of time in terms of 

language pairs and specializations. Additionally, contains a table with customer contacts 

(project managers) with amounts and volumes processed with them. List of filters allows to 

additionally filter data by projects, job statuses, customers, customer contacts, own project 

managers, job amounts and job volumes. 

Margin analysis 

 

Displays margin (as amount and percentage) in a specified period of time. Report contains few 

tabs which allow to analyze margins in different forms: as pivot table, as chart of margin 

amounts, chart of average margins and chart of total margin. 

Allows to filter data by customers, language pairs, projects, specializations and responsible 

persons. 



Average volumes by vendors 

 

It displays average volumes for vendors in a specified period and allows to detail this volume 

by units and services. Allows to quickly filter by dates and vendor names. Contains two tabs. 

First tab displays 2 chart - first chart displays average volumes for all filtered vendors. Second 

chart displays detailed information about volumes for a vendor selected on the first chart. 

On the second tab, pivot table is presented which allows to analyze volumes in a tabular 

format. 

Calculated fields 

The QuickReports Designer provides the capability to create calculated fields that allow you to 

apply complex expressions to data fields that are obtained from the QuickReport's data source. 

You can use these fields in data visualizations as regular source table fields. 

Creating a Calculated Field 

You can add create new calculated field based on the existing data source fields. 

To create a calculated field, right click on the data source area and select Add calculated field, 

or use corresponding button in the Ribbon's Data Source tab: 



 

This invokes the Expression Editor dialog, which allows you to specify an expression that will 

be used to obtain calculated field values. Here, you can construct the required expression. 

You can use the following elements in expressions. 

 Functions 

 Operators 

 Columns 

 Constants 

 Parameters 

After the expression has been specified, select OK. This displays a new calculated field in the 

data source structure. Now you can specify the required calculated field type, change its default 

name, etc. 

Editing a Calculated Field 

To edit a calculated field, use its context menu. This menu contains the following items: 

Edit Expression... 

Invokes the Expression Editor dialog, which allows you to change an expression for an existing 

calculated field. 

Field Type 

Specifies the type of the calculated field. 

Note. The type of a newly created calculated field is detected automatically based on the type of 

values returned by the specified expression. 



Rename 

Changes the calculated field name. 

Delete 

Removes the existing calculated field from the data source. 

Calculated Fields at the Summary 
Level 

When you create calculated fields in the QuickReports designer, their values are calculated on 

the base of individual data source rows. Then, when this calculated field is used in any 

dashboard widget, you apply selected summary function to it. 

About this task 

Let's take Translation jobs table as data source and create new calculated field called Amount 

per hour. Using expression builder you can quickly build the following expression for this 

calculated field: [Amount (base cur)] / [Edit time (minutes)] * 60 

This calculated field allows to get earned amount per hour for each job. If to drag this column to 

a Table, Chart, Pivot table or any other widget, you will be able to select summary function for 

this field. 

 

On provided screenshot you can see that Amount (base currency), Edit time 

(minutes) and Amount per hour fields were put onto the Values section of the pivot table, 

and Date field was put into Rows section. Average amount per hour is calculated by summing 

this value for each job in specified year and dividing it by a number of jobs. Because of that, 

applying provided expression to summary values shown on the screenshot would not give 

value in the last column. 



To calculate expression on a summary level, right click on a calculated field, select Edit 

expression, expand Functions node and select Aggregate functions: 

 

You can select from a number of aggregate functions to calculate your values on a summary 

level. 

For the first row, 6626.96 / 15028 * 60 gives 26.46. Amount per hour is now calculated for the 

summary values, not as average of jobs. 

You can use any of the following predefined aggregate functions within the QuickReports 

Designer: 

 Avg() - Returns the average of all values in the expression. 

 Count() - Returns the number of values. 

 CountDistinct() - Returns the number of distinct values. 

 Max() - Returns the maximum value across all records. 

 Min() - Returns the minimum value across all records. 

 Sum() - Returns the sum of all values. 

Default widgets 

This section contains description of each widget available in the Insert group of the ribbon the 

QuickReport designer. 

QuickReport items - Cards 



Displays a series of cards, each illustrating the difference between two values. This difference can be 

expressed as an absolute value, an absolute variation or a percentage variation.

 

QuickReport items - Chart 

Chart displays data graphically using bars, lines, points, etc. 

To bind the Chart item to data, drag and drop a data source field to a placeholder contained in 

one of the available data sections. 

Transposing arguments and series 

The Chart dashboard item provides the capability to transpose chart arguments and series. In 

this case, data items contained in the Arguments section are moved to the Series section, and 

vice versa. 

To transpose the selected Chart item, use the Transpose button in the Home ribbon tab. 

 

Series 

The Chart item supports different types of series - from simple bar and line charts to candle 

stick and bubble graphs. To switch between series types in the Dashboard Designer, click 

the Options button next to the required data item (or placeholder) in the Values section. 



 

In the invoked Series Options dialog, select the required series type and click OK. 

 

You can also do this using the Series Type gallery in the Design Ribbon tab. 

To manage common series options, use the Common Options tab of the Series Options dialog. 

 



 

Panes 

The Chart item can contain any number of panes. Panes are visual areas within a diagram that 

display chart series. 

Each pane has its own Y-axis and displays a specific set of series. All panes in a chart share the 

same X-axis. 

To add a pane, click the Add Pane button at the top right of the Data items pane. 

 

Interactivity - drill-down 

The Chart item supports drill-down on argument or series values. 



When drill-down on arguments is enabled, an end-user can click a series point to view a detail 

chart for the corresponding argument value. Drill-down on arguments requires that 

the Arguments section contains several data items, from the least detailed to the most detailed 

item. 

 

Switch to Data tab on the ribbon and click Drill-down button. From now, you will be able to 

click on chart points to get detailed information for quarters, and then for months. 

QuickReport items - Choropleth map 
Allows you to colorize required areas in proportion to the provided values. 

 
SDL Trados Business Manager ships with a set of default maps showing various parts of the 

world. The following maps are included. 

 World Countries - a world map. 

 Europe - a map of Europe. 

 Asia - a map of Asia. 

 North America - a map of North America. 

 South America - a map of South America. 

 Africa - a map of Africa. 

 USA - a map of the USA. 

 Canada - a map of Canada. 



To select the required default map, use the Default Map button in the ribbon Design tab. 

After you select the default map or a custom map, you can view supplemental information (such 

as the name of the country, state, etc.). To do this, click the Options button next to 

the Attribute data item. 

 
For example, Customer has a field named Country. This field can be bound to a name of the 

country in this Dashboard map item. 

The Choropleth Map item colors map shapes depending on the provided values. If you need to 

customize these settings, click the Options button next to the data item that contains these 

values. This invokes the Choropleth Map Options dialog. 

 
You can specify the following settings in this window. 

 Color palette - allows you to specify the start and end color of the palette. 

 Scale settings - specifies whether a percent scale or an absolute scale is used to define a set 

of colors. You can specify the number of levels that represent the number of colors used to 

color the map. 

 Preview is used to display a full set of palette colors generated based on the start/end colors 

and the number of levels. Use the Allow Edit check box to automatically change the 

generated colors or specify value ranges for each color. 

Also, the Choropleth Map allows you to visualize the difference between 

the actual and target values of a particular parameter. To specify delta indication settings, click 

the Options button next to the data item container. This invokes the Choropleth Map 

Options dialog. When the map type is set to Delta, this dialog contains the following settings. 



 
Value type 

You can specify which values to display within map tooltips. Use the Value type combo box to 

select the value that will be displayed as the delta value. 

Result Indication 

You can specify the condition that will be used to select the indicator color. To do this, use 

the Result indication combo box. 

Threshold type and Threshold value 

You can specify that a required indicator should only be displayed when the difference between 

the actual and target values exceeds a specified value. For instance, the actual value exceeds the 

target value by 10%, or by $2K. Use the Threshold type combo box to select whether you wish 

to specify the threshold in percentage values or in absolute values. Then use the Threshold 

value box to specify the threshold value. 

QuickReport items - Gauges 
Visualizes data within a series of gauges. Each gauge can communicate two values - one with a 

needle and the other with a marker on the scale. The image below shows a sample Gauge 

dashboard item that is bound to data. It shows the difference between paid amount and full 

amount of invoices for each customer. 

 

Delta 

Gauges allow you to display the difference between the actual and target values of a particular 

parameter. This difference is called delta. Delta is shown with a delta indicator (indicating 



whether the actual value is less than or greater than the target value) and delta 

values (representing this difference as an absolute value or a variation). To customize settings 

that relate to the calculation and display of deltas, use the options buttons displayed next to the 

data item container in the Gauges section of the Data items pane. These buttons invoke 

the Gauge Options dialog. 

 

Use it to define the condition for displaying delta indication, specify which delta values should 

be displayed, and introduce the comparison tolerance. 

Gauge scale 

By default, the Gauge item automatically determines the range of the gauge scales based on the 

values they display. You can override this behavior and specify maximum and minimum values 

on the scale. To do this, invoke the Gauge Options window using the Options button displayed 

in the data item container in the Gauges section of the Data items pane. In the Gauge 

Options window, deselect the Auto check box for the maximum or minimum value, and specify 

this value in the corresponding field. 

 

QuickReport items - Grid 



Grid allows you to present data in tabular form. To bind the Grid dashboard item to data, drag 

and drop a data source field to a placeholder contained in one of the available data sections. 

About this task 

The Grid dashboard item supports four types of columns. 

 Dimension Column - displays grouped values from the bound data item and allows you 

to provide discrete categorical information. 

 Measure Column - displays summaries calculated against data in the bound data item. 

 Delta Column - bound to two measures, calculates summaries for both measures, and 

displays the difference between these summaries. 

 Sparkline Column - displays values in the bound data item using sparklines. 

When you drop a data item into the Columns section, the type for the new column is 

determined automatically based on the data type. The type of the column is indicated within 

the corresponding data item container in the DATA ITEMS area. 

 

Column type indicators are defined as follows. 

To change the column type, select the column type indicator. In the Column Options window, 

select the column type from the Column type section. 

The dimension column displays values from the bound data item "as is". 

 

If the dimension column is bound to a data source containing images, it can display images. 



A measure column displays summaries calculated against data in the bound data item. Values 

in the measure column can be displayed as text or represented by bars. 

To select between these modes, open the Column Options window and select Value or Bar. 

 
If bars are displayed, use the Always show zero level check box to specify whether the bar 

zero level is always visible. 

Drill-down 

The built-in drill-down capability allows end-users to change the detail level of data displayed 

in dashboard items on the fly. The Grid item supports drill-down for rows. When drill-down is 

enabled, you can select a grid row to view the details. Drill-down requires that 

the Columns section contains several dimensions at the top, from the least detailed to the most 

detailed dimension. 

 
 

To enable drill-down, select Drill Down in the Data ribbon tab. 

 
To return to the previous detail level (drill up), use the corresponding button within the Grid 

caption, or the Drill Up command in the context menu. 



Conditional formatting 

The Grid item supports the conditional formatting feature that provides the capability to apply 

formatting to grid cells whose values meet the specified condition. This feature allows you to 

highlight specific cells or entire rows using a predefined set of rules. To create a new format 

rule for the Grid's dimension/measure, do one of the following. 

 Click the Options next to the required measure/dimension. Select Add Format 

Rule and choose the condition. 

 
 Right-click the column header corresponding to the required measure/dimension and 

select Add Format Rule. 

 
 Use the Edit Rules dialog. Depending on the selected format condition, the dialog used 

to create a format rule for Grid contains different settings. For instance, the image 

below displays the Greater Than dialog corresponding to the Value format condition. 

 
 



Totals 

The Grid dashboard item enables you to add a summary value (a total) calculated against 

displayed values of an individual column, and show the result under this column. 

Note that you can add any number of totals for each column. For example, you can obtain the 

number of column records, average or maximum value, etc. You can create totals using 

different sets of summary functions. This depends on the type of the data source field providing 

data for the target column. 

To create a total, use the context menu of the column header. Right-click the required column 

header, select Add Total and specify the type of summary function used to calculate a total. To 

change the total type, right-click the required total and select a new total type. 

 

Other 

To configure table layout, switch to Design tab on the ribbon and try to play with provided 

functions. For example, you may turn word wrapping feature to wrap words in table cells. Or 

use Banded rows button to colorize odd and even rows. 

QuickReport items - Group 

Group is a container which is used to arrange items and manage QuickReport items interaction 

within and outside the group. 

The Group has the following functions: 

 Combines QuickReport items within the report into a separate layout group. 

 Manages the interaction between QuickReport items within and outside the group. 



For instance, you can group related filter elements and data visualization dashboard items. 

To create a new group, click the Group button in the Home ribbon tab. 

 

You can drag-and-drop QuickReport items to add them to a group and change their layout. 

Note. You cannot add groups to another groups. 

The Group allows you to manage the interaction between dashboard items in and outside the 

group. The image below shows a group's default interactivity settings: 

 

The Master Filter and Ignore Master Filters buttons are located in the Interactivity group on 

the Data ribbon tab of the Group Tools contextual tab set. 

If the Master Filter button is Off, master filter items in a group can filter only this group's 

items. The enabled Ignore Master Filters option isolates the group from external master 

filters (for example, from main Range filter element). 

QuickReport items - Pies 
Pie displays a series of pies or donuts that represent the contribution of each value to the total. 

Principles of working with pies are the same as with previously described charts. Simply drop 

necessary fields to placeholders to build pie chart. Here is an example: 



 

QuickReport items - Pivot 

Pivot table displays cross-tabular reports and allows you to analyze multi-dimensional data. 

Select the Pivot button on the ribbon, an empty pivot table will added to the workplace. 

To bind the Pivot item to data, drag and drop a some field to a placeholder contained in one of the 

available data sections (Value, Column, Row). A table below lists and describes a Pivot data 

sections. 

 Values 

Contains data items used to calculate values displayed in the pivot table. 

 Columns 

Contains data items whose values are used to label columns. 

 Rows 

Contains data items whose values are used to label rows. 

The Pivot dashboard item provides the capability to transpose pivot columns and rows. In this case, 

data items contained in the Columns section are moved to the Rows section and vice versa. To 

transpose the selected Pivot dashboard item, use the Transpose button in the Home ribbon tab. 



Drag desired fields to a corresponding areas of the pivot grid: 

 

You see that Date field was dragged to Columns area few times, but different detailization level was 

selected. It allowed to create nested Year - Quarter groups. After few clicks, we have got a table 

showing our margin from translation jobs in a context of different customers and year-quarter 

groups. 

To change a name of this element, select Title button in the Dashboard group of the ribbon. Except 

name, you can load any image for even better visualization. 

To setup conditional formatting for this pivot table, right click on it and select Edit rules. In the 

opened window, configure desired formatting rules to highlight points of interest in the table. 

QuickReport items - Range filter 
The Range Filter item allows you to apply filtering to other QuickReport items. 
This item displays a chart with selection thumbs that allow you to filter out values 
displayed along the argument axis. 

 

To bind the Range Filter item to data, drag and drop a data source field to a 
placeholder contained in one of the available data sections. The Range Filter item 
supports various Line, Area and Bar series types. To switch between series types, 
click the options button next to the required data item in the Values section. In the 
invoked Series Type dialog, select the required series type and click OK. You can 
also do this using the Series Type gallery in the Design Ribbon tab. 

Range Filter may interact with other QuickReport items. QuickReports allow you 
to use any data-aware widget as a filter for other widgets (Master Filter). Master 
filtering is always enabled for the Range Filter item. This Range Filter displays a 



chart with selection thumbs that allow you to filter out values displayed along the 
argument axis. 

To enable filtering across data sources for the Range Filter, use the Cross-Data-
Source Filtering button in the Data Ribbon tab. 

When range filter is placed on the QuickReport, you can quickly change period of 
displayed data. 

QuickReport items - Scatter chart 
You can use the Scatter Charts to visualize relationships between numeric variables. The 

image below shows a sample Scatter Chart item that is bound to data. 

 

To bind the Scatter Chart item to data, drag and drop a data source field to a placeholder 

contained in one of the available data sections. A table below lists and describes Scatter Chart 

data sections. 

Section Processed as Description 

X-Axis Measure Contains the data item against which the X-coordinates of data points are calculated.

Y-Axis Measure Contains the data item against which the Y-coordinates of data points are calculated.

Weight Measure Contains the data item whose values are used to calculate the weight of data points.

Arguments Dimension Contains data items providing scatter chart arguments that are used to create data points.

QuickReport items - Tab container 



Overview 

The Tab container item allows you to split the dashboard layout into several pages. For 

example filter controls for large elements in a QuickReport can be located on a separate tab 

page. 

Tab creation 

To create a tab container, click Tab Container button in the Home ribbon tab: 

 

A newly created tab container contains an empty tab page (Page 1). 

 

Click the + (plus) icon to add an empty page to the tab container. You can use drag-and-drop to 

add widgets to a tab page and manage the layout. Tab containers cannot be nested, so you 

cannot add a tab container to another tab container. However, a tab container can contain 

item groups. 

Tab Order 

To change the tab page order, click the Reorder Tabs button on the Tab settings group. 



 

The Tabs Order dialog is invoked. 

 

Click up and down arrows to change the order of the tab pages in the tab container. 

Display Item as Page 

The tab caption is above the caption of the content element on the page. If a tab page contains a 

single element, the Display Item as Page feature is activated. It merges the item with a tab 

page and displays a single caption, as illustrated below. 

 

To disable the Display Item as Page feature, use one of the following methods: 



 Select the tab page and click the Display Item as Page button in the Layout group on 

the Design ribbon tab of the Page Tools contextual tab set. 

 
 Select the Display Item as Page command in the tab page context menu. 

Interactivity 

The tab page allows you to manage the interaction between QuickReport items inside and 

outside the page. The following image shows a tab page's default interactivity settings: 

 

The Master Filter button (in the Interactivity group on the Data ribbon tab of the Page 

Tools contextual tab set) controls whether the current page's master filter items can filter 

QuickReport widgets outside the page. This option is enabled for the newly created tab page: 

master filter items in the page can filter any QuickReport widgets. 

The Ignore Master Filters button (in the Interactivity group on the Data ribbon tab of 

the Page Tools contextual tab set) allows you to isolate QuickReport widgets contained within 

the tab page from external master filter items. This option is disabled for the newly created tab 

page: external master filter items can filter the QuickReport widgets contained within the tab 

page. 

Parameters 

Parameters allow to add interactivity to QuickReports, allowing users to specify specific values 

which affect on data displayed in QuickReport's. 

It can be time period, customer name, job status, etc. 

Creating Parameters 



To create a parameter, perform the following steps: 

1. Select the Parameters button on the ribbon Home tab. 

2. In the invoked dialog, select Add to add a new parameter. 

3. Specify the parameter settings. 

Settings Description 

Visible Specifies whether or not the parameter editor is visible in the Parameters dialog.

Allow Null Specifies whether or a not null value can be passed as a parameter value. 

Allow Multiselect Specifies whether or not multi-selection is enabled for the current parameter. 

The following limitations are applied to parameters with multi-selection enabled.

Use the is any of or is none of operators to pass a multi-select parameter to a filter criteria or to the Expression 

format condition. 

Use the In or Not In operators to pass a multi-select parameter to a calculated field expression.

Name Specifies the parameter name. 

When creating and modifying parameter names, follow the rules below. 

A name can contain letters, numbers and underscores. 

A name cannot contain spaces. 

A name cannot be an empty string. 

The dashboard cannot contain parameters with the same name. Names are case-

create the names Parameter and PARAMETER. 

Description Specifies the parameter's description displayed to an end-user. 

The parameter's description is the value displayed in the Parameter Name column of the 

Look-Up Settings Specifies the parameter look-up editor settings. 



Settings Description 

Select All Values Specifies whether or not all parameter values should be selected in the initial state of the QuickReport Viewer.

Note that this option is in effect when Allow Multiselect is set to true. 

Type Specifies the parameter type. 

Value Specifies the default parameter's value(s). 

Note that when Allow Multiselect is set to true, the Value option allows you to select multiple parameter values.

4. Select OK to add the created parameters to the dashboard. 

Look-Up Editor Settings 

There are three types of look-up editor settings that can be specified for a parameter. 

 

Select the required type from the Look-Up Settings drop-down list. 

 

 No Look-Up - set the Value to use a static value as a parameter. 

 Static List - click the ellipsis button to add static values for the current dashboard 

parameter. 

 Dynamic List - allows you to use a list of values from the existing data source as a 

parameter. Specify the following settings. 

 First, select the required Data Source from the list of available data sources. For 

example, if you wish to filter job list by PM, add a new data source linked 

with Contacts table. 

 Then, specify data members for the dashboard parameter's value and display 

name using Value Member and Display Member, respectively. 



 If necessary, specify the data member used to sort parameter values using 

the Sort By option. Sort Order specifies the required sort order. 

 From now, you can use parameters to filter QuickReport's data source (Data 

source tab - Filter) or in calculated fields. When you double click on a 

QuickReport to generate it, you will be able to provide parameter value in the 

Parameters dialog. 

Dashboard 

Dashboards serve as a single place to display differentiated information about your business on 

a single screen. 

 

They allow to fit multiple widgets (views) on one screen, allowing to keep the most important 

data under control. In addition, there are a number of widgets which are available only in 

dashboards (not possible to open that views from navigation). For example, you can open list of 

jobs in a separate tab from navigation tree, but you cannot view Ready to invoice list 

anywhere except dashboard. 

By default, the system has three dashboards, available from the Workspace section of the 

navigation tree: 

 



All these dashboards are customizable, and you are free to fully replace default widgets with 

your own views. In addition, you can define a color for each widget for better presentation. 

Among default widgets in different dashboards, you will find: 

 Ongoing jobs 

 Unpaid invoices 

 Balance statement 

 Word stats chart 

 Earnings chart 

 Volumes chart 

 Top customers chart 

 Jobs ready to invoice 

 Undistributed payments 

 Notepad 

 Workload planner 

 Undelivered assignments 

 Unpaid assignments 

 Active quotes 

Dashboards has columnar structure. Each column can be collapsed to make other columns 

wider. In the same way, each widget can be collapsed vertically, to free some space for other 

widgets. Collapsed/expanded state is preserved between sessions. In addition, you can find 

splitter between all columns (horizontally) and between all widgets (vertically), which can be 

used to quickly change size of necessary column or widget. 

Note. In some visual themes, splitter has no color and may be invisible. Simply hover mouse 

pointer on a border between columns and widgets to highlight splitter. 

Most of widgets can be opened in full screen mode. For this, you can press View widget in full 

screen on the toolbar. If toolbar is hidden, press F11. 

Dashboard default widgets 

See nested articles with examples of default widgets presented in different dashboards. 

Dashboard item - Ongoing jobs 



 

This list contains all the jobs for previous 60 days. 

 To view and edit the job simply double-click on it. 

 To add a new job, click New on the toolbar or Quick job creation on the ribbon. 

 The list of current jobs can be customized. 

You can select displayed columns. To do this, right click on any column name and 

select Column chooser. Drag and drop fields according your wishes and close column chooser. 

Also, it is possible to apply automatic filters in this list. Take a note that all changes made in this 

list are saved between sessions. 

Dashboard item - Workload 

 

This is a compact version of the Workload planner feature. 

This widget displays planned translation volumes for upcoming days. If a day contains multiple 

jobs, they are stacked as cards below the date. Each card contains short information about 

planned work: customer short name and logo, job deadline, total volume and volume planned 

to do during a day. 

Double clicking on a card allows to open corresponding job editing form to view detailed 

information about a job. 

Dashboard item - Ready to invoice 



 

You can specify invoicing threshold for each customer. Until amount of delivered job isn't be 

reached, this customer won't appear in this list. By default, this value is set to 1. Setting it to 

zero fully excludes that customer from this widget. 

To create an invoice, double click on any card inside this widget. A new invoice will be 

automatically created and filled with the data of uninvoiced jobs. Payment term will also be 

automatically detected using settings you specify for a customer. 

Dashboard item - Unpaid invoices 

 

This list contains all issued invoices that are still unpaid by the customer. You can see full and 

due amounts here. 

Right click on the invoice to open context menu, which allows to open invoice, create a 

payment over this invoice or print it. 

Dashboard item - Monthly results 



 

 

It is a chart showing your profit and expenses for the specified period year. 

Amounts are expressed in the base currency. You can select one of the following chart types in 

this widget: bar chart, where results are grouped by months and average income line is 

painted, or linear view, showing income in sequential order (where current month income is 

highlighted with red color). 

To find out how values in this chart were calculated, you can always open Reports > Ledger, 

and check records per necessary month. Please remember that earnings can be calculated 

differently depending on the accounting type you use in the application. 

Dashboard item - Balance statement 

 
This table shows the balance amount for each customer based on the entered projects (plus, or 

debit) and payments (minus, or credit). 

Dashboard item - Assignments 



 

Dashboard for manager contains 2 similar widgets: undelivered assignments and unpaid 

assignments. 

Both lists are grouped by currency, so you can see totals by each used currency. You can add 

another grouping level (by language pairs, for example). To do this: 

1. Right click on a table header, select Show group by box, and drag necessary column to 

the group panel (after or before Currency column). 

2. Then you can hide group panel again to save free space. 

To open any assignment, double click on it. Both lists share the same settings (visible columns, 

groupings). Taking this into account, please make changes only in one table. Second table will 

reflect the same changes when this dashboard will be loaded next time. 

Dashboard item - Undistributed 
payments 

 

If you add an incoming payment, but still do not have issued invoice (for example, of this 

payment is a prepayment), than it is necessary to remember that this payment must be 

distributed later. 

This widget helps to keep this information in mind. Later, when an invoice will be created, 

undistributed payment can be linked with it and disappear from this list. 

Dashboard item - Volumes chart 



 
This chart simply displays average amount volume of jobs for a specified period. This period is 

selected above the chart. 

Dashboard item - Work stats 

 

Here you can see your jobs volumes categorized by work fields and presented as a chart. 

If, for example, you did one job counted in words and the other counted in hours, both these 

jobs will be included into this chart. To achieve correct volume representation in different 

units, there is an 'Adjustment factor' column in the 'Units' catalog. If, for example, you know 

that 1 hour corresponds to about 600 words, than go to the 'Units' catalog and set this value for 

the 'Hours' unit. And vice versa, if your base unit is an hour, than you can set 0.0017 as an 

adjustment factor for words. Such approach allows to fit volumes in different units into the one 

chart. 

You can select a period above the chart, save it as image or print. 

Dashboard item - Notepad 



 

Incredibly simple widget which allows to mark some simple text information. 

You have more dedicated place to keep some simple text. 

Context menu here contains a number of functions to format selected text. 

Dashboard configuration 

Select Configure dashboard, to move, hide, delete and add widgets, in 

the Configuration screen: 

 

The following Configuration screen appear: 

 

Here you can find list of all dashboard widgets organized by groups. There is a root group 

called Root. It cannot be edited, deleted or renamed, and its orientation is always Horizontal. 

You can edit group and widget properties. For groups, you can set caption, orientation and 

caption visibility. Widget properties window looks as this. 

 

To faster move widgets between groups, you can use drag&drop functionality implemented in 

the tree list. Simply drag any group or widget and drop it into any other group. 



To change widget/group order within a group, click Increase row index or Decrease row 

index buttons in the list of widgets. 

To create a new group, click Create new group. New group will added to a group which is 

currently selected in a tree. However, you can always move it into another location later. 

In the same manner, you can use Toggle visibility button to change visible state of a widget. 

Making widget invisible allows to hide it from dashboard, but not delete. This allows to quickly 

display it in future, without need to create deleted widget from scratch. However, if you are 

sure that particular widget would not be needed in a dashboard, click Delete to fully delete it. 

Widget size field allows to set widget height in percentage. When changing this value, try to 

follow this rule: sum of all widgets sizes should give 100 (approximately). Widget size affect 

only initial state of a dashboard. You will be able to change sizes later using splitters which are 

automatically added between all groups and widgets. 

Note. Splitters are not supported in web version. So, pay additional attention to setting widget 

size more precisely. 

Widget color field allows to set a color of widget caption and border on the dashboard. By 

default, all widgets do not have any color, and default theme color is used (usually, gray). 

 

To create a new widget, click New widget in the list of widgets. Main goal during widget 

creation is to select entity type. You can expand list of types and select one depending on 

requirements. Scroll list to find out which types are available (in general, it includes all 

reference data, all documents, and a number of additional types, like Earnings, Ledger, Book of 

accounts, etc.). When entity type is selected, you have to select a view (except 

when Notepad or Earnings chart is selected). Depending on selected type, list of available 

views will be different. Purpose of each view can be understood from its name. For example, if 

you select Translation job as a type, then TranslationJob_ListView_ChartMonthlyValues will 

allow to display some chart with monthly volumes, while TranslationJob_ListView_Limited will 

display simple list of jobs with limited number of columns. 



Note. With time, selection of available views will be expanded, allowing to create more 

different widgets. Especially, more charts will be added with time. 

After selecting data type and view type, you can provide additional criteria in the Criteria filed. 

This field provides visual filter designer, which will help to quickly build a criteria. Let's 

assume, you have selected Translation job as entity type, 

and TranslationJob_ListView_ChartMonthlyVolumes as a view. To display uninvoiced jobs 

for a particular customer, you can provide the following criteria: 

 

Now, this chart will display volumes for Capital Translation with Not invoiced status. 

When you made all necessary changes on the dashboard configuration screen, do not forget to 

click Apply changes in the list of widgets. Otherwise, your changes would not be saved. Close 

the configuration window, and your changes will be immediately applied to a currently opened 

dashboard. 

 

Configuration examples 

Here are few examples of layouts and recommendations how to build corresponding tree on 

the Dashboard configuration screen. 

Example 1. 

 



Tree structure: 

 Root 

 Group 1 (vertical) 

 

 Widget 1 

 

 Group 2 (horizontal) 

 

 Widget 2 

 

 Widget 3 

 

 Widget 4 

 Group 3 (horizontal) 

 

 Widget 5 

 

 Widget 6 

Example 2. 

 
Tree structure: 

 Root 

 Group 1 (vertical) 

 

 Group 2 (horizontal) 

 Widget 1 

 

 Widget 2 

 Group 3 (horizontal) 

 



 Group 4 (vertical) 

 

 Group 5 (horizontal) 

 Widget 3 

 

 Widget 4 

 

 Widget 6 

 Widget 5 

Example 3. 

 
Tree structure: 

 Root 

 Widget 1 

 Group 1 (vertical) 

 Widget 2 

 Group 2 (horizontal) 

 Widget 3 

 

 Widget 4 

 Group 3 (horizontal) 

 

 Widget 5 

 Widget 6 

 Widget 7 

Service functions 

Description of additional functionality available throughout the application. 



Importing analysis data from CAT 
tools 

Overview 

SDL Trados Business Manager supports the importing of analysis reports which have been 

generated from different CAT tools into quotes, projects and jobs. This section describes the 

workflow and the possibilities provided by this feature. 

During quote, translation project and translation job creation you can fill items (tasks) 

manually, or use the Analysis report importer tool to quickly fill an entity from a report 

generated by a supported CAT tool. 

SDL Trados Business Manager will try to load as much data as possible and in the ideal case it 

won't be necessary to manually edit any fields. 

The CAT tool importer has a few modes: Analysis file, Trados direct and MemoQ direct. To 

open it, use the Import data from CAT tools buttons while editing one of the supported entities: 

 

Analysis file 

When this option is selected, you will see the following popup window: 

 



In this window, please select the required CAT tool, the path to the analysis file, and click 

OK. The default analysis report importing results window will be opened: 

 

When you import analysis data into translation project, behavior could be slightly different 

comparing to translation jobs and quotes. Analysis report could contain values for multiple 

language pairs. In this case, during analysis import, you can specify language pair for each value 

(or it could be determined automatically, if analysis report contains such information). Then, 

when data is being imported, TBM will create or correct translation jobs which belong to a 

current translation project. If job with corresponding language pair isn't found, it will be 

automatically created. 

The main option in this window is the Analysis import settings. It's a reference to settings 

which control the import process (which units will be imported, should unit conversion be 

applied, should the system import all fuzzy types or only the average volume, etc.). See the 

separate article describing analysis import settings. 

Erase existing tasks checkbox allows to force deletion of existing items in a job when 

importing analysis results. However, if particular task in a job was already assigned to any 

vendor, it won't be deleted anyway. 

The analysis table contains all information about volumes in an imported analysis file. The 

main column here is the Target fuzzy type. Since different CAT tools use different codes for 

fuzzy types TBM may not correctly determine the matching fuzzy types. If you see empty values 

in this column, please manually select the matching fuzzy types. 

The Language column specifies the language pair. When the analysis report is being imported 

into the translation project, the value in this field specifies a job where it will be imported. 

Since the translation job may only have one language pair, and if the imported analysis report 



contains information about different target languages, TBM can import the data into separate 

jobs. 

When you are ready, just click OK, and the analysis data will be transferred into a base entity 

(quote, job or project). TBM will automatically pick-up the prices and calculate the amounts. 

Trados direct 

When this option is selected, the following window will be opened: 

 

TBM will read the projects.xml file and display its contents here. You will then need to select a 

project, and TBM will automatically read the analysis report of the selected project, and open 

the analysis results window described in the Analysis file section of this document. 

In addition to the default data, TBM can read the following data from SDL Trados Studio: 

 Creation date 

 Deadline 

 Job name 

 Language direction 

 Path to the source files 

 

MemoQ direct 

When this option is selected, a window with MemoQ projects will be opened. You will then 

need to select a project, and TBM will automatically read the analysis report of a selected 

project, and open the analysis results window described in an Analysis file section of this 

document. 

In addition to the default data TBM can read the following data from memoQ: 



 Creation date 

 Deadline 

 Job name 

 Specialization 

 Path to source files 

Mail sender 

SDL Trados Business Manager allows to sent e-mail right from with the program. 

This feature is used in the following cases: 

 to send generated invoices to your clients 

 to send payment reminders to your clients 

 to send invitations to contractors 

 to send suggestions to developer 

To be able to send e-mails, it is needed to setup mailbox properties. You may use a many 

mailboxes as needed. 

1. Go to Reference data > E-mail accounts. 

2. Create new account by clicking New. 

3. Fill-in the opened form with your e-mail settings. 

Here you provide sender name (what recipient will see in the From field), e-mail 

address, login (which is usually the same as e-mail address, password, SMTP server and 

port). 

4. Optionally, mark Require SSL check-box. 

You may get detailed information about these settings from your e-mail provider. Also, e-mail 

account editing form contains a hint with default settings for the most famous providers. 

Composing messages 

Try to send test message. Click Mail sender from the Tools tab of the ribbon. Click New to 

create a new message. Message composing window appears: 



 

At the top you select E-mail account to use to send a message (default e-mail account 

automatically selected for new messages). Date represents a moment of a message creation. It 

is assigned automatically, but you can change it when needed. Message sent selector shows 

sending status of the message. After sending, it will be automatically changed to Sent. 

In the Subject field you specify conventional message subject. 

Require read notification flag allows to add read confirmation to a message. However, not all 

e-mail clients support this feature. In addition, message recipient can deny sending 

confirmation, so it may happen that you would not get it anyway. More to say, including of read 

notification request into your message may be negatively perceived by a recipient, as it does 

not seem to be a good tone in mail conversations. 

The rest of space is occupied by the message editing box. Formatting toolbar contains a set of 

buttons provided by any modern text editor. 

SDL Trados Business Manager has extensive mechanism of message templates and 

variables. To apply one of message templates, click Apply template text on the ribbon and 

select a template. 

To create a new template, go to Reference data > Message templates and create a new 

template. Or click Save as a template button on the ribbon to save current message as a 

template. Template creation process from the reference data table is similar to message 

composing, so it doe not require additional description. 

Composing messages - Variables 

When you create a new mail message or message template, you can use variables in a message 

text and subject line. 



To insert variable, use Insert variable button on the ribbon. 

 

Then select desired variable from the drop-down list. Recipient first and last names are 

common variables. Other groups contain variables specific for a corresponding documents, 

which are used depending on a current task. For example, if you create a message or a template 

for purchase orders or translation offers, use variables from the Translation 

assignment group. 

Here is the list of the currently supported variables: 

Section  
Variables 

Recipient 

Recipient first name 

Recipient last name 

Recipient title 

Login to web-portal 

RecipientPassword 

Invoice 

Number 

Date 

Term 

Full amount 

Due amount 

Currency name 

Currency symbol 

Translation job 
Number 

Date 



Deadline 

PO number 

Job name 

Weighted volume 

Specialization 

Amount 

Currency 

Language pair 

Services (list of comma-separated services from the Job tasks table) 

Instructions (support formatting) 

Customer name 

JobURL (requires to fill Web-app option in the application settings) 

Translation project 

ProjectNumber 

ProjectDate 

ProjectTerm 

ProjectCustomer 

ProjectCustomerContact 

ProjectName 

ProjectSpecialization 

ProjectPO 

ProjectSourceLanguage 

ProjectSourceLanguageCode 

ProjectTargetLanguages (list of comma separated names of target languages) 

ProjectTargetLanguageCodes (list of comma separated codes of target languages) 

ProjectTotalAmount 

ProjectTotalAmountCurrency 

ProjectAverageVolume 

ProjectURL (requires to fill Web-app option in the application settings) 

Translation 

assignment 

Number 

Date 



Deadline 

Deadline in local vendor's time zone 

PO number 

Job name 

Weighted volume 

Specialization 

Language pair 

Services (list of comma-separated services from the Job tasks table) 

Amount 

Amount offered to a vendor 

Currency 

Instructions (support formatting) 

URL-address (allows to insert a link to a web-page with details/files of an assignment; 

to SDL Trados Business Manager Team Online version; web-portal address must be specified in the application 

Settings, in the Web-app URL field) 

AssignmentVendorPickNotes 

AssignmentNotesFromVendor 

AssignmentVendor 

AssignmentStatus 

Quote 

QuoteDate 

QuoteDueDate 

QuoteDeliveryTerms 

QuoteJobName 

QuoteAmount 

QuoteCurrency 

QuotePaymentPolicy 

QuoteItemsInfo 

QuoteCreatedBy 



QuoteDocumentNumber 

QuoteURL (requires to fill Web-app option in the application settings) 

QuoteLastMessageFromCustomer 

User's data 

First name 

Last name 

Company name 

Address 

E-mail 

Phone 

Web-page 

Web-portal 

Skype 

ProZ profile 

Twitter profile 

Facebook profile 

LinkedIn profile 

Customer 

CustomerName 

CustomerCode 

CustomerVAT 

CustomerAddress 

CustomerCountry 

Incoming invoice 

InvoiceInNumber 

InvoiceInDate 

InvoiceInTerm 

InvoiceInAmount 

InvoiceInNumberOfAssignments 

Test piece 
TestPieceName 

TestPieceLanguage 

TestPieceSpecialization 



TestPieceSourceText 

TestPieceTargetText 

TestPieceComments 

TestPieceScore 

TestPieceReferenceNumber 

Sender's data (user or 

responsible person) 

First name 

Last name 

E-mail 

No category 

List of attached files 

AdditionalText - this variable is used in one case - when you send single confirmation message to multiple vendors 

working in different language pairs; this variable is replaced by a list of vendors, languages, services

Composing messages - Recipients 
tab 

Here you specify message recipients. 

 

E-mail message will be sent as many times as a number of recipients. This allows to use 

variables in the message text. In the example image shown 

above, {RecipientFirstName} variable will be replaced by Sam in the first message, and 

by Barbara in the second. 

CC and BCC fields allows to send message copies to the specified addresses. 

To add recipients faster, you may use Add recipient from contractors list and Add recipient 

from client contract list buttons on the ribbon. These buttons open list of contractors and list 

of customer contacts, correspondingly. To quickly find necessary contacts in these lists, you 

may use default filtering and searching functionality. Select one or multiple contacts and 

click OK. Selected contacts will be added to the Recipients list. 



Composing messages - External 
attachments and Internal 
attachments 

SDL Trados Business Manager allows to attach files to messages. 

Mail sender window provides two ways to attach files: Internal attachments and External 

attachments. Files which are added on the Internal attachments tab will be stored inside 

database. Files from the External attachments tab are stored on your hard drive, so only file 

paths are saved. This means that if you delete or move file on hard drive, Mail sender won’t be 

able to send it anymore. In many cases, when you create a message from other entity (for 

example, from invoice or from translation assignment), file attachments will already be 

populated. 

Mail sender can automatically upload large files to cloud drives and insert links to these files 

into a message body. To enable this feature select necessary options in the application settings 

(see Mail sender settings). Then, insert {FileLinks} variable into the message text: 

 

If your message has attached files with size larger than minimum size (specified in the 

application settings), then such files will be automatically uploaded to a cloud drive when you 

press Send button, and {FileLinks} variable will be replaced by Links header text (also specified 

in the application settings), followed by links to uploaded files (each link starts with new line). 

If a message has no files uploaded to a cloud drive, then this variable will be replaces by empty 

string, so it won’t appear in the final message text. 



 

Composing messages - Linked 
documents 

 

SDL Trados Business Manager allows to send invoices, payment reminders, job offers, purchase 

orders, etc. 

In junction with message templates and support of variables, it is possible to include dynamic 

data in the message text, which will be replaced by actual data from a linked document. When 

you send purchase order, this data must come from a corresponding translation assignment. 

When you send payment reminder - data are gathered from unpaid invoice. On the Linked 

documents tab you specify base documents (invoice, job, assignment) to get data for variables. 

In most cases, necessary document will be pre-filled. For example, in the invoice print preview 

window there is a Send invoice via Business Manager button - when this button is pressed, a 

new e-mail message window opens with the corresponding invoice selected. In the translation 

assignment editing form there is a Send offer button, which allows to send e-mail message to a 

selected contractor. Again, when that button is clicked, corresponding translation assignment 

will be pre-selected. 

Note: When you have variables in the message text, check that corresponding document is 

selected on the Linked documents tab before sending a message. Otherwise, that variables 

would not be replaced by actual text. 

Message previewing 

To see how used variables work, you can preview a message by selecting Preview final 

message button on the ribbon. A popup window will be shown with generated message for 

each recipient where all variables are replaced by their actual values. 

Scroll this window to view all messages and confirm that they look as expected. 



 

Message sending 

To send prepared message, click Save button. Until then, sending button will be unavailable. 

Then click Send. 

You can also send messages from the message list. Here you can select multiple messages and 

send them in a batch. After few seconds, you will see a window with the operation results. If 

there is any error. 

 

After successful sending, message status will be changed to Sent. 

If any invoice is selected in the Linked documents tab, then status of this invoice will be 

changed to Sent. 

Working with files 

Overview 

SDL Trados Business Manager allows to attach files to the following entities: 

 Customers 

 Contractors 

 Translation projects 

 Translation jobs 

 Translation assignments 

 Invoices (one file containing generated invoice) 



 Quotes (one file containing generated quote) 

 Mail messages 

Attachment means that the file is stored inside SDL Trados Business Manager database. 

Optionally, files can be inserted as links to Dropbox, Google Drive or Microsoft OneDrive. When 

source file is deleted or moved from HDD, attachments will stay available in SDL Trados 

Business Manager until deleted from a database (except files linked with cloud drives). 

You can view all files attached to all entities by selecting Other/Tools > Manage file 

attachments from the navigation tree. 

 

This list contains all files attached to all entities. You can view file names, dates of creation, file 

types, file sizes, and a number of entities which particular file belongs to (Attached to column). 

In addition, there is an Icon column, which allows to distinguish files stored in the database 

and on cloud drive (also, cloud drive files has blue background in the list). As in other 

lists SDL Trados Business Manager, you can sort, filter and group this list to efficiently manage 

your files. 

To view any file in a corresponding application, select this file in list and click Open. Default 

application linked with selected file type will be launched for viewing it. 

To save selected files on disk, select one or multiple files and click Save as.... 

To save/download selected files in a single archive, select one or multiple files and 

click Download as zip file. This function is particularly useful in web-version. 

Note. When you use Download as zip file function for cloud drive files (Dropbox, OneDrive, 

Google Drive), you will see Loading window showing a name of a file currently being 

downloaded. When all files will be downloaded, you will be able to select a destination where 

to save zip file. In web-version, downloading of files linked with cloud drive may take longer, 

since it is needed to initially download them from cloud drive to a server, and then allow 

current user to download zip file on his/her computer. 



Note. When you send files linked with cloud drives by e-mail, or create a project in a CAT tool 

using these files, the system will download them to your computer (or server, in case of web-

version), perform required action and delete files from memory. 

You can delete any selected file, and it will be removed from entities where this files is attached 

to. 

You can also double click on any row to edit file properties (for example, to change file type or 

date of creation) and to view all entities where particular file is used. 

While Manage file attachments screen is used for general management of attached files, 

actually you add file to database from individual entities, in a process of their creation. The 

process is the same for all entities, and below you can find an example screenshot of file 

attachments in translation job editing form: 

Specifics of file management in quotes, translation 
projects, translation jobs and translation assignments 

Mentioned entities allows to store files not only inside database, but on hard drive as well. To 

control this, there is a special tab in the application settings called Files and folders, where you 

specify folder name patterns, used to determine folder names and their structure for each type 

of entity. Then, when you fill data in the editing form, this data is used to determine folder 

name, which is reflected in the Folder field (Folder with job files on the screenshot below) of 

the Files tab (this tab is available in any editing form of mentioned entities: quotes, projects, 

jobs and assignments): 

 

Actual folder on the hard drive won’t be created until you click Create and open folder ( ) 

or Create and do not open folder ( ) button. Such approach is used because folder name is 

specified by a pattern which supports variables (for example, folder name may include 

customer code, source language name, etc.), and value in the Folder field will be changed each 

time you change value in one of fields which variables are used in a pattern. If you wish to fix 

currently determined folder and prevent from automatic detection, check Fix folder name box 

on the right. When this box is checked, you can click Refresh button in the Folder field to force 



folder detection mechanism to determine folder name according a pattern specified in the 

application settings. 

To manually select work folder, click three dots icon in the Folder field. 

List of files below Folder field displays all files of a current entity, both stored on hard drive 

and internally in a database. Icon column displays file icon (if it’s stored on hard 

drive). Date field displays date of last modification (for files on hard drive) or date of adding a 

file to a database. Storage source displays one of the following values: Hard drive (file is stored 

on hard drive), Internal attachment (file is stored in a database), Dropbox, Google 

Drive or Microsoft OneDrive (file is stored in a cloud drive). File size displays size of file in 

kilobytes (for cloud files,  value is zero, as SDL Trados Business Manager doesn’t retrieve this 

information). File type allows to specify ‘intended use’ of file. To quickly change file type, select 

necessary files and click Select file type button on the toolbar: 

 

Select desired file type from the drop-down list, or select Create a new file type…, if necessary 

file type is still missing in the database (to manage file types, go to Reference data > File 

types). Also, you can select Clear values to erase file type values for the selected files. 

All other buttons in this list are the same as in default file attachments list: 

 Creates and new file stored in a database based on file selected from hard drive. You can 

also drag and drop a file from Windows Explorer to attach it to a database. 

 If file is already in the database, allows to add a link to it, so it becomes a part of a 

current entity (and may belong to other entities as well). 

 Removes link to a file but doesn’t delete it from database (file could be linked to other 

entities). 



 Link with Dropbox, Link with Google Drive, Link with OneDrive. Adds a file from a cloud 

storage. 

 Open (only in desktop version). Opens selected file in default application. 

 Download as zip. Downloads selected files in a single zip archive. 

 Download (only in web-version). Allows to download selected file. 

 Delete. Deletes a file from a database. 

In translation jobs, list of files could include not only files from a job's folder and files attached 

to a job, but also files from linked translation assignments. For example, if some vendor 

delivers an assignment, you will see delivered files right here, in a corresponding group, 

without need to open corresponding assignment to find that file. 

Buttons explanation 

Button name Description 

 New Opens an editing form for creating a new file. 

 Add from file Allows to add a new file by directly selecting a file on disk, without opening new file dialog.

 Link with Dropbox 

Displays a popup window to select file(s) stored in your Dropbox account and add them as links 

into Business Manager database. This allows to save space. To make this function working, you 

have to connect to Dropbox account first. To do this, open program Settings an

to Dropbox. 

 Link with Google Drive 

Displays a popup window to select file(s) stored in your Google Drive account and add them as 

links into Business Manager database. This allows to save space. To make this function working, 

you have to connect to Google Drive account first. To do this, open program Settings and 

click Connect to Google Drive. 

 Link with OneDrive 

Displays a popup window to select file(s) stored in your OneDrive account and add them as links 

into Business Manager database. This allows to save space. To make this function working, you 

have to connect to OneDrive account first. To do this, open program Settings and click

to Microsoft OneDrive. 

 Save as Saves selected files on disk. 



 Link 
If a file which you're going to attach is already exists in Business Manager

button and select desired file to add to to a current entity. 

 Unlink 
Allows to remove selected file from a current entity, but don't delete it from databas

example, if this file is used in another entity or when it is needed to leave it for future use).

 Delete Deletes selected files from database and from all entities where it is attached to.

 Download as zip file 
Allows to archive selected files and save them on disk in a single file.

This button becomes disabled if security role of a current user restricts access to a selected file.

 Open Allows to view a file in default system application. 

File attachment dialog 

When you create mail messages from different entities (quotes, projects, jobs, assignments, 

invoices, etc.), file attachments dialog could appear: 

 

In this dialog, you can select files which you wish to attach to a created message. 

List of files is a table grouped by a file type. Group name specifies storage place of files in that 

group. In example above, user creates a message from translation project, and system has 

found files in the following locations: 

 Attached project files 

 Files from a folder on HDD linked with this project 

 Files from 'Packages' folder determined from a SDL Trados Studio project linked with 

this project 

 Files from one translation assignment created under this project 



In other words, Business Manager tries to find all possible files from a current entities and 

entities which are linked with a current entity. 

If you don't want to attach any files to a create message, simple click Cancel in this dialog. 

If you wish to attach one or multiple files from a list, select them by 

holding Ctrl or Shift buttons (checkboxes in web-version), and click OK. Selected files will be 

attached to a created message. 

If one or multiple selected files are stored in HDD, then you can check As internal 

attachment checkbox. In this case, Business Manager will import files into a database, and 

attach them as internal attachment. This means that attachments won't be linked with files on 

HDD, and will be available to all users who connect to a current database (in case of network 

usage). 

If you check External files as internal zip file, all files from HDD will be packed into ZIP file and 

added as internal attachment (stored inside database) to a created message. 

Source for attaching SDL Trados Studio project files option allows to control which files will 

be listed in the Attached files table if a source entity (quote, project, job) is linked with Studio 

project. By default, it's value is Packages, which means that the system will offer to attach only 

package files from a project folder. If you change this value to Language files or Both 

packages and language files, then you will also see all sdlxliff files from all language folders, as 

on the following example: 

 

Notifications 

Notifications module in SDL Trados Business Manager allows to create custom notifications 

shown at certain time. 



Each notification can linked with some data, which means that you will be able to navigate to 

specified entity at the moment of showing notification. Also, you can select an application user 

to show notification to. 

1. To start, open Notifications view from the Other/tools section in the navigation tree. 

 
2. You will see the list of active notifications. Here you can create new notifications or 

clone existing ones. In the notification editing view, you can specify reminder time, 

reminder text, target user, and select linked data: 

 

When User field is empty, notification will be shown to all users. Otherwise, it will be shown 

only to a specified user. If, for example, you wish to show notification to a number of selected 

users, clone it from the list of notifications, creating individual entry for each user. This is 

required, because each user may react differently on reminder: dismiss it or snooze. Or it may 

be needed to show the same notification, but in different times. 

To select linked data, select data type first, and then select corresponding data (particular 

invoice for Invoice data type, job for Translation job data type, etc.). 

Notification reminder window looks as following: 

 

You can Snooze notification (postpone for a specified time period, from 5 minutes to 2 

weeks), Dismiss it (delete from the notifications list), or double click on the message text to 

show linked data. On the screenshot above, notification is linked with translation job. Double 

clicking on it will lead to opening of the job editing form in a separate tab. 

Quick notification creation 



You can quickly create a notifications from the following views (applies both to list and detail 

views): translation project, translation job, translation assignment, invoice, invoice incoming, 

payment incoming, payment outgoing. 

 Select necessary row in the list or open any detail view, and select Create 

notification on the ribbon. 

 A new notification creation window will be opened. It will already be linked with 

currently selected record, and alarm time will be set to a current time plus 3 days. In 

addition, new notification will be set to show only to a currently logged-in user. 

 You can just provide notification message and select Save and close (Ctrl-Enter) to 

create a new notification. If needed, you can edit other fields as well: select another user 

or adjust alarm time. 

Automatic event notifications 

SDL Trados Business Manager allows to send notifications to specified users when some event 

occurs (for example, a customer creates a quote request or accepts a quote, a vendor registers 

on a portal or delivers an assignment, adds an invoice, makes changes in own profile, etc.). 

There is a particular set of events defined (which expands with time), which will be described 

in this document. For each of such notifications, a separate message template is defined in 

the Reference data > Message templates table. TBM is supplied with some default texts for 

such notifications, which you can freely edit, turn off or delete. 

To completely disable particular type of notification described below, you can simply disable or 

delete particular message template. When TBM can't find enable message template for some 

event type, corresponding notifications won't be sent. 

Setting-up notifications 

Users could receive notifications via 2 channels: by e-mail or in-app. If meaning of e-mail 

channel is clear, then in-app channel means that notification will be displayed to a user after 

logging on into the application (via desktop application, online application, customer or vendor 

portal). If user is already logged on, notification will be displayed to that user in 5-minutes 

period (this means that user could see a notification in a few seconds or few minutes after 

notification has been created). 



To control how users receive notifications, go to Other/tools > Users, and select necessary 

user to open its editing form. Then, switch to the Notifications tab: 

 

Receive notifications checkbox. It has effect only for internal users (users who are 

NOT vendors or customers). If this checkbox is unchecked, this user will never receive any 

notifications. The exclusion is when this user is responsible person for some quote/project/job, 

and customer triggers some event which requires notifying of responsible person (for example, 

customer accepts a quote). 

Vendors and customers will always receive notification regardless of this setting. 

Notification method allows to choose a channel how to send notifications to a particular user. 

To make E-mail method working, two prerequisites must be implemented: 

 E-mail filed must be filled for a user 

 Under Reference data > Email accounts table, a default e-mail account must be 

configured and tested 

Only get notifications from the following users table allows to limit automated notifications 

to be send to a current user to a set of specified "source" users who generate a notification. For 

example, if some manager must receive quote requests only from customer A, then you have to 

add all users linked with that customer to this table. 

List of users who get notifications is specified by Send notifications checkbox in the User 

editing form. For each user you can also specify a list of vendors, whose actions will generate 

notifications to a particular user. 

After setting up list of users who receive notifications, create a user with Vendor or Customer 

role to allow them to log in into your portal. When one of supported actions will be performed 

by such users, each user eligible for receiving notifications will see popup notification window 



(both in Windows and Web versions) and a yellow 'bell' icon with a number of unread 

notifications will appear at status bar. 

Default notifications 

The following table describes all events which could occur in TBM, corresponding message 

template used for that event, and default recipients. 

Event name 
Default message template 

type 
Default recipients Notes 

Automation rule 

failed to apply 

Automated notification - 

automation rule failed to 

apply to an assignment 

Responsible person or all 

managers, if responsible 

person is empty. 

See Automation rules topic to get additional information 

about automation rules 

Automation rule is 

ready to be 

applied 

Automated notification - 

automation rule is ready 

to be applied 

--//-- 
If automation rule behavior is set to not 

assign next vendor in a sequence

Automation rule 

successfully 

applied 

Automated notification - 

automation rule 

successfully applied 

--//--  

Customer 

accepted a quote 

request 

Automated notification - 

customer accepted a 

quote 

Responsible person or all 

managers, if responsible 

person is empty. 

 

Customer created 

a new job 

Automated notification - 

customer created a new 

job 

--//-- 
When customer creates a new job directly from the 

dashboard, skipping quote request phase

Customer created 

a new project 

Automated notification - 

customer created a new 

project 

--//--  

Customer created 

a quote request 

Automated notification - 

customer created a quote 

request 

--//--  



Event name 
Default message template 

type 
Default recipients Notes 

Customer 

declined a quote 

request 

Automated notification - 

customer declined a 

quote 

--//-- 
Variable for displaying declining reason provided by a 

customer: {QuoteLastMessageFromCustomer}

Customer profile 

changes 

Automated notification - 

customer edited own 

profile 

--//--  

Quote is ready 
Automated notification - 

quote ready 

To customer contact (if e-

mail is provided); if contact 

is empty, to a customer user 

who initially created a quote 

request; if initial user is 

empty, to all customer's 

users. 

 

Project is 

ready/delivered 
Project delivery 

To customer contact (if e-

mail is provided); if contact 

is empty, to a customer user 

who initially created a quote 

request; if initial user is 

empty, to all customer's 

users. 

Disabled by default, and will be sent only if Web

is specified in the application settings

Job is 

ready/delivered 
Job delivery 

To customer contact (if e-

mail is provided); if contact 

is empty, to a customer user 

who initially created a quote 

request; if initial user is 

empty, to all customer's 

users. 

Disabled by default, and will 

is specified in the application settings

Message added to 

a job 

Automated notification - 

message added to a job 

To customer contact person 

user (if send to customer), or 

to responsible person or all 

Variable for displaying message 

contents: {AdditionalText}. 



Event name 
Default message template 

type 
Default recipients Notes 

managers if responsible 

person is empty (if sent by 

customer) 

Message added to 

a project 

Automated notification - 

message added to a 

project 

--//--  

Message added to 

a quote 

Automated notification - 

message added to a quote 
--//--  

Vendor registered 
Automated notification - 

new vendor registered 
To all managers  

Vendor 

registration 

confirmation 

Automated notification - 

vendor registration 

confirmation 

To a registered vendor 
This is the only message which contains initial users's 

password ({RecipientPassword}

Vendor profile 

changes 

Automated notification - 

vendor edited own profile 
To all managers  

Vendor profile 

changes request 

Automated notification - 

vendor requests to edit 

own profile 

To all managers 

Used when direct changes in a profile are restricted by 

security system. Variable that holds explanation of des

changes provided by a user: {AdditionalText}

Vendor accepted 

an assignment 

Automated notification - 

vendor accepted an 

assignment 

Responsible person or all 

managers, if responsible 

person is empty. 

 

Vendor declined 

an assignment 

Automated notification - 

vendor declined an 

assignment 

--//-- 
Variable to display declining 

reason: {AssignmentVendorPickNotes}



Event name 
Default message template 

type 
Default recipients Notes 

Vendor sent 

counter-offer for 

an assignment 

Automated notification - 

vendor counter-offer for 

an assignment 

--//-- 
Variable to display counter-

offer: {AssignmentVendorPickNotes}

Vendor delivered 

an assignment 

Automated notification - 

vendor delivered an 

assignment 

--//-- 
Variable to display delivery 

notes: {AssignmentNotesFromVendor}

Vendor created an 

invoice 

Automated notification - 

vendor created an invoice 
To all managers  

Vendor edited an 

invoice 

Automated notification - 

vendor edited an invoice 
To all managers  

Vendor submitted 

test piece 

Automated notification - 

vendor submitted a test 

piece 

To all managers  

Test piece marked 

as finished 

Automated notification - 

test piece results to 

vendor 

To a vendor  

Vendor assigned 

to work 
Purchase order To a vendor 

If assignment has PO attached, this file will be 

automatically attached to a created message.

Audit trail 

By default, audit trail in SDL Trados Business Manager is turned on for 2 types of 

data: Customers and Vendors. Additionally, in the application settings you can enable it for 

other entity types. Since audit trail records a lot of information about changes made into 

entities, please enable this feature only for where it is required. 

When any user make any change in these types of data, audit trail system logs these changes 

and saves for future viewing. This allows to track how data of particular customer or 



contractor was changed, which user made that changes and which fields were affected. Old 

values and new values of each field are stored, so you can view full history of data change. 

1. To view audit trail log, open any customer or contractor and switch to the Audit 

trail tab. 

 
2. To view detailed information about data change, double click on any row. As you see, in 

this operation Admin user changed default price on 17-apr-2018 by setting it to 0.09 

USD for Translation work type. This mechanism is especially useful when Business 

Manager is used in network mode with many users. In particular, when external vendor 

has access to web-portal and changes own data, administrator may open audit trail, 

filter a list by user assigned to that vendor, and view what changes were made. 

 

As you see, in this operation Admin user changed default price on 17-apr-2018 by setting it to 

0.09 USD for Translation work type. 

This mechanism is especially useful when Business Manager is used in network mode with 

many users. In particular, when external vendor has access to web-portal and changes own 

data, administrator may open audit trail, filter a list by user assigned to that vendor, and view 

what changes were made. 

Global audit trail book 

You can view all entries created by the audit trail system in one screen. For this, 

select Other/tools > Global Audit trail book. It may look as this: 

 



The table contains few fields, which allow to determine what kind of change it registered, when 

and which user initiated this change. Double clicking on any row allow to view full details 

about change. 

If you wish to search by certain entity, open filter menu for the Description column, switch to 

he Text filters tab, select Contains operator and enter search value, as shown on the following 

screenshot: 

 
Depending on searched entity, you may need to enter document number, vendor or customer 

name, etc. 

Workload planner 

The idea behind Workload planner is to get a clear picture of the current jobs and to get help 

with decisions about incoming offers. 

With one task for the day, that's easy to remember what is planned to do, but with 5-10 

ongoing jobs it becomes easy to get lost. This planner is intended to help in such situations. 

To turn the planner on, please open program Settings, switch to Productivity settings, and 

mark Turn on workload planner check-box. In the same settings group, specify your daily 

capacity and preferred job allocation method (Earliest delivery, Latest delivery or Evenly). 

After that, when any new job will be created or any old job will be re-saved, the program will 

try to allocate it through days from the job day until job deadline using specified allocation 

method. Weekend days will be left free. 

To see how allocation was done, switch to the Workload planner tab in the job editing 

window. It contains very simple table with information about planned working days and 

volume assigned for each day. 

 



You can make any corrections in this table to adjust automatic results. In this case, 

mark Manual allocation check-box to prevent overriding your changes when the job will be 

saved. 

Above the table you can see weighted volume of the job being edited. This value is calculated 

from the job details table by applying adjustment factors of each used unit. When making 

manual changes in this table, it is recommended to control equity of table amount and 

weighted volume. 

To open main Workload planner window, select Other/tools section in the navigation tree 

and then select Workload planner item. 

Optionally, use Radial menu to quickly open Workload planner. 

 

Example of the Workload planner window: 

 

When the planner is opened, a default time period will be preselected (see Planner 

parameters in the top right corner). Usually it includes few previous days from today and 

nearest two weeks. Also, parameters group contain Show labels on the chart checkbox, which 

allows to turn labels off and on. The chart contains a lot of jobs and a lot of labels, 

correspondingly. Turning labels off allows to make the picture clearer, while you still can get 

additional details by hovering mouse arrow over necessary job. 



Main pane consists of a bar chart, where X axis contains days, and Y axis represents volumes. 

Each day may include any number of jobs (colorized rectangles). Top red line represents 

maximum day capacity. Of course, our goal is to avoid exceeding this line and appearing of jobs 

on weekends. 

Hover mouse pointer on any bar to see detailed information about the job, which includes job 

volume and deadline. Double click on a job to get full information about it in the Selected job 

details panel. In this panel, the following information is displayed: job number, date, deadline, 

client and volume. Below them, two additional numbers are displayed (unassigned volume of 

the selected job and remained capacity for the selected day), followed by the job allocation 

table, which is similar to that in the job editing form. You can make any manual adjustments in 

this table, and they will be immediately saved in the database. When any manual change is 

made here, Manual allocation check-box will be set automatically for the job being edited. 

If you make any external changes (add or edit any job from the dashboard or job list), 

click Refresh on the ribbon to displayed refreshed data. 

When any job is selected (by double click), you can use the buttons from the Selected job 

actions group on the ribbon. 

Here you can open job editing form and use one of seven buttons to automatically re-allocate 

the selected job. 

For example, you had a job to translate 4000 words, which lasts from 10th to 12th day of a 

month, which means that you have 3 days to complete it. If Earliest delivery method is used 

and day capacity is 2500 words, than the program will place 2500 words to 10th day and 1500 

words to 11th day. Say, a new urgent job arrives (700 words), which must be started and 

delivered on 10th day. After adding this job, planned volume for the 10th day will become 3200 

words (2500 + 700): 

 



But we can easily see that the first job can be re-allocated and shifted to later days. Simply 

select it and select Try move to earliest delivery (no weekends) on the ribbon. Since we 

have free slots in the next days, this job can be re-allocated. 

 

As 12th day is still free, you can easily see that on 11th and 12th days you can translate about 

2800 new words without exceeding default daily capacity. 

When Try move to the specified period is clicked, you will be able to manually set time 

period when plan to work on the selected job. If possible, the program will place this job 

explicitly to these days. 

You may add exceptions, which will be taken into account when the system will automatically 

allocate jobs. To do this, select Manage exception days in the Workload planner view. You 

will see simple list containing two columns: Day and Volume. If you are fully unavailable on 

certain day, add it and set volume to zero. If you are partially unavailable, enter average value 

which you can process on that day. 

Scheduler 

SDL Trados Business Manager has an internal scheduler, which allows top plan work time, set 

reminders, view tasks in the timeline manner, where jobs are split between customers. 

In addition to manual creation of events, it is possible to create them automatically for each job. 

When a new job is created or existing job is edited, than corresponding event in the scheduler 

is created or parched, accordingly. The default look of the scheduler (date range selector on the 

right is in Russian here, but it will be displayed in your own language - this depends on 

computer settings): 

The way of working with the scheduler is similar to any other calendar. 



 

You can create events in a few ways: by selecting New appointment on the ribbon or by 

selecting necessary time interval, and then right-clicking on it and selecting New appointment. 

One difference comparing to default calendars is possibility to select Resource for each event. 

Here you can select resource, or customer, in other words, by clicking Link button 

above Resources table: 

 

When a customer is selected, than event is linked with the customer. In month, week or day 

view it has no difference, but on the timeline view the situation changes: 

 

Here you can see that during viewable period translator worked on the projects for five 

different customers. The number of displayed rows depends on the number of customers with 

job in the selected period. 

In addition to internal scheduler, Business Manager supports synchronization with Google 

Calendar. To enable it, go to Settings and mark corresponding option. In this case, together 

with event creation for the job in the internal scheduler, Business Manager will create the same 

event in Google Calendar. 

Favorites 



SDL Trados Business Manager allows to add any detail view (object editing form) to favorites to be 

able to quickly return to particular entry at any time later. 

Each entry in the Favorites table may have a comment and a category assigned. Comment allows to 

provide some reminder or text explaining why this favorite was created. 

Favorites button is available on any screen from the main menu. 

 

And the same in web-version: 

r 

If any category has been assigned to a favorite, it will be displayed in a nested folder (as on 

screenshot). 

If a favorite has a comment, this comment will be displayed in the list of favorites after its name. 

Because of this, try to avoid using long comments. 

To add any object to the favorites list: 

1. Click Favorites - Add current view to favorites.... If you are viewing list (table) view, you 

will get a message about impossibility to create a favorite. Otherwise, the following dialog 



will appear: 

 

2. Enter/correct necessary data. 

3. Click OK. New favorite will be created and added to the menu. 

To delete/edit favorites, select Favorites - Manage favorites. List of favorites will appear. From 

here, you can delete necessary favorites or edit them (for example, edit comment or category). 

Forms customization 

In most cases you add/edit data in SDL Trados Business Manager using data entry forms. 

Each editing form in Business Manager supports customization. To enter customization mode, right 

click on empty space on the form and select Customize layout. 

You will be switched into customization mode: 

 

Form elements will be grayed, with borders painted around them, and Customization window will 

be opened. In the editing mode, you can freely move any element you see on the form. During 

dragging, guiding lines and rectangles will be painted to show where dropped element will be placed. 

To hide any field from the form, drag it to the Customization window (cross icon will appear during 

dragging). If it will be needed to display hidden field later, you will find it in the 

same Customization window, in the Hidden items tab. 



The whole structure of the current form can be found in the Layout tree view of the Customization 

window. Here you can do the following actions: 

 Rename fields. Right click on any field and select Rename. 

 Make new groups of fields. Select few fields, right click and select Group or Create tabbed 

group. 

 Ungroup existing groups by selecting a group, right clicking on it and selecting Ungroup. 

Sometimes Business Manager developers change default layout of different forms. If you use 

customized forms, you would not see those changes. Please, carefully read change log, and if you see 

information about new fields in particular form, then you will be able to see those new fields only 

after manually dragging them into your form from the Hidden items section of the Customization 

window. Another way to get latest changes is to reset customizations. To do this, click Reset view 

settings button on the ribbon. 

Import data from TO3000 

SDL Trados Business Manager allows you to import data from Translation Office 3000 

software. Currently the system supports data import from two versions of TO3000: 11 (latest 

release) and 3D. The process is almost automated, but may require few manual steps. 

Before you begin 

Before starting with importing, it is recommended to create necessary work types and 

languages. In TO3000, you have services, which combine work types and a language 

combination. Because of this, SDL Trados Business Manager cannot fully correctly link services 

with internal work types and languages. 

When this is done, click Data transfer button in the Tools tab of the ribbon and select Import 

TO3000 data: 

 

To begin loading data, click Open database file. It will be loaded in a few seconds. Pay 

attention to the switch which specifies how to import job/invoice numbers: per 

client or globally. This selection depends on a way you use TO3000. 



Check Only import reference data if needed. This allows you to import all data except 

documents (projects, jobs, invoices, etc.). Actually, this is an easy way to transfer customers 

(mainly). 

Switch to the Services tab and select corresponding work types and languages for each service. 

In TO3000 there is no such term as language combination. Because of this, language names are 

usually specified in the service name. It is impossible to read this information automatically, 

and because of this it is required to manually select correspondence. 

The import operation is now ready to start. Click Begin import on the ribbon and wait a little. 

You will see information about the import progress. When data is loaded, another operation 

will be started - transactions creation. You will see the progress in the status bar of the 

application.  

Do not close the program until the transactions creation operation is finished. It is needed to 

correctly reflect the data in the accounting tables. If you have to force close the program before 

this operation is done, then select Recreate transactions in the Settings upon next run of the 

program. 

After finishing the importing and transactions creation operations try to compare total 

amounts by building different reports and viewing lists of jobs/invoices/payments. 

Note. SDL Trados Business Manager does not support phantom payments/invoices used in 

TO3000. After importing, please check your invoices and payments and make necessary 

corrections, if needed. If you see some invoices with Partially paid status, but these invoices 

must be marked as Paid, take a note on the Due amount column. If amounts in this column are 

small, select such invoices and click Fix due amounts button on the ribbon. This will add due 

mounts as Bank charges to corresponding payments. 

Custom logos 

Both desktop and web versions of Business Manager allow users to use their custom logos. For 

windows version, custom logon is shown on splash screen showing during application launch. For 

web version, custom logo is always displayed in the top left corner. Follow steps described below to 

insert your custom logo. 

Windows version: 



 Put a file called png into the application installation folder. 

 Preferred file size is 550x300 pixels. 

Web version: 

 Put a file called logo_custom.png or logo_custom.svg into the Images folder inside 

application installation folder. 

 Preferred file size is 100x30 pixels. 

System messages 

This table contains automatically generated messages with information about certain events 

(in most cases, unexpected errors). This table is intended for administrators and any users 

(except vendors and customers) who has access to the System message type. 

To view this table select Other/tools > System messages. Also, when any unread messages 

exist, a corresponding icon will be displayed in the top right corner (web version), or bottom 

left corner in the status bar (desktop version), along with a number of unread messages: 

 

Clicking on this button will open the log: 

 

Here, you can see date, record type and header. Unread messages are selected with bold font, 

while regular font is used for other messages. When you click on unread message, details will 

be displayed with additional field containing more information about an event, and a message 

will immediately be marked as read. 

Sometimes detailed information about error could contain stack trace, which could be sent to 

developers to help them to resolve an issue, if error reason is in application code. 

Advanced functions 



Description of functionalities intended for advanced users 

 Edit 

Custom fields 

Overview 

On some stage of program usage, you may find that it is needed to add additional information 

to some entity, but corresponding field to enter this information is missing. Of course, you can 

write to the developer and ask to include required field in the next update, but there is another 

option - create this field manually. 

In SDL Trados Business Manager, you can create own custom fields, place them on any place in 

object editing forms, display in tables, include in reports, invoices, etc. This operation can be 

done pretty easily, but requires some attention. 

To open Custom fields editor, please go to Settings and click Edit custom fields button on 

the ribbon. 

 

Adding a new custom field 

1. Click the New button. 

2. Select entity type to add new field to, type field name (without spaces, it will be added 

to the database structure), provide field caption (as it will be displayed in the UI), select 

value type (string, date, boolean, integer, decimal) and provide max length if selected 

field type is string. 

3. For string fields, provide max length if selected field type is string, optionally mark this 

field as required (such fields will be mandatory to fill-in to save an entity), 

and optionally provide list of predefined values (comma-separated, like Value1, Value2, 

Value3, etc.). Then, you will be able to select from these values in your data entry forms. 

4. Click OK to confirm field creation. 

5. Save program settings and restart the program to apply changes. 



When you open list of the changed entity, you will see that corresponding column is already 

added. For example, if you added ProfileUpdate field with caption set to Last profile update, 

then after application restart you will notice a new column in the list of contractors: 

 
 

Adding new field to an entity editing form 
 

When you open list of the changed entity, you will see that corresponding column is already 

added. If to open contractor editing form (from example above), this field will be missing there, 

but it can be added in a few clicks. 

1. Right click on empty space of the contractor editing form. 

2. Select Customize layout. 

3. Find the field you have created and drag it onto the form: 

 
4. Close customization window and type something on the added field. 

5. Save changes to see that information from the new field was correctly saved. 

Custom fields (Online version) 

Overview 

On some stage of program usage, you may find that it is needed to add additional information 

to some entity, but corresponding field to enter this information is missing. For such cases, SDL 

Trados Business Manager offers Custom fields, functionality, which includes the following 

possibilities: 

 alternation of database tables structure; 

 customization of list and data entry form layouts to place custom fields at desired 

places; 



 providing predefined list of values for custom fields; 

 usage of custom fields in reports for analytics and printing templates (for example, 

invoices) 

Adding a new custom field 

1. Click Settings from any view of the application. 

2. Click Edit custom fields button: 

 
3. In the opened list click the New button. 

4. Select entity type to add new field to, type field name (without spaces, it will be added 

to the database structure), provide field caption (as it will be displayed in the UI), select 

value type (string, date, boolean, integer, decimal), provide max length if selected field 

type is string, and optionally mark this field as required. 

 
5. For string fields, provide max length and optional list of predefined values (comma-

separated, like Value1, Value2, Value3, etc.). Then, you will be able to select from these 

values in your data entry forms. 

6. Click Save and close to confirm field creation. 

7. Save program settings and restart the application to apply changes (this can be done 

from IIS manager on a server by restarting application pool). 

Check list view 

When you open list of the changed entity, you will see that corresponding column is already 

added. For example, if you added Comment field to taxes, then after application restart you will 

notice a new column in the list of taxes: 



 

If you don't want to see this field in the list, simply right click it and select Hide this column. 

Adding new field to an entity editing form 
 

If to open tax editing form (from example above), this field will be missing there, but it can be 

added in a few clicks. 

1. Click layout customization button on the toolbar ( ). 

2. You will see a customization form, which contains tree view representing all groups and 

items which you have in layout. Depending on edited entity, this structure can be pretty 

complex, as such forms as translation job editing form could contain a lot of groups, tabs 

and items. Carefully analyze the structure, noticing groups and tabs, their orientation 

(elements inside groups can be arranged horizontally or vertically). 

3. Click New button to create a new view item. The following form will appear: 

 
4. Fill in details of an item: provide some ID (can't be empty), select parent group and 

database filed from a list of fields, which will already contain your custom field as well. 

5. Click OK to add a new field to a layout structure. 

6. If needed, move (by using drag and drop functionality) created item to another group or 

to change its position inside a group. 

7. Implement other changes in layout, like creating new groups, tabs and items, re-

arranging existing items into necessary groups, etc. 

8. Click Save and close to commit changes, return to an editing form and check changed 

layout. 



9. If something went wrong, open layout customization dialog again and click Reset 

changes button to revert layout tree to its initial state: 

 

Avoid providing identical IDs to different elements. 

It is restricted to create multiple items linked with a same database field. 

If you wish to make a lot of changes in a complex form, implement changes one by one and 

check results to see if you're on the right way. 

For groups with horizontal layout, never put more than 5 items into them, as it could lead to 

incorrect results. 

For groups with horizontal layout, always provide item size (as percentage, from 1 to 100), and 

try to keep sum of all element sizes inside such groups exactly or near 100. 

Model editor 

Model editor is an advanced feature which allows to make a lot of customizations of the default 

setup. 

In this topic, the following topics will be covered: 

 Default application options 

 Field captions 

 Localization 

 Calculated fields 

 Conditional formatting 

To launch Model editor, select Tools tab on the ribbon and click Edit model. You will see the 

following window: 



 

Model contains a lot of different nodes and sub-nodes, each with its own properties and 

intention. As this tool must be used only by administrators, it is not recommended to make any 

changes here if you are unsure what you are doing. Follow recommendations from this manual 

to make described changes and avoid touching undocumented nodes. Of course, you may try to 

experiment and change anything you like. If something will go wrong, you can always reset all 

changes. 

Creating additional view variants 

You may notice that some views in SDL Trados Business Manager has different view variants 

(layouts). You may switch between them according your preferences. For example, invoice list 

has a variant showing details of selected invoice above the table; project editing window has a 

variant for small screens, etc. Variants are switched using Switch current view 

representation button in the View group of the ribbon. 

Using Model editor, you can create own view variants. 

1. Click Tools > Edit model to open Model editor. 

2. Expand Views and then expand necessary group of views. Usually you will find desired 

view under BusinessObjects.Doc (documents) and BusinessObjects.Spr (reference data) 

nodes: 

 
 



3. Find necessary root view. All views has naming convention: 

[Type]_[ViewType]_[OptionalPostfix]. Type is entity type (invoice, job, project, etc.), 

view type could be ListView or DetailView, and OptionalPostfix is used for additional 

non-default views (for example, Variant1). 

4. Right click on a view which you want to clone to use as basement to create own view 

variant and click Clone. 

5. Make necessary edits: 

a. For list views, in the Columns node (you will see preview of columns on the 

right): 

 
 

b. For detail views, on the Layout node: 

 
You can do this by logically organizing elements using tree view, or visually by 

dragging and dropping element (right click in the preview panel and 

select Customize layout). 

6. Clear all contents of the Variants node of the cloned view. 



7. Find main view (for the example above, it will 

be Invoice_ListView or Invoice_DetailView), expand it and find Variants node: 

 
8. Right click on Variants and select Add. 

9. For the added variant, select created view in the View property, and optionally 

provide Caption. 

10. Close model editor and save changes, return to your view and check that created view 

appeared in the View variants drop-down list. 

Model editor - Calculated fields 

1. Open Model Editor and find the following node: BOModel > 

BaccS_XAF.Module.BusinessObjects.Doc > Invoice > OwnMembers. 

2. Right click on OwnMembers node and select Add > Member. A new member will be 

created with random Id assigned. 

3. In the Id field enter OverdureDays. 

4. In the Type field select System.Int32. 

5. In the Expression field, open expression editor and compose the following 

expression: Iif([Term]<Today(), DateDiffDay(Today(), [Term]), 0). 

This expression can be composed using helpers provided by expression editor - no need to 

type it manually). As you see, we used few functions here: Iif (accepts three parameters: 

logical expression, returned value if expression is true, and returned value if expression is 

false), Today() (return today's date) and DateDiffDay (returns number of days between 2 

dates). 

6. Click OK. 

7. Select Invoice node above OwnMembers and find DefaultListView property. 

8. Click Open. 

9. ListView node will be opened. Expand it, right click on the Columns node and select Add. 



10. In properties of added column select OverdueDays in the PropertyName property. 

11. Save changes, close Model Editor and open Invoices list. 

12. From now, each day value in this column will be changed automatically. In addition, you can 

apply conditional formatting rules to highlight invoices which overdue, for example, for 60 

days. 

Model editor - Default application 
options 

Options node of the Model editor contains a number of important settings. 

 

First interesting option here is FormStyle. You can select between ribbon (default) and 

classical menu style. Classical menu allow to save some vertical space. 

Another very important option is DataAccessMode. By default, the value here is Client. This 

means that when any list form is opened, all data will be loaded into the RAM. However, when 

the program is used in network mode, your Internet connection may become bottleneck and 

lead to long loading time of different forms, To improve performance in this case, you can 

use Server or InstandFeedback modes. Recommended value is InstandFeedback, but you 

may experiment with these settings and see which one will give better results. 

If to expand Options node, you will see few sub-nodes here. In 

the LayoutManagerOptions node you will find a number of settings which define forms 

composition. For example, you can decrease properties ended with ... Distance to make the 

whole UI more compact. In the PrintingOptions node you can change default paper options 

used to print documents. In the RibbonOptions you can change RibbonControlStyle property 

to change ribbon appearance (for example, to make it more compact). 

Model editor - Field captions 



Model editor allows to rename any field you may find on any form of the application. 

To achieve this, use BOModel node. This node contains few sub-nodes, and it may be difficult 

to find what you're looking for. In general, all reference data types can be found in 

the BaccS_XAF.Module.BusinessObjects.Spr node, while operations (documents) are placed 

to the BaccS_XAF.Module.BusinessObjects.Doc node. Also you can use Search function to 

find necessary entity. Here is an example showing how to find TranslationAssignment entity 

type: 

 

1. Select on the found object, and it will be immediately selected in the main tree. 

2. Expand this object and expand OwnMembers node inside it. This OwnMembers node 

contains all fields of the selected entity. 

3. Select any member and change its Caption property (or any other property). 

4. Close Model editor, save changes and switch to the Translation assignments list to 

see changes. 

Model editor - Localization 

Process description 

If your native language is not supported, you can localize SDL Trados Business 

Manager manually. 

To do this: 



1. Open Model editor (Edit Model) and find Languages filed on the tool-

bar.  

2. Select on it and select Languages manager....

 

 
3. Click Add, select desired language and click OK. 

4. Select OK again to return to the Model editor, then click Localization. 

5. Provide translations or save the list to translate it in external application. 

 



Recommendations 

List of strings available for translation is pretty long at first sight. And if you export the whole 

list as it appears after adding a new language, it could contain more than 110,000 rows and 

100,000 words. However, most of these segments can be filtered out. To do this, find odd 

segment, right click it and select Mark as translated. If table contains similar segments, 

application will offer to mark them as translated as well. 

To work with filters, right click table header and select Filter editor. Here you can provide 

some filters which will help you to find rows which are not needed to be translated. Here are 

few conditions which you can apply to quickly find such rows and mark them as translated: 

 Default language value Begins with Auto. 

 Default language value Contains true. 

 Default language value Begins with Diagnostic. 

 Default language value Begins with IsRef. 

 Default language value Begins with IsRf. 

 Default language value Begins with File. 

 Default language value Begins with {. 

 Default language value Begins with Id. 

 Default language value Equals g. 

 Default language value Equals n2. 

 Default language value Equals n4. 

 Default language value Equals n0. 

 Default language value Equals n5. 

 Node path Contains Audit trail. 

 Node path Contains SystemModule. 

 Default language value Begins with EntityBase. 

 Default language value Begins with SimpleEditors. 

 Node path Contains SystemException. 

 Node path Contains Persistent.Validations. 

 Node path Contains DevExpress.Xpo. 

 Node path Contains AboutInfo. 

These are just recommendations. You can also apply provided filter conditions by simply 

pasting the following string into the filter editor: 



(StartsWith([DefaultLanguageValue], 'Auto') Or Contains([DefaultLanguageValue], 'true') Or 

StartsWith([DefaultLanguageValue], 'Diagnostic') Or StartsWith([DefaultLanguageValue], 

'IsRef') Or StartsWith([DefaultLanguageValue], 'IsRf') Or StartsWith([DefaultLanguageValue], 

'File.') Or StartsWith([DefaultLanguageValue], '{') Or StartsWith([DefaultLanguageValue], 'Id') 

Or [DefaultLanguageValue] = 'g' Or StartsWith([DefaultLanguageValue], 'n2') Or 

StartsWith([DefaultLanguageValue], 'n4') Or StartsWith([DefaultLanguageValue], 'n0') Or 

StartsWith([DefaultLanguageValue], 'n5') Or Contains([NodePath], 'AuditTrail') Or 

Contains([NodePath], 'SystemModule') Or StartsWith([DefaultLanguageValue], 'Entity base') 

Or StartsWith([DefaultLanguageValue], 'SimpleEditors') Or Contains([NodePath], 

'SystemException') Or Contains([NodePath], 'WIWOReply') Or Contains([NodePath], 

'Persistent.Validation') Or Contains([NodePath], 'DevExpress.Xpo') Or Contains([NodePath], 

'AboutInfo')) And Not (StartsWith([DefaultLanguageValue], 'Automatic connection') Or 

StartsWith([DefaultLanguageValue], 'The ObjectSpace has already') Or 

StartsWith([DefaultLanguageValue], '{0} - recipient name') Or 

StartsWith([DefaultLanguageValue], 'Automatic') Or StartsWith([DefaultLanguageValue], 

'"{TargetPropertyName}')) And [IsCalculated] = False 

Scroll through filtering results and confirm that they indeed do not contain meaningful strings. 

Then, you can select them all and mark as translated with a single click. 

After that, remove filter and scroll through source text. You can try to find more similar 

patterns to exclude untranslatable strings. Or mark some segments one by one, manually. This 

will significantly speed up upcoming translation work and eliminate possible questions sent by 

translators. 

Bottom line 

If you decide to manually localize SDL Trados Business Manager into any language which is not 

provided by default, please consider sharing localization with development team. 

Model editor - Tab captions 

SDL Trados Business Manager has tabbed user interface. 

When you open any table or editing form, a new tab is created. Captions of those tabs has some 

predefined format, which depends on the object type. For example, for the Unit tab caption will 

contain unit name. For the invoice, it will have a form of 'Invoice [number]', where number will 

depend on the Number field. For the job, tab caption has a form of 'Job [PONumber]'. You can 

customize tab captions according your own preferences. To achieve this, do the following: 



1. In the model editor, find necessary object type, as described above. Here is an example 

for the Translation job node: 

 
2. Click Open button in the DefaultDetailViewProperty. You will be moved to the list 

view node: 

 
3. In the Properties pane find ObjectCaptionFormat property (at the bottom) and 

correct it according your needs. 

To include any field from the Job object into the caption, use {0:FieldName} structure. 

Here is an example showing how to include job number and date into the tab caption: 

Job {0:Number} dated {0:Date:d} 

4. Save changes, close model editor, and open any job editing form. Instead of po number 

in the tab caption, it will include job number and date. 

Data export and import 

This section contains information about data exporting and importing capabilities supported 

in SDL Trados Business Manager. 

Export and import data to/from 
Excel 



SDL Trados Business Manager allows to export any data into Excel format for exchanging 

information with external systems, transfer data between different databases, or simple editing 

in Excel environment for importing it back later. 

Data export 

Exporting mechanism is available from any list view. 

1. To access exporting function, open any list view (for example, list of customers, 

contractors, translation projects, jobs, invoices, assignments, etc.), and select necessary 

rows. 

2. Click Export/Import - Export selected rows button. 

 
3. If you are using desktop version, a dialog will appear to select file name and path for 

saving exported file. If you're using web-version, a dialog will appear with a link to a file 

- select it to download exported data. 

This file can be used to edit exported data and importing it back, or as a template to import new 

data into the system. In later case, delete/replace existing values in cells with new ones. 

 

Working with data in Excel 

Workbook contains two tabs: Data (which contains actual exported data) and Info (short 

information about working with data). 



In general, Data worksheet contains a number of sections. First section (first table) contains 

actual information from rows you have selected before export. After first table, a number of 

nested tables are listed - it depends on type of object you exported. In the example above, 

translation job contains the following nested tables: Job tasks, Receivables, Checklist, Workload 

planner and Messages. Other entity tables will contain different nested tables (some reference 

data may not contain nested tables at all, for example countries or languages). 

Structure of each table corresponds to a structure you see during working with the system. 

Each cell in Excel file will have the same data type which is used in SDL Trados Business 

Manager: dates, numbers, booleans and string. While editing data, please remember about that 

and do not change cell types in Excel. If some field has reference data type (for example, 

Customer in translation job is reference data type, because you select customers via drop-down 

list), then you are allowed to enter only those values in such fields, which exist in SDL Trados 

Business Manager database. For example, if customer name is Customer1, and you will change 

it to non-existing Customer12, then the system will ignore this change during import, which 

will lead to the following results: 

if you are importing existing record, customer would not be changed, and old value will be 

persisted; 

if you are importing new record, this record will fail and the whole import operation will be 

aborted. 

Note. Please remember about way of using reference fields while working with data in Excel - 

use only those values which actually exist in SDL Trados Business Manager database. 

Id column is also special column. When you export existing data, this column will always 

contain some GUID value. If you are filling a table with new data, you should always leave this 

column empty. During following import, if this column contains any value, the system will find 

existing record and wrote data from a row into that record. However, if I would value is empty, 

the system will create a new record. 

Nested tables always contain a column which points out to master object. In the example 

above, you can see that each nested table has Job column. And value in this column has the 

following notation: DocumentNumber/DocumentDate. By this combination of document 

number and date the system will be searching for a master record of each child record. So, if 

you are creating a new job in Excel, then you have to define its number and date in the first 

table, and then use this combination of number and date in each nested table, to correctly link 

them (for example, to correctly link job task with master job). 



Importing data from Excel 

When you made necessary changes in Excel file, you can import it back to SDL Trados Business 

Manager. To do this, open corresponding list view and select Export/Import - Import data. 

Select a file (in desktop version) or upload it (in web version). Click OK. The system will start 

importing selected file and then will display resulting message. Here are few points which you 

have to consider during importing: 

 If imported file contains multiple entries and at least one entry was processed with 

mistake, the whole operation will be aborted and no changes will be made in database. 

 If operation was successful, it is recommended to select Refresh (F5) after importing. 

 If operation was successful, and if Excel file contained new data, do not try to import 

the same file again. The reason here is that new Id column for new records is empty in 

Excel file, and TBM created new entries in database for such records. If you will try to 

import same file again, TBM will again create entries for records with empty Ids. In such 

case, to repeat import, please export data to Excel again so Id columns will be filled with 

actual values. 

 Do not create empty rows between sections of Excel file. Empty row will be perceived 

as end of file. 

 Always keep the same data type in cells as in exported file. In other words, do not try to 

type characters in a cell which should contain number. Otherwise, import will fail. 

 Carefully handle cells pointing on reference data. For example, value in Customer 

column should contain full name of customer which exists in TBM database. If the 

system would not be able to determine customer during import, most likely import 

operation will fail, because Customer is a required field in most of documents. 

For columns with ‘Language’ pair value type ,you can use simplified approach. Language pair 

could be written using one of these two patterns: 'Language name => Language name' or 

'Language code => Language code'. Business Manager will search source and target languages, 

and if both languages are found, but language pair is missing, then language pair will be created 

automatically. More to say, language code could be written both as 'en-US' or 'en_US'. 

Security system 

SDL Trados Business Manager provides flexible system to control access to a data stored in your 

database. 



This security system allows to create roles and assign those roles to users. Roles specify a set of rules 

which allow or restrict access to a specified data. It is possible to control access right on the level of 

individual forms and fields. If access is restricted to some form, it will be hidden from the UI. If 

access is restricted for some field, than a user with that role will see 'Protected content' label instead 

of actual data contained in that field. 

The whole security system is controlled via two main forms available through 

the Other/tools section of the navigation tree: Role and User. 

Important. To start using security system, you have to set a password 
for Admin user. If Admin user has no password, you will be automatically logged-
in into the system using Admin user with blank password. If Admin password is 
not blank, you will get logon window to enter user name and password when the 
application starts. 

User form allows to simply create, edit and delete users, assign roles and set passwords. It also 

contains some notification settings and allows to link user logins with particular contractors and 

customers. 

 

To create a new user, click New button on the ribbon. To edit existing user, simply double click on it. 

Change my password and Reset password buttons allow to set a new password, if it is empty, or 

reset existing password (admins only). 

For newly created users, you may check Change password on first logon checkbox to force users to 

create a new password when application will be launched for the first time. 

Is active checkbox allows to temporary disable current user (without deleting it). 

E-mail field allows to provide an e-mail used for sending messages to this user. 

If you are creating a user for Contractor, to allow this contractor to login into web-portal, select this 

contractor in the Associated contractor field. 



If you are creating a user for Customer, to allow this customer to login into web-portal, select this 

customer in the Associated customer field. 

Note. When a user has associated contractor or customer, you can click Send login 
details to compose a message with information how to login into the portal. 

On the Notifications tab you can setup internal notifications sent to a user. If you select Receive 

notifications checkbox, this user will get notifications about actions are performed 

by Contractors or Customers. Examples of such actions: contractor partially of fully delivers a job, 

contractor registers an invoice, customer creates a new job. By default, this checkbox is set 

for Admin user. But if you also wish your managers to get similar notifications, check this box for 

respective users too. 

Notification method field allows to select a channel to send messages to a user. Possible values 

are In-application (messages will be sent using internal notifications mechanism), E-mail (messages 

will be sent to an e-mail address specified in the E-mail field), or Both. 

If you wish a user to receive notifications about actions performed only by specified users, add them 

to the table below checkbox. If this table is empty, a user will receive all notifications. Otherwise, a 

user will receive notifications only from listed users. 

To assign roles, use Roles table. Using default controls, add roles which currently edited belongs to. 

The Is administrative option is intended to simplify the unrestricted access definition and grants all 

available permissions to a role. If a role is administrative, it is impossible to deny any rights unless 

the administrative permission was removed. Can edit model checkbox specifies if current role has 

access to the Model editor. 

Working with roles 

In the navigation tree, select Other/tools > Roles. Start with creating a new role or editing existing 

one. 

For example, when SDL Trados Business Manager was launched for the first time, few default roles 

were created: Administrator, Default, Vendor, Customer. As it is clear from its name, administrators 

has full access to all data. From the other hand, users with Default role do not have access to any 

data at all. Try to login with the User user name and you will see that navigation tree is almost empty 

- access rights are fully limited. 



Editing view for the Default role: 

 

Both checkboxes are clear and in the Permission policy field Deny all by default value is selected. 

This means that users with this role would not get access to any data unless you explicitly allow it in 

the Navigation permissions and Type permissions tabs. You can change Permission policy value 

to Read only all by default and Allow all by default. In the first case, a user will get access to all 

data without ability to edit it. In the second case, he/she will get access to all operations. Depending 

on the selected value here you specify a way of working with Navigation permissions and Type 

permissions tabs. If default policy denies access by default, than in these tabs you will specifying 

objects to allow access. And vice versa, if default policy allows access, than in these tabs you will 

specify object to restrict access to. 

The Navigation Permissions allow you to grant or deny permissions for a single navigation item or 

for the whole navigation group as shown on the image below: 

 

Allowing access to Reference data group will open access to all items in this group with read only 

rights. By default, permission policy dines all access. After giving access to the Reference 

data group we expand this policy by giving additional rights. Since we use policy of restriction, 

given rights allow only to view data, but not edit it. 

Item permissions have a greater priority than group permissions. For instance, you can deny access 

to the group, but grant access for one of its items, so this item will be enabled in the Navigation 

Panel. 

The Type Permissions tab specifies access to all objects of a particular type. The image below 

illustrates this (in addition to previously granted access to the Reference data group, we open write 

rights for the Units table): 



 

From now, user with Default role assigned will be able to edit Units table, but would not be able to 

delete any records from it. 

If you wish to quickly fill this table with all object types available in the Business Manager, instead 

of manually adding rows one by one, click Pre-fill list of object types button on the ribbon: 

 

Double click on the new type permission to open its editing form: 

 

In this window, you can adjust access rights in detail. In addition 

to Read, Write, Create and Delete rights you get access to two additional tables: Member 

permissions and Object permissions. 

Member permissions 

Member Permissions grant access to specific members of an object. 

For example, users can have access to objects of a particular type and simultaneously have no 

access to several members of this type. For other example, it is possible to deny access to 

objects of a particular type and only allow access to a strict list of its members. It is possible to 

grant access to multiple properties with a single entry. 

In the following example, we provide access to customers table, but restrict access to 

the Default rates table and Default prices column, and this restriction applies only 



to Company1 and Company2 customers (if to leave Criteria empty, this restriction will be 

applied to all customers): 

 

Instead of prices, 'Protected content' text is displayed. 

As you see, Member permissions table also contains Criteria column. Using this column, you 

may provide additional conditions for applying particular right. Built-in criteria builder will 

help you to compose necessary criteria: 

 

ObjDefault Vendor role 

In addition to Admin and User default roles, SDL Trados Business Manager has a predefined 

role called Vendor. 

This role should be assigned to all user accounts created for vendors who will be able to access 

their area on the web-portal. In addition to a role, Associated vendor field must be filled for 

such users. By default, Vendor role allows vendors to: 

 Change own password for accessing a portal 



 View and edit own profile (vendor editing form - full access is provided to all fields, 

including prices and languages; while editing, a vendor can select Units, Languages, 

Work types, Software applications contained in the database) 

 View their assignments (with status, language pair, PO number, date, deadline, 

amounts, due and paid amounts, instructions, etc.) 

 Partially deliver assignment (with possibility to attach up to 5 files) 

 Fully deliver assignments (with possibility to attach up to 5 files) 

 Register invoices over delivered assignments (with possibility to attach invoice file) 

 View Vendor performance QuickReport 

Translators cannot edit assignments. They only can change status of assignments by 

clicking Partial delivery, Final delivery or Register invoice buttons. After registering an 

invoice delivery buttons and invoice creation buttons become disabled. 

You are fully free to change default permissions defined in the Vendor role. However, if you 

unintentionally remove permissions which are mandatory for correct working of a vendor's 

portal, then application will automatically return these permissions after clicking Save button 

in the role editing window. 

Below you will find explanation of every permission setting in the Vendor role. 

Navigation permissions 

Translation assignments Allows to view all assignments. Special limited list of assignment will be opened with buttons to 

deliver files. 

Translation assignments Adds Translation assignments to a navigation tree. 

My details Allows to view user's form which allows to change password for a vendor's user.

Invoices (in) Adds Invoices (in) to a navigation tree. 

This means that navigation tree on the left will contain only 2 links: to open translation 

assignments and my details. 



Type permissions 

While navigation permissions control contents of the navigation tree and do not control access 

right to actual data, type permissions serve exactly for this - to define a data allowed/denied to 

be read, written, created or deleted by users with this role. By default access to all data is 

denied in Vendor role: 

This means that even if navigation permission allows to open translation assignments list, 

attempt to do this will lead to fully empty list of assignments, because it is not allowed to read 

(nor write, create and delete) and data. So, the task of Type permissions table is to define 

what is allowed to read/write/create/delete. In this list you can see what is allowed by default 

in the Vendor role: 

Type Rea

d 

Writ

e 

Crea

te 

Dele

te 

Member 

permissions 

Object permissions Notes 

Role Den

y 

            

User Allo

w 

      Change 

password on 

first logon 

Criteria: 

[Oid] = 

CurrentUser

Id() 

Allow write 

Stored 

password 

Criteria: 

[Oid] = 

x Needed to 

allow user 

to change 

own 

password 

Read 

permission 

for all 

users is 

needed to 

determine 

users for 

sending 

notificatio

ns 



Type Rea

d 

Writ

e 

Crea

te 

Dele

te 

Member 

permissions 

Object permissions Notes 

CurrentUser

Id() 

Allow write 

Applicatio

n setting 

Allo

w 

Allo

w 

    

Write 

permission 

for 

applicatio

n settings - 

internal 

temporary 

data is 

stored in 

this table 

Vendor Den

y 

Deny Deny Den

y 

  Criteria: [Id] = 

CurrentUserVendorOrClie

ntId() 

Allow read and write 

Allows to 

read and 

write only 

logged in 

vendor 

Country Allo

w 

            

Currency Allo

w 

            

Dashboard           [Title] = 'Vendor 

performance' 

Allow read 

Allows to 

view only 

one 

QuickRep

ort named 

'Vendor 



Type Rea

d 

Writ

e 

Crea

te 

Dele

te 

Member 

permissions 

Object permissions Notes 

performan

ce' 

Document 

checklist 

item 

     

[Assignment] Is Not Null 

And 

[Assignment.Vendor.Id] = 

CurrentUserVendorOrClie

ntId() 

Allow read and write 

Allows 

vendors to 

mark 

checklist 

items as 

done 

before 

delivering 

an 

assignmen

t 

File 

attachment 

Allo

w 

Allo

w 

Allo

w 

Den

y 

    To deliver 

files and 

invoices 

File data Allo

w 

Allo

w 

Allo

w 

Den

y 

    Linked 

with File 

attachment 

table 

File type Allo

w 

     

Allows to 

view file 

types 

Fuzzy type 

Fuzzy type 

kit 

Fuzzy type 

kit detail 

Allo

w 

          Allows to 

read 

informatio

n from 

fuzzy 

schemes 



Type Rea

d 

Writ

e 

Crea

te 

Dele

te 

Member 

permissions 

Object permissions Notes 

Invoice 

incoming 

Invoice 

incoming 

item 

  

Allo

w 

  

[Vendor.Id] = 

CurrentUserVendorOrClie

ntId() 

Allows to 

create 

invoices 

with own 

vendor val

ue. 

Language Allo

w 

Allo

w 

          

Language 

pair 

Allo

w 

Allo

w  

          

Model 

difference 

Model 

difference 

aspect 

Allo

w 

Allo

w 

Allo

w 

      Used to 

store 

individual 

user 

settings 

(column in 

tables, 

etc.) 

Notificatio

n 

Allo

w 

Allo

w 

Allo

w 

Allo

w 

    Needed to 

send 

notificatio

ns to users 

Payment 

outgoing 

     

[Vendor] Is Not Null And 

[Vendor.Id] = 

CurrentUserVendorOrClie

ntId() 

Allow read 

Allows to 

view own 

payments 

Report Allo

w 

          Needed 

for 



Type Rea

d 

Writ

e 

Crea

te 

Dele

te 

Member 

permissions 

Object permissions Notes 

viewing 

reports 

Settings Allo

w 

          Read 

applicatio

n settings 

Software 

application 

Allo

w 

            

Specializat

ion 

Specializat

ion 

category 

Allo

w 

     

Read 

reference 

data 

Tax Allo

w 

            

Translation 

assignment 

Den

y 

Deny Deny Den

y 

  1. Criteria: [Vendor.Id] = 

CurrentUserVendorOrClie

ntId() 

2. [Vendor] Is Null And 

[Vendor pickup][[Vendor] 

Is Not Null And 

[Vendor.Id] = 

CurrentUserVendorOrClie

ntId()] 

Allow read and write 

Criteria 

sets rights 

on reading 

and 

writing 

only those 

assignmen

ts which 

are created 

for logged 

in vendor, 

as well as 

assignmen

ts offered 

to a 

vendor 



Type Rea

d 

Writ

e 

Crea

te 

Dele

te 

Member 

permissions 

Object permissions Notes 

Translation 

assignment 

pick 

Den

y 

Deny Deny Den

y 

   [Vendor.Id] = 

CurrentUserVendorOrClie

ntId() 

Allow read and write 

Explicitly 

deny 

access to 

Translator

s pickup 

tab in 

assignmen

ts, but 

allows to 

accept and 

decline 

assignmen

ts 

Translation 

job task 

        Fuzzy type; 

Unit; Work 

type 

 

Needed to 

allow to 

view 

fuzzy 

type, unit 

and work 

type in 

assignmen

ts, because 

tasks in 

assignmen

ts are 

based on 

job tasks 

Unit Allo

w 

     

Read 

reference 

data 



Type Rea

d 

Writ

e 

Crea

te 

Dele

te 

Member 

permissions 

Object permissions Notes 

Work type Allo

w 

          Read 

reference 

data 

* Empty cell means 'Deny' 

As you see, two functions were used in the Object permissions column: 

CurrentUserVendorOrClientId() and CurrentUserId(). 

CurrentUserVendorOrClientId() function returns Id of a vendor or customer which is linked 

with a logged in user. This vendor or customer is specified in the Associated 

vendor or Associated customer in the Users table. 

CurrentUserId() function returns Id of the logged in User. 

Let's check criteria used to access translation assignments: 

Criteria: [Vendor.Id] = CurrentUserVendorOrClientId() 

Read, Write, Create and Delete properties are not set. This means that it is denied to access 

translation assignments table. But in the Object permissions table a row is created which 

allows to read and write assignments which meet provided criteria. And this criteria sets 

that Id of a Vendor selected in assignment must equal to Id of a currently logged in vendor. 

Visual designer can help you to build this criteria, but you have to manually type name of a 

function after equity symbol: CurrentUserVendorOrClientId(). 

By modifying Vendor role you can provide more rights to your vendors or for individual 

vendors (in this case, Criteria property will look like [Vendor.FullName] = 'Peter Blake'). 

Note. It is strongly recommended to carefully test modified permissions before granting them 

to any real users. 

Note. It is always recommended to ask SDL Trados Business Manager developers for help 

when modifying default role. 



Object permissions 

An Object Permission grants access to object instances that fit a specified criterion. 

The following image illustrates the Object Permissions tab in the Type Operation 

Permissions dialog. 

 

Here with fully restrict an access to all customers whose name starts with 'Flying'. In the result, 

'Flying Colors' customer will fully disappear from the Customers list. 

Providing access to additional 
reports for Vendors 

By default, Vendor role allows access only to one report - Vendor performance. 

However, you may create another custom reports or QuickReports which you may wish to 

provide your vendors access to. This topic describes how to do this. First of all, open list 

of Reports or QuickReports and write down name of a report you wish to grant access to. 

Note. Object type for custom reports - Report Data V2, for QuickReports - Dashboard. 

1. In the navigation panel, select Other/Tools > Roles. 

2. Double click on Vendor role to edit it. 

3. Switch to Type permissions tab and find Report Data V2 row (create it if needed). 

4. Double click on it to open editing form. 



5. Create a new Object permission and specify the following criteria using built-in 

criteria builder. 

 
6. If you wish to provide access to several reports, change condition to And to Or at top. 

7. Select OK and set Allow for a created permission. 

8. Save a role to apply changes. 

9. Log in using vendor's account and open Translation assignments. 

10. Select Reports and verify that a new report is added to the list. 

11. Open this report and try to select a contractor in the Parameters panel. As you see, 

logged in contractor can select only himself/herself. 

Default Customer role 

In addition to Admin and User default roles, SDL Trados Business Manager has a predefined 

role called Customer. 

This role should be assigned to all user accounts created for customer who will be able to 

access portal for customers. In addition to a role, Associated customer field must be filled for 

such users. By default, Customer role allows customers to: 

 Change own password for accessing a portal 

 View and edit own profile 

 Create quote requests, create new projects and jobs, with possibility to upload files and 

provide additional instructions 

 View ongoing and past quotes, translation projects and jobs, including pricing and 

volumes information 

 View invoices issued by a user and status of their payment 

 View number of QuickReports to assess cooperation with a user 



You are fully free to change default permissions defined in the Customer role. However, if you 

unintentionally remove permissions which are mandatory for correct working of a customer's 

portal, then application will automatically return these permissions after clicking Save button 

in the role editing window. 

Below you will find explanation of every permission setting in the Customer role. 

Navigation permissions 

Translation assignments Allows to view all assignments. Special limited list of assignment will be opened with buttons to 

deliver files. 

My details Allows to view user's form which allows to change password for a vendor's user.

QuickReports View list of available reports (allowed by security system) 

Credit notes View list of credit notes issued by a user 

Customer's dashboard Dashboard showing ongoing quotes, projects and jobs on a single screen, as well as few charts

Invoices View all invoices issued for a customer, along with their status of payment 

Payments View all payments registered by a user for a customer 

Quotes View all quotes (available for acceptance and past quotes) and create quote requests

Translation jobs View and create translation jobs (tasks with single language pair) 

Translation projects View and create translation projects (multiple language pairs) 

This means that navigation tree on the left will contain only 2 links: to open translation 

assignments and my details. 

Type permissions 

While navigation permissions control contents of the navigation tree and do not control access 

right to actual data, type permissions serve exactly for this - to define a data allowed/denied to 



be read, written, created or deleted by users with this role. By default access to all data is 

denied in the Customer role. 

This means that even if navigation permission allows to open translation project list, attempt to 

do this will lead to fully empty list of projects, because it is not allowed to read (nor write, 

create and delete) data. So, the task of Type permissions table is to define what is allowed to 

read/write/create/delete. In this list you can see what is allowed by default in 

the Customer role: 

Type Read Write Create Delete Member 

permissions 

Object permissions

User Allow       Change 

password on 

first logon 

Criteria: [Oid] 

= 

CurrentUserId() 

Allow write 

Stored 

password 

Criteria: [Oid] 

= 

CurrentUserId() 

Allow write 

x 

Application 

setting 

Allow Allow 
    



Type Read Write Create Delete Member 

permissions 

Object permissions

Country Allow           

Currency Allow           

Customer 
     

[Id] = 

CurrentUserVendorOrClientId()

Allow Read and Write

Dashboard           [Title] = 'Vendor performance'

Allow read 

File 

attachment 

Allow Allow Allow Deny     

File data Allow Allow Allow Deny     

File type Allow 
     

Fuzzy type 

Fuzzy type kit 

Fuzzy type kit 

detail 

Allow           



Type Read Write Create Delete Member 

permissions 

Object permissions

Invoice 

Invoice item 

  

Allow 
  

[Customer.Id] = 

CurrentUserVendorOrClientId()

[Invoice.Customer.Id] = 

CurrentUserVendorOrClientId()

Allow Read and Write

Language Allow Allow         

Language pair Allow Allow          

Model 

difference 

Model 

difference 

aspect 

Allow Allow Allow       

Notification Allow Allow Allow Allow     

Payment 

Payment 

details 

     

[Customer.Id] = 

CurrentUserVendorOrClientId()

[Payment.Customer.Id] = 

CurrentUserVendorOrClientId()

Allow Read and Write

Price-list Allow Allow 
    



Type Read Write Create Delete Member 

permissions 

Object permissions

Quote 

Quote item 

  

Allow 
  

[Customer.Id] = 

CurrentUserVendorOrClientId()

[Quote.Customer.Id] = 

CurrentUserVendorOrClientId()

Allow Read and Write

Report Allow           

Scheduler Allow Allow Allow Allow 
  

Settings Allow           

Software 

application 

Allow           

Specialization 

Specialization 

category 

Allow 
     

Tax Allow           



Type Read Write Create Delete Member 

permissions 

Object permissions

Translation job 

Translation job 

task 

Translation job 

receivable 

    

  [Customer.Id] = 

CurrentUserVendorOrClientId()

[Translation job.Customer.Id] = 

CurrentUserVendorOrClientId()

Allow read and write

Translation 

project 

  

Allow 
 

  [Customer.Id] = 

CurrentUserVendorOrClientId()

Allow read and write

Translation job 

task 

        Fuzzy type; 

Unit; Work 

type 

 

Unit Allow 
     

Work type Allow           

* Empty cell means 'Deny' 

As you see, two functions were used in the Object permissions column: 

CurrentUserVendorOrClientId() and CurrentUserId(). Description of these functions can be 

found in the Default Vendor role article. 



Transfering UI customizations 
between users 

When user logs-in into SDL Trados Business Manager, tables and editing forms will have 

default look for that user. 

This allows to have separate customization settings for each user. For example, different user 

may have different setup of tables (hide, display and move columns, create appearance rules, 

change colors, create default groupings and summaries, etc.), they can customize data entry 

forms, etc. 

Sometimes, manager or administrator may wish to deliver default look and feel to all users, so 

they all get the same colors, columns set, and other settings throughout the application. 

This can be done from the Users list by clicking Manage user UI customizations. 

 

In the Model difference list you can view list of customization entries for all users: 

 
Shared model difference entry contains default UI customizations supplied with the 

application. This row should not be deleted . 

To copy UI settings from one user to another, select source user in the list and click Copy 

model difference. The Copy Model Differences dialog is displayed: 



 
In the Copy Model Differences dialog you can select copy behavior and target users. 

By default, Target users table will contain all users you have in the database. Remove 

unnecessary users (select them and click Unlink) and leave only users you wish to apply 

settings to. 

Click OK. The system will copy settings, and next time user logs into the system new default 

settings will be applied. 

Allowing users to create entries 

Sometimes it is needed to configure a role in a way that allows users to create particular 

entities, but denies to edit or delete them after creation. 

To achieve this, do the following: 

1. Open a role and switch to Type permissions tab. 

2. Add a new row and select Target type. 

3. Set Read and Create permissions to Allow, and Write and Delete permissions to Deny. 

4. Double click on this row to open its editing form. 

5. Switch to Object permissions tab and add a new row. 

6. Set Write permission to Allow, and type the following in the Criteria:  

IsNewObject([This]) = True 

This means that write is denied in general, but allowed when current object is new. 

7. Save a role, assign it to some user and test how it works. 

Linking managers with specified 
customers 



Sometimes it is needed to allow company manager to view data only for particular 

customer(s). 

This data may include customer's data, projects, jobs, invoices, and other information which 

can be clearly associated with particular customer. 

Security system implemented in SDL Trados Business Manager allows to solve this task by 

correct configuration of user roles. It will be needed to create as many roles as the number of 

users who needs to get access only to data of individual customers. 

Security system allows access to an entity only when this access is granted in ALL roles 

assigned with a user. This means that you will need to create a general role applied to all 

managers, which will allow them to access all data, and then create individual roles which will 

deny access to all customers, projects, jobs, assignments, invoices and payments, which are not 

associated with specified customer or customers. 

Say, you already have Manager role, which allows managers to view all necessary data. Now 

the task is to create additional "slice" of security which will add additional restrictions to 

existing role and allow user to view only data associated with specified customers. 

1. Create a new role, set its name, and click Set customer(s) allowed to access by this 

role on the ribbon: 

 
2. Select customer in the popup window and click OK. 

3. Switch to Type permissions table to view results of operation: 

 
4. Six objects has been added to the table. Double click on any to view its details, and 

switch to Object permissions table: 

 
You can see that this role denies access to all jobs where customer is not Euro-Soft and 

not Capital Languages. The same rules are created for lists of customers, projects, 



invoices, assignments and payments. From now, user with this role assigned will be 

able to view only jobs (and other 5 entity types) for these two customers. 

5. You are free to edit entities created automatically. For example, you can manually add 

another customer in future. 

Invoice templates and custom 
reports 

Articles in this section explain how to work with custom report designer (also used to create 

printing templates). 

Invoice templates 

SDL Trados Business Manager has built-in template designer, which can be used to create 

invoice/quote/purchase orders templates, as well as to create custom reports. 

This is very flexible and powerful reporting solution, which gives you full freedom in creation 

of nice-looking documents. 

To create own template, you can use one of build-in examples, or create it from scratch. 

When you run template designer for the first time, it may seem too complex. Please, spend 

some time reading these instructions, and it will become much easier to implement any idea. 

Creating attractive invoices is an art, and SDL Trados Business Manager gives you all necessary 

instruments to get desired results. 

Getting started 

All printing templates and custom reports can be found in the Reports and templates list, 

which can be opened from the Reports group of the navigation tree. 

The list is categorized by report types. Invoice templates can be found under Invoice template 

category. Predefined templates (blue highlighting) cannot be edited, but they can be cloned 

(Copy predefined report button) and used as a base for creating customized templates. To do 

this: 



1. Select any predefined template and click Copy predefined report on the toolbar. A 

new report will be created with the same name as selected report, but a new row would 

not be highlighted with blue color. 

2. Click Edit button. In the opened form, give another name to this template, to distinguish 

it in the list. 

3. To launch template designer, click on the Show report designer button. Now, welcome 

to the next article, where you will get basic information about the designer. 

Template designer description 

Report designer's default look: 

 

1. Main toolbar - contains basic commands, like save/open reports and formatting 

buttons to change appearance of the currently selected element. 

2. Print preview toolbar - allows to quickly switch to preview mode and see how your 

template will be looking using real data from the database. 

3. Toolbox panel - contains elements which can be placed on the design surface. 

4. Design surface - here you build template structure, using bands and controls from the 

toolbox, which are bound to database fields listed in the field list. 

5. Report helper menu - contains the most important report commands and properties. 

The same helper menu is available for each element on the workspace. When you select 

any element, corresponding icon appears: 

 



This menu significantly simplifies workflow, providing quick access to the most used 

properties. 

6. Field list - contains list of database fields which you can use in your template. Please 

read separate article about navigation in the field list. 

7. Property grid - contains properties of the selected element. Most properties will be 

never used, while others will be interesting. 

8. Group and sort panel - allows to sort source data (for example, when you print several 

invoices at once) or group it (for example, if you want to group source data by currency 

or by customer). 

Toolbox 

The Toolbox contains all available report controls and allows end-users to add them to the 

report being edited. Report controls can display both static and dynamic information of 

different kinds (simple or formatted text, pictures, tables, etc.) and adjust a report layout 

(organize controls within panels, insert page brakes, etc.) 

General Content 

The following controls are most commonly used to display data in a report. 

Icon Control Description 

 

Label The most basic Label control is intended to display plain text in a report.

 

Check Box The Check Box control displays True/False or Checked/Unchecked/Indeterminate states in a 

report by displaying (or not) a check mark, which can be accompanied by a text description.

 

Rich Text The Rich Text control displays formatted text in a report. 

 

Picture Box The Picture Box displays static or dynamic images of various file formats in a report.

 

Table The Table control is designed to display tabular information in a report.

 

Bar Code The Bar Code control transforms its content into a bar code of the 



Icon Control Description 

 

Zip Code The Zip Code control transforms its content into a zip code. 

 

Gauge The Gauge control provides the capability to embed graphical gauges into a report.

Extended Data 

The following controls are connected to data individually, without accessing a report's data 

source. 

Icon Control Description 

 

Chart The Chart control displays a series of points using numerous 2D or 3D chart 

types. 

 

Sparkline The Sparkline control displays a compact chart that is 

reflect the flow of data for every row in a report.

 

Pivot Grid The Pivot Grid control displays dynamic data in a cross

Report Layout 

The following controls allow you to draw shapes in a report and customize the report layout. 

Icon Control Description 

 

Panel The Panel control is a container that frames separate report controls to allow 

them to be easily moved, copied and pasted, and visually unite them in the 

report's preview. 

 

Line The Line control draws a line of a specified direction, style, width and color.

 

Shape The Shape control draws one of the predefined graphic objects (rectangle, 

ellipse, etc.) 

 

Subreport The Subreport control allows you to include other reports in a current report.



Icon Control Description 

 

Page Break The Page Break control inserts a page delimiter at any point within a report.

 

Cross-Band Line The Cross-band Line control draws a line through several bands.

 

Cross-Band Box The Cross-band Box control draws a rectangle through several bands.

Document Statistics 

The dynamic content of the following controls is not obtained from a data source. 

Icon Control Description 

 

Page Info The Page Info control is intended to add page numbers and 

system information (the current date and time or the current 

user name) to a report. 

Adding controls to a report 

To add a control from the Toolbox to a report, do one of the following. 

1. Double-click an item in the Toolbox to create the corresponding control at the default 

position. 

2. Drag-and-drop an item from the Toolbox onto the required position within a report. 

 
3. Select an item in the Toolbox, and then indicate the bounding rectangle by holding 

down the left mouse button. 

 



4. If you need to perform selection, re-arranging or resizing operations, select the Pointer 

item. 

5. To edit main properties of the selected element, use triangle to display helper menu. 

Contents of this menu depends on the selected element and usually allows to change 

data binding, formatting, alignment, etc. 

6. To edit the text inside label or text control, simply double click on it. In the case of rich 

text, you can apply different formatting into different parts of the text inside it. 

7. To do this select the text and change any formatting parameters (font, color, alignment) 

- these commands will be applied only to the currently selected text. 

Field list 

The Field List panel is intended to display the structure of the data source to which a report is 

currently bound. 

When you are working on the invoice template, usually field list contains 1 source (or table): 

Invoice. This source links report with a corresponding table in SDL Trados Business 

Manager database. 

You may add as many source as you need to build your template. As an example, let's take CV 

template: some built-in CV templates contains 2 data sources: User and Projects. First one 

serves as a source of user's data, while second one is used to show list of your recent projects. 

Filed list is used to create new bound report controls, manage calculated fields and template 

parameters. 

 



To add any field to the report, drag and drop a field from the field list to the design surface. This 

creates an appropriate control bound to the selected data field. 

 

When you select any control on the designer surface which is bound to some field, this field will 

also be automatically selected in the field list. This is conventional way to analyze report 

structure: just select a label and see to which field it is bound: 

 

This is useful approach when you would like to add adjacent fields. For example, you edit 

invoice row band, already have Quantity field there, and wish to add Price field, which you 

know is located nearby Quantity field. In this way, you select Quantity label on the designer 

surface, and then quickly find Price label in the field list, which can be quickly dragged onto 

designer surface. 

Group and sort panel 

The Group and Sort Panel allows to quickly apply grouping and sorting to report data. 

 

To create a new sorting or grouping criterion: 



1. Select Add a Sort or Add a Group, respectively. Then, select the desired data source 

field in the invoked drop-down list. 

 
2. After adding the grouping criterion, the Group Header band is automatically created. 

You can manually specify whether to display the corresponding Group 

Header and Group Footer using the Show Header and Show Footer check boxes. 

3. You can choose the sorting mode (ascending or descending) in the Sort Order drop-

down list. 

4. The Group and Sort Panel also allows you to change the precedence of multiple 

grouping and sorting criteria using the Move Up and Move Down buttons. 

To remove a grouping or sorting criterion, select it and select the Remove button. 

Properties panel 

The Properties panel allows you to access and customize settings of a report and its elements. 

 



Selecting a Report Element 

To select an element and show its properties in the Properties panel, do one of the following. 

 Select a required element in the drop-down list at the top of the Properties panel. 

 
 Select a required element in the Report Designer Surface. 

 Select a required element in the Report Explorer. 

Changing Property Values 

In the Properties panel, each row consists of two cells: the header cell showing the property 

caption and the value cell. 

To set a property value, locate the property and specify its value using the corresponding cell 

editor. Specific properties contain nested properties, which can be accessed by selecting the 

expand button for the property captions. 

 



Searching for Properties 

The Properties panel includes the search box that allows you to search for a required 

property. 

When you type within the search box, the Properties panel automatically creates a search 

criteria based on the entered text and filters the list of available properties. 

 

If you type two substrings separated by the space character, these substrings are considered as 

individual conditions combined by the OR logical operator. 

 To find properties that contain both substrings (i.e., to use the AND logical operator), 

type "+" before the second substring. Similarly, type "-" to exclude properties that 

contain a specific substring. 

 To search for a property that contains a space character, enclose the entered string in 

quotation marks. You can also combine several logical operators and quotation marks. 

Field list and adding fields to the 
designer surface 

During invoice template creation the main instrument which you will use to display data in the 

report will be Field list. 

Nested User property provides access to your personal data (your name, address and other 

details specified in the program settings). 



Expand Invoice table and see which data it contains: 

 

It contains a number of fields of different types. Type of field is determined by an icon. Some 

fields contain an arrow near icon, which means that this field contains nested fields. Nested 

fields may be contained in the reference fields (example is a customer, which has name, VAT 

code, address, etc.) or in table fields (examples areRows to print or Payment methods nested 

tables, which contain set of rows). 

If a field is not referenced field or table field, than it can be placed on the design surface. For 

example, we would like to display invoice date on the surface. The easiest way to do this is to 

drag and drop Date field inside corresponding band. The program will automatically create 

label control and bind it with Date field. When any control is bound to any table field, a yellow 

icon is displayed in the top right corner of that element: 

 

Another way to bind an element with a field is to use toolbox panel. Drag and drop Label 

element from the toolbox, open its helper menu and select a field to bind to: 



 
You must clearly understand its meaning to efficiently create templates. In the built-in 

templates field list contains one single table called Invoice. This table provides access to all 

invoice fields and nested tables. All invoice rows re contained in the Invoice to print table. 

Selected payments methods can be found in the Payment methods table. 

1. To change binding, open helper menu again and change value in the Data binding 

property. Or, you can simply drag and drop any field from the Field list over existing 

control, and its binding will be automatically changed. 

When a control is placed on the design surface, the next very common task is to change 

its formatting. By default, all dates are printed using full form of date (with hours, 

minutes and seconds). Number usually contain too much decimal places, while you 

usually need to display only 2 decimals. 

2. To change formatting, open helper menu of the element and select ... button in 

the Format string property: 

 
 

3. In the opened window, depending on the type of formatted value, select desired 

options. 



For dates, your common choice will be d value. For numbers - n2 (number with 

thousands separator and 2 decimal places). 

Another interesting feature of format string is possibility to add prefix and postfix to the 

value. 

 

4. If to type something before or after {0:d}, than this value will be printed along with field 

value. Now, in addition to due date, the word 'Deadline' will be printed before it. This 

technique will be useful when printing customer VAT number. If customer do not have 

VAT number, the whole value would not be printed. But if a customer has VAT number, 

the following string will be printed in the invoice: "VAT: 2323232". Therefore, you will 

avoid situations when invoice contains "VAT: " string, but actual VAT would not be 

specified. 

Mail merge binding 

Template designer provides another way to bind elements to data. This feature is called mail 

merge and allow to bind one element to multiple fields. 

The best option will be putting currency symbol, followed by the amount after single space. In 

such cases, mail merge function will be a solution. 

This is useful, when you want to print different data from the source table, but using of 

separate labels is not sufficient because of arrangement limitations. For example, you want to 

print invoice amount and put currency symbol before it. It is possible to place 2 elements, and 

bind the first one to the currency symbol, and the second to the amount itself. But since amount 

may be of different length, how to place both elements in relation to each other: 



 

1. Place label control on the report surface. 

2. Double click on it to start editing. 

3. Enter square brackets and drag necessary field from the Field list inside first pair of 

square brackets. 

4. Type another pair of square brackets and drag second field from the Field list inside it: 

 
 

5. Now, invoice amount will take the following form: "$ 1346.32000". Close to desired 

result. 

6. For mail merge boxes, simple way of setting format string would not work, because 

such element is bound to several fields, which may have different types. To apply 

formatting to each included field, type exclamation mark before closing bracket, 

followed by format string. You will get the desired result: "$ 1 346.32" 

 

Template structure 

When you select Print in the invoice list, you see composed template. 

In most cases, it contains a header, followed by invoice rows, followed by summaries and additional 

information. Information about selected invoices (or one invoice) comes to report generation system 

from a database. This system processes this data and displays in the form, which is ready to be 

printed or saved into file. To correctly display this data, a specific template structure is required. This 

structure is created on the designer surface. The whole structure consist of a number of bands, which 

are printed in a certain order necessary amount of times. 

Here is how empty report looks like: 



 

It contains the following bands: 

 The Detail band, which is printed for every record in a data source (i.e., for each invoice you 

selected in invoice list). Every template should have the Detail band, and you cannot delete 

it. 

 The Top Margin and Bottom Margin bands. These bands are repeated once on every 

document page. You also cannot delete them, but can make them invisible by decreasing 

height to zero. 

You can also add the following bands: 

Report header and report footer The Report Header is the report's first band (margins are "out

The Report Footer is placed before the Page Footer and Bottom Margin on the report's 

last page. 

Usually these bands are not used in invoice/quote templates, as it makes no sense to print 

some header or footer for a batch of invoices. 

Group header and group footer These bands are above and below each group. The Group and Sort Panel

bands automatically. For example, each invoice may contain multiple jobs, and each job, 

in its turn, may contain multiple tasks. In this case, job can be presented as a group, and 

you may display some totals for each job. While designing the template or report

free to create groups (for example, by currency in custom reports), and use group headers 

and footers per current task. 

Detail Displayed once per data row. If you print multiple invoices, it will be printed once per 

each invoice. Thus, this is ideal band type to display invoice header.

Page header and page footer These bands are at the top and bottom of every page in a report. They display information 

that should be printed on every page (for example, logo or number of pages).



Sub-band Very interesting type of band. It may contain some logically separated kind of 

information. You can apply special rules to display or hide this band. for example, 

invoice may contain tax or may not contain tax. You can put tax amounts into sub

and print it depending of the tax selection. 

Another example: if tax in invoice is not selected, than you may have a special sub

where a text explaining absence of taxes will be displayed. 

Detail report Used when you need to display internal table (multiple rows).

header, which is printed once, a number of rows are printed. To correctly display them, 

you have to add Detail report inside Detail band. 

Here is graphical representation of this structure: 

 

Expanding/collapsing bands 

You can collapse bands which are not currently needed, to free-up some space and 
concentrate in a band you're currently working with. 

 

Adding bands 

To add a band, right-click a report's design surface and choose Insert Band in the 
invoked context menu.  



 

You can insert the Detail Report band to display nested table contents. For 
invoices, nested tables are: Rows to print, Invoice details, Payment method list, 
etc. (these properties in the field list have corresponding 'table' icon). 

Detail report bands, in its turn, also may have headers and footers. 

Accessing the Bands Collection 
 

Select Edit and Reorder Bands context link in a report's smart tag to access the 
report's bands collection. It may be useful to reorder bands, or manage them from a 
centralized place. 
 

 

Template source data and invoice structure 

Using the Field list panel, as it was written in the previous article, you get access to template source 

data. 

Each source represents one table from the database. Amount of rows in that table depends on the 

quantity of selected invoices (quotes, purchase orders, etc.) to be printed. To access application 



settings and user data, each table usually has User property, which provides access to this 

information. 

Invoice structure usually contains one header, multiple rows, summary, optional information about 

taxes, optional notes, and a footer. Depending on the order and optionally displayed information, you 

select structure of the template. 

For example, invoice header (Detail bans) usually contains user's and customer's data, invoice 

number and date, logo, etc. This band is followed by Detail report linked with 'Rows to print' table, 

which contains invoice rows. 

As you already know, some kind of bands are displayed only once, while others are intended to 

display arrays of information. Let's examine default invoice template v1. 

It begins with Detail band, where we put such details as invoice number, term, customer data, 

information about issuer. This band will be printed once per each printed invoice. Open helper menu 

and check Page break property: 

 

This property signals to insert page break before each invoice header, except the first one. Thus, each 

invoices will be printed from the first page. 

Second band is InvoiceRows (detail report). If to open helper menu for this band, you will see that 

its data member is set to Rows to print. This table is generated dynamically: it contains all tasks or 

receivables from linked translation jobs. Let's repeat: invoice may be linked with multiple jobs, and 

each job may contain multiple rows in Tasks or Receivables tables. When Receivables table has at 

least one row. Rows to print table will be filled with data from Receivables table. Otherwise, it will 

use Job tasks table. This approach allows you to control what you want to see in invoice: all tasks 

(all fuzzy types), or some single row which shows average volume and price. Then you build custom 



invoice template, you may bind InvoiceRows band to Invoice details table instead of Rows to 

print table (for example, if you wish to print only totals per each job, without detailed job contents). 

So, InvoiceRows detail report will be printed as many times as a number of rows in the 

invoice. InvoiceRows is grouped by job: 

 

For each group, template has group footer, which displays job notes and horizontal line. Sub-band 

with job notes is conditionally hidden, if job does not contain notes. Second sub-band contains only 

horizontal row to separate jobs in template. This band is always printed (that is why it is separated 

from sub-band with notes). 

Underlining, InvoiceRows section contains InvoiceRow band, which lists all tasks of the job linked 

with an invoice row. 

InvoiceRows band has a report footer with total amount and notes. This footer is split to a number of 

sub-bands. This is done to be able to conditionally hide these sub-bands. For example, when Tax2 is 

not selected in an invoice, corresponding sub-band would not be printed. To achieve this, Formatting 

rules feature is used. 

After InvoiceRows detail report, another detail report is placed - Payment methods. It will display 

accepted payment methods. In the header of this nested report we've put description text, which will 

be hidden if no any accepted payment methods were selected in a printed invoice. Again, this is 

achieved with the help of Formatting rules. 

Detail report linked with accepted payment methods also demonstrates interesting property: it will be 

printed not only in the down direction, but in the right too. This is specified via helper menu, 

using Multi-column mode and Column count properties. This feature allows to save some paper 

space and print 2 (in this example) payment methods in 1 row. 



Here is an image demonstrating a structure of default invoice template: 

 

 

Does it all sound too complex? Maybe, a bit. Different people has absolutely different requirements 

to invoice templates. This leads to a increased complexity at start. Bands, especially detail reports, 

may force you to think that it is way to difficult to create own template. Don't think that. Instead, try 

to play a bit with the designer, analyze field list, understand referenced properties and tables. Invoice 

in the field list is a table, which requires detail report. This detail report is the whole template itself. 

If you need to print table property from the field list (Invoice details, Payment methods), than you 

must create detail report. Additional complexity is added due to two detail reports linked with 

Invoice details (one for rows with empty job, another for rows with selected job). This is done 

because SDL Trados Business Manager allows to create invoices in two ways - with linking with 

jobs and without linking. When invoice row is linked with the job, we use one way of printing 

(displaying information from the list of task of the selected job). When job is not selected, we use 

another way of printing (simply displaying price, quantity and amount from the invoice row). 

Formatting rules 



Formatting rules feature is one of the most important features of the template designer. It 

allows to create rules with specific criteria, and apply particular formatting to the 

corresponding elements when this criteria is met. 

Formatting rules may be applied to any report element (like labels) or whole bands. You can 

access it from the helper menu: 

 
or via Properties panel: 

 

Example of the Formatting rule sheet window: 

 

Formatting rules allow may affect the following properties when applied to elements: 

 Background color 



 Border color 

 Border dash style 

 Borders 

 Border width 

 Font 

 Foreground (text) color 

 Padding 

 Text alignment 

 Visibility 

This feature is extensively used in invoice templates. For example, you may select invoice 

accent color in the program settings. Depending on the selected color, invoice elements will 

have different background and foreground colors. This has been achieved using formatting 

rules feature. Another example is possibility to hide template elements depending on values of 

the invoice being printed. Visibility change option allows to hide tax amounts if no any tax is 

selected in the invoice being printed. The same applies to invoice notes, discounts and any 

other elements. 

Formatting rules are created via Formatting rule sheet property of the template. You may 

access it via report helper menu or via report properties window 

In the Condition property a criteria is created using built-in visual criteria builder, which meas 

that this condition is met when Tax1 field of the printed invoice is not empty. When this 

criteria is met, Visible property of the attached element is changed to Yes. If you will find 

SubBandTax1 band in the report and select it, you will see that its Visible property is set to No. 

This means that this band is not printed by default. In the Formatting rules property of this 

band this rule (ruleTax1) is applied. This allows to change Visible property of 

the SubBandTax1 band from No to Yes, when Tax1 field of an invoice being printed is not 

empty. 

It is not required from you to remember how to use IsNull function - it can be picked-up from 

the list in the condition editor: 



 

Exporting and importing template 
layouts 

Sometimes it may be needed to export template or custom report to a file, to share it with a 

colleague or to send it to a developer to get help with designing a template. 

You can easily do this by following these simple steps: 

Windows version 

1. Go to Reports > Reports and templates. 

2. Select your template or custom report and select Edit in the designer. 

3. In the designer, right click outside paper and select Export layout to file...: 

 
or use report quick menu: 

 
 



4. Save repx file into desired location and send it to a colleague. 

5. After receiving corrected file, repeat the same procedure, but select Import layout 

from file..., to replace opened template with a file you received. 

Web version 

1. Go to Reports > Reports and templates. 

2. For a required template, use inline Export or Import button. 

 

Asian characters in PDF files 

When an invoice containing Asian characters gets exported into PDF format, layout may be 

corrupted and instead of Asian characters unreadable symbols may appear. 

This happens because fonts used in default templates do not contain all the necessary glyphs to 

display the Unicode text. To fix this issue, it is needed to clone any predefined invoice template 

and apply another font to all labels. For example, it is known that Arial Unicode MS font 

displays Asian characters correctly. Also, you may use any other font which has necessary 

glyphs. 

Adding support to edit fields in the 
print preview dialog 

You may notice that built-in invoice templates support editing in the print preview dialog. You 

can click on a field and replace/edit text before saving generated document: 



 

If you wish to add such editing fields to your custom templates, please do the following: 

1. Open a template in the Report designer. 

2. Select a field which you wish to make editable, and find Edit options property: 

 
3. Check Enabled box. 

4. In the Editor name, select type of editor you wish to use for a field: 

 
5. Save a template, generate an invoice using this template, and check editing 

functionality. 

Protecting generated PDF files with 
password 

You can add support of automatic password protection of PDF files generated by Business 

Manager. To do this, follow this procedure: 

1. Open your custom template in the Report designer. 

2. Click on empty space outside paper to select the whole report in the Properties panel: 

 



3. Switch to the Behavior tab, expand Export options, PDF Export options, and click 

three dots in the Security options field: 

 
4. Set password protection settings in the appeared dialog: 

 
5. Save your template, generate invoice using this template and export it to PDF format to 

check if all works correctly. 

Including currency rate and amounts 
in base currency in invoice templates 

Some legislation may require to show amounts in your invoice expressed in your native 

currency. 

Since each invoice has Currency, User, Currency, Currency rate and Amount (base 

currency) fields, it is easy to display total amounts in your base currency. Just drag this fields 

into report footer (somewhere near final amount), and you are done. 

1. Open your template and determine source table for printing your invoice rows. 



This table allows to simplify invoice template structure and makes workflow more 

logical. To determine which of these tables is used, find a detail band which contains 

invoice rows and check what is written after its name. 

 
2. This template uses Rows to print table. 

3. Now, when a table is determined, we will add a new calculated field to this table. 

4. In the Field list, right click on the Rows to print item and select Add calculated field. 

5. Set the following parameters for this calculated field: 

Data member - Rows to print 

Data source - Invoice (or according name of your data source) 

Expression: Round([Amount]*[Invoice].[Currency rate], 2) 

Name - AmountBase 

Take a note that value is rounded to 2 decimals here. Please set rounding according 

your preferences. 

6. Now you have a new calculated field which may be used in the detail band. 

 
7. This label is bound to User.Base Currency.Name field. As a prefix, the work Amount is 

used. In the detail band, drag and drop previously created calculated field. 

 
 

8. If you wish to include currency symbol, clear this label binding and use mail merge 

feature, by writing (or drag/dropping) something like this: [User.Base currency.Symbol] 

[AmountBase!n2] 

9. To use drag and drop functionality, double click on this label, clear text and drop both 

fields one after another from Field list. You have amounts expressed in base currency 



for each invoice row. 

 
10. To display full amount, drag and drop Amount (base cur) field to the Total 

amount sub-band, or to any place below detail report. 

Using different formatting culture 

When you print invoice, all numbers and dates are formatted using default settings of your 

operating system (decimal and group separators, date structure).But sometimes it is needed to 

use language culture of your target customer from a different country. To achieve this, do the 

following: 

Procedure 

1. Open Reference data > Customers, and open necessary customer. 

2. Go to the Main customer settings tab and find Default formatting language field. 

3. Select desired culture and save settings. 

4. Try to print any document for that customer. 

Custom invoice template user case 1 

Introduction 

Once we've got a request from a user to help him to build certain invoice template in SDL 

Trados Business Manager. Among complexities which this user met, we can point out to the 

following: 

 Under tax name, different texts should be printed depending on applied VAT and 

customer country (see below); 

 Payment details must be printed to the left from invoice totals, which seemed complex 

because of horizontal bands which forms a structure of a report in TBM; 



 In the totals part, final amount should be printed both in customer's currency and user's 

local currency, for tax purposes. 

Requirements to conditional text which depends 
on customer country and tax 

A: The client is a non-taxable person:  

1: The client is a Business entity and has a VAT number, then print this in VAT note: 

The services are taxable in the country where the recipient is established (Reverse charge 

cross-border supply of services to a customer in another EC country (Article 44 of Council 

Directive 2006/112/EC)) 

Applicable when the client is a translation agency and my services are intermediary (I don’t 

serve the end clients), VAT should be charged to the end clients only by the translation agency, 

and I shouldn’t add any taxes to my invoices. In this case, the tax rate is 0% 

2: If the client is a Business entity outside the European Union and doesn’t have a VAT number, 

then print this in VAT note: 

The services are not taxable because the recipient is not established in the EU (Exempt 

cross-border supply of services to a customer in a non-EC country (Article 44 of Council 

Directive 2006/112/EC)) 

B: The client is a taxable person: 

1: The client is a Business entity within the EU and has a VAT number (it’s the end-client for 

me), then print this in VAT note: 

2: The client is an individual and he/she is my end client 

In both cases I should charge my default tax (e.g. 17%) and I need to mention this: 

17% VAT is applicable under the Luxembourgish VAT Law of 12 Feb. 1979, as amended 

thereafter 



Client type EU VAT number 
End Client in 

the service 
Tax rate Tax note: 

Business yes yes no 0% 

The services are taxable in the country 

recipient is established (Reverse charge cross

border supply of services to a customer in another 

EC country (Article 44 of Council Directive 

2006/112/EC)) 

Business yes yes yes 17% 
17% VAT is applicable under the Luxembourgish 

VAT Law of 12 Feb. 1979, as amended thereafter

Business no no yes/no 0% 

The services are not taxable because the recipient 

is not established in the EU (Exempt cross

supply of services to a customer in a non

country (Article 44 of Council Directive 

2006/112/EC)) 

Individual yes no yes/no 17% 
17% VAT is applicable under the Luxembourgish 

VAT Law of 12 Feb. 1979, as amended thereafter

Individual no no yes/no 0% 

The services are not taxable because the recipient 

is not established in the EU 

supply of services to a customer in a non

country (Article 44 of Council Directive 

2006/112/EC)) 



Invoice design 

Invoice should be designed as shown in the attached file (which also includes few comments 

explaining what user wishes to see in the resulting document).

DOCX  

Solution 

Since attached design differs from all built-in designs, we can duplicate any built-in template, 

for example last one - Invoice v7. 

In the designer, first of all let's adapt invoice header, which is simplest task. 

1. Select whole report (click outside of paper, for example) and change default Font to 

Calibri, size 12. This will set default font to all labels in the report. 

2. While working on the template, if particular label use non-default font, click on the 

green box near Font property of that label and select Reset, so this element will start 

using default font select for the whole report: 

 
3. To put all customer's and user's details inside single blue frame, put Panel element onto 

the designer surface, and configure its border: 



 
 

4. Then, simply put all labels containing customer's and user's name, address, VAT, etc., 

inside this panel. 

5. Modify table header design: set background and foreground colors, set grey borders. To 

display currency name in the last column, bind it to Currency.Name field and set 

format string to Job Total ({0}): 

 
6. Modify InvoiceRow detail band under Invoice rows (Rows to print) details report to 

display information required by user: 

a. Purchase order will be linked to Rows to print.Job.PO number field 

b. Job/project number - Rows to print.Job.Client ref number 

c. Job completed - Rows to print.Job.Date delivered 

 
d. Job description - Description 

e. Project manager - Rows to print.Job.PM.Full name 



f. Service - Work type.Name 

g. Units - Unit.Name 

h. Quantity - Quantity 

i. Unit price - Price 

j. Job total - Amount 

For quantity, price and amount, use this format string: {0:###,###,###,###,##0.00###}. 

This means that value will be presented as grouped number, with minimum 2 decimals, and 

maximum 5 decimals if they present in a number. To understand format string better, you can 

search in Internet about formatting numbers in .NET Framework. 

You can download final template, import it (clone predefined template, open in in the designer, 

right click outside paper and select Import) and click on elements to view fields which they are 

bound to in the Field list panel.  

Header and table contents are ready. Next part is invoice totals and payment information 

which must be printed to the left of totals. 

Report designer has a feature which allows to print band contents across next bands. However, 

this feature is available only for Group header bands. However, at this point, after table, we 

can only display group footer. To overcome this, we should add nested detail report linked 

with Rows to print table again. This time, there is no need to display any data from this table, 

we only need to get a structure Report header - Details - Sub-bands - Report footer. We have to 

decrease height of the Details band to zero, so it doesn't occupy space, because it will be 

printed for each invoice row again. But since its height is zero, it won't be visible in a generated 

document. 

So, we add new nested report, link it with Rows to print table, add Header band to this report 

and put payment information into this band: 

 

Then, open quick properties of the header band and check Print across bands checkbox: 



 

From now, contents of this band will be merged with next bands (so you have to remember 

that it won't be a good practice to put any contents of the following bands right below contents 

of this band, because in this case text could be overlapped. 

Since we created new nested report, we have to move the whole invoice totals group from first 

Detail report (where they were created in original built-in template) to the new one. To do this: 

1. Add report footer to the new detail report. 

2. Create necessary number of sub-bands (for each tax, discount, charged expenses, etc.) 

3. For each sub-band, set Visibility property as it was set in original template and apply 

same conditional formatting rules. For example, sub-band for tax 1 is not visible by 

default, and Tax1 rule is applied in the Formatting rules property of this band: 

 
4. To get details of rules, click Edit rule sheet button. List of all formatting rules created in 

the report will be opened. In this editor, you can select any rule to view its expression 

and behavior. For example, if you select Tax1 rule, you will see that it sets Visibility 

property to false with the following expression: !IsNull([Tax 1]). In human words, 

if Tax 1 of an invoice is not empty, element to which this rule is applied will become 

visible. To get more information about formatting rules, please check this article: 



https://community.sdl.com/product-groups/translationproductivity/business-

manager/w/wiki/4962/formatting-rules 

5. Based on user's requirements, we need to create few labels with different texts and 

show/hide these labels based on some conditions. To solve this task, the following rules 

were created (all three rules set Visibility to true of an attached element): 

a. Name: 

ruleTaxNoteVat 

Condition: 

[Tax 1].[Rate]>0 

b. Name: 

ruleTaxNoteZeroEU 

Condition: 

[Tax 1].[Rate]=0 And Not IsNullOrEmpty([Customer].[VAT]) 

c. Name: 

ruleTaxNoteZeroOutEU 

Condition: 

[Tax 1].[Rate]=0 And IsNullOrEmpty([Customer].[VAT]) 

6. To better solve this task, we can create boolean custom field and call it 'EU', for 

example, which will allow to distinguish EU and non-EU customers. Then, this field 

could be used in our expressions. For simplicity, our rules rely on tax 1 rate and 

presence of VAT number for a customer. 

7. Create three labels with VAT notes, set their visibility to false and attach corresponding 

formatting rules to each of these labels. 

8. On the designer surface, place all three labels one above other (so they get overlapped): 

 
Since only one label will be made visible by conditional rules, in a generated report 

overlapping issue won't appear. 

Final task is to display currency rate and amount in base currency in the last row of totals 

section. For this, we create a label and apply Mail merge feature, by including multiple fields in 

one label: 

 



Since text on the screenshot isn't visible, the whole contents of the left label looks like this: 

Exchange rate ([Currency.Name]>[User.Base currency.Name]): [Invoice.Currency rate!n4] 

([Date!d] ECB) 

Here you can see that we access user settings (base currency name) and apply different 

formatting (for example, n4 to currency rate) in one label. 

That's all. The task is solved - another complex template has been implemented using invoice 

designer. Final result can be downloaded here: 

Invoice v7 Lux.zip 

CV 

SDL Trados Business Manager allows you to generate CV and keep it updated. CV feature is 

implemented using custom reports feature. This means that CV templates are created in the 

same editor which is used to create/edit invoice templates and custom reports. Check 

corresponding manual sections to get more detailed information about it. 

About this task 

In general, CV includes some background information (like education, skills, work experience, 

languages, etc.), which is mainly static and may change not too often, and dynamic information, 

like recent projects, customers, rates. Even if you are able to keep your CV in text form, idea to 

implement this feature in SDL Trados Business Manager is based on this dynamic/changeable 

information, because in many cases we do not find time to refresh our CV with recent data. And 

here translation automation system can help: you work on your translation projects, 

translation volumes grow, new customers are added to the database, and you get an option to 

generate refreshed CV with customer logos, projects description and volumes just via single 

select. When some project becomes more important, it will be moved up in the list of projects. 

Thus, you can always demonstrate recent achievements to your potential customer. 

Another reason to implement CV function is design. You can select one of predefined templates 

and customize it according your needs. Currently SDL Trados Business Manager offers 4 built-

in templates, but this set will be expanded with time. 



 

 

 



 

1. To enter static information, please open program Settings and switch to 

the CV/Professional data tab. 

Here you can enter any details which you would like to include into your CV, like slogan, 

career start year, personal details, education, skills, work experience, diplomas and 

certifications, languages, specializations, feedback and references, professional and 

other software. The Custom data table can be used to enter any information in a free 

form (2 text values, 1 date value and 1 long/multiline text value). 

Dynamic information (projects) will be taken from the Translation projects. In the 

default templates, only projects with Include in CV option checked will be printed, 

sorted by translation volumes. Of course, you can change this behavior, and print, for 

example, 10 projects with highest translation volumes. 

2. To generate resulting CV, select Reports > Reports and templates in the navigation 

tree. 

3. Select CV templates filter to display only CV reports. 

 
 

4. Simply double click on a selected template to preview the results. In the preview 

window you can estimate downsides of the generated CV and then customize it to 

achieve desired results. 



2-Column templates 

In some CV templates complex structure is used. For these purposes, nested reports function is 

used. This means that main template contains links to other templates, which are printed 

separately. 

 
It's almost empty: only 2 placeholders for sub-reports. If you will open list of CV templates, you 

will see the following there: 

 
CV template 1 consists of three reports: CV1 (shown on the screenshot above), and separate 

templates for left column and right column. Therefore, to create own CV template on the base 

of template 1, you have to do the following: 

1. Clone each of three reports of the template 1. 

2. Open cloned main template in the designer (as shown on the screenshot above). 

3. Select subreport1 (for left column), open its helper menu and find Report source 

Uri property. Select on selection button and select cloned left column. 

 
 

4. Repeat step 3 for the right column. 



Web-version 

This section contains documentation articles specific to web-version. Particularly, it includes 

user guides about Vendor portal and Customer portal. 

Please expand nested section to find detailed articles. 

Configuration utility 

SDL Trados Business Manager Online is supplied with Configuration utility, which allows to 

manage application license, as well as configure database connection and other parameters. 

You can find this utility in the Windows Start menu under SDL Trados Business Manager Online 

group. Main UI looks as following: 

 

Window is divided into 2 parts: licensing and configuration. Licensing is described in 

the Installing SDL Trados Business Manager Team Online (web version) article. 

In the Database configuration group, you can specify database connection parameters. It is 

possible to select from 2 database engines (Microsoft SQL Server or PostgreSQL). You have to 

install one of these two engines before configuring it. 

In the Database server name (it could be IP address of a computer which hosts database 

engine; 127.0.0.1 or localhost if database engine is installed on the same machine where TBM 

Online is installed, or in case of SQL Server it could be an instance name, for 

example .\SQLEXPRESS). 



Port is specified depending on database engine installation configuration, and can be found in a 

corresponding documentation of used database engine. 

Database name could be any name supported by database engine. It is not required to create 

database in advance. If database is missing, it will be automatically created by the application 

upon first start. 

Use Windows authentication checkbox can be selected, if user running application pool in IIS 

has enough rights to access database engine. Otherwise, you have to specify Database user 

name and Database user password.  

Do not force HTTPS checkbox allows to disable automatic redirection of requests coming via 

HTTP protocol to HTTPS. This feature is enabled by default. However, if you don't have SSL 

certificate on your server and still wish to allow unsecure connections, you can disable this 

settings here. 

When all changes are made, don't forget to click Apply configuration. This will write all 

changes to the webapp.config file found in the application installation folder. Take a note that 

this file will not be overwritten when you install fresh version of TBM Online. 

Data entry aspects in Online version 

In desktop version, when you double click on an entry in any list, data editing form is opened in 

a new tab. In this tab, you can modify values in all displayed fields, as well as directly edit any 

nested tabular contents. For example, let's take translation job editing window: 

 



You're free to directly edit any field in the top part (for example, customer, specialization, 

translation project, etc.), and click on any cell in the Job tasks table to edit its contents. For 

example, if you click inside quantity cell and enter different quantity, you will immediately see 

recalculated total amounts in the right part. 

In Online version, approach to data editing is slightly different. First of all, due to performance 

considerations, when you open translation job, non-empty fields will be displayed in read-only 

mode by default: 

 

You can't edit them by default. Instead, you can click on values to open editing window of a 

selected object (for example, click on customer name to view customer data). If you wish to 

edit read-only field, you have to click Edit button on the main toolbar: 

 

Another aspect of data editing is nested tables. When you click on any cell in the Job 

tasks table, you will enter cell editing mode: 

 



However, after you change quantity value, amount in this row will be recalculated 

automatically, but total job amount won't be updated until you click Save changes button 

below the table: 

 

You can see that unconfirmed changes in the table are highlighted with green color. After you 

click Save changes, highlighted cells will become regular cells, and job totals will be 

recalculated. 

If you forget to click Save changes and save a job, unconfirmed changes will be automatically 

applied, and job totals will also be recalculated. 

Portal for customers 

SDL Trados Business Manager allows to create user accounts for your customers, so they can 

login into the system, view personal information, projects, jobs, invoices, check current state of 

tasks, generate reports, download files, etc. 

 

When customers perform any actions on a portal, system administrators/managers 

automatically get notifications using internal notification mechanism or by e-mail. In the list of 

roles there are 2 special predefined roles: Vendor and Customer. When you create a user and 

assign Customer role to that user, customer portal functionality will be automatically applied 

for that user after his/her login. You are free to change default Customer role, by adding or 

removing necessary rights. But before doing this it is strongly recommended to carefully test 

changes, to avoid exposure of sensitive data. 

See nested articles in this section to get detailed information about customer portal. 



Portal usage and dashboard 

When customer logs in into the system, a default customer dashboard will be 

displayed. Navigation tree will contain fewer items (which are duplicated in the top toolbar), 

there will be fewer buttons on toolbars, and list of projects/jobs/invoices/payments/credit 

notes will display only entities of a customer associated with a user. 

Default dashboard looks like this: 

 

It provides access to the following data and actions: 

 list of ongoing quotes projects; 

 lists of ongoing jobs and projects; 

 list if unpaid invoices; 

 charts with turnaround and average volumes; 

 navigation toolbar with: 

 buttons to open separate views for credit notes, translation projects, translation 

jobs, invoices and payments; 

 a button to view and edit personal profile; 

 a button to change application language and default formatting culture; 

 additional toolbar to quickly create quote requests, projects and jobs; 

 a button to quickly view different reports. 

Widgets with lists on the dashboard support filtering functionality. To view/edit corresponding 

entity, simply click anywhere on a row. 

Chart widgets has buttons to view charts in full screen mode, as well as drop-down menus to 

choose displayed period. 

Creating an account for a customer 



1. Select Other/tools > Users navigation item. 

2. Click New to create a new user. 

3. Set a name (login) for a user, and select associated customer from the list. 

 
 

4. Then, add a new role (Customer) to the list of roles. 

5. Set Change password on first logon checkbox, if you wish not to set any password for 

a user, and allow him/her to change it after first logon. 

6. Click Save. 

7. Optionally, click Reset password to manually set a password for a user. In this case, 

you will have to pass this password to your customer. 

Editing personal information 

To edit personal information, click your user name in the to right corner and then select My 

profile. 

 

A new screen will opened, where you can change your personal information (logo, name, 

address, etc.), as well as view currently assigned default prices (cannot be edited), list of 

contact persons, associated translation jobs, projects, invoices, payments and credit notes. You 

can open any of these documents right form this form. Or, you can access same lists from the 

navigation menu, which is more convenient way of working with different types of documents. 

On the profile page, you can also change application UI language and language code used to 

format dates and numbers in the application (if differs from application language). 

To edit company contacts list, switch to the Contacts tab: 



 

Click New to create a new contact, or click on existing contact to edit his/her information. 

On the Price-list tab, you can view default prices associated with a customer: 

 

The list is grouped by service types, languages and currencies. In case you work with many 

languages and work types, this list can be long. Use paging buttons at the bottom of this table to 

navigate. When needed, page size can be increased up to 100 rows per page. 

Quotes, Translation jobs, Translation projects, Invoices, Payments and Credit notes tabs 

contain all relevant documents for a customer. 

Working with quotes 

Viewing quotes 

To view list of quotes: 

 Open the Dashboard and find Ongoing quotes widget; 

 Select Workspace > Quotes item in the navigation menu. 

 Click Quotes at the top toolbar. 

Creating new quote requests 

To create a new quote: 

 Click New quote request...button on the Dashboard; 

 Click New button in the quote list. 



Quote creation form will be opened: 

 

Here you can specify job title, desired delivery date and time, select contact person, currency 

and languages (source and target). Optionally, provide instructions on the Additional 

notes tab, where you can describe requested services in detail using an editor which supports 

rich formatting. 

To upload files, click Upload multiple files button on the toolbar in the File attachments tab. 

The following dialog appears: 

 

Here you can upload up to 5 files. Open this dialog again if you need to upload more than 5 files. 

Click Submit or Submit and close to save a request and send a notification to a manager. Also 

you can click Save as draft to save a quote without sending it to manager (if you are not ready 

to submit it or don’t have enough details about a quote): 

 

When a quote will be prepared (amounts calculated), manager will send a notification to 

person selected in the Customer contact field. After that, you will be able to open this quote, 



view quotes items with prices, discounts and amounts, and download quote PDF file, which will 

be available in the Quote file field at the bottom: 

 

If you wish to ask a question or send another message to a manager, open a quote, switch to 

the Messages tab, and click New. 

 

Type your message and click OK. 

Note. When a quote will be prepared, SDL Trados Business Manager will automatically send e-

mail notification to a customer contact (if specified), or customer users (if e-mail notifications 

are enabled in customer’s user settings). 

Accepting a quote 

If you accept a quote and ready to start translation: 

 Click Accept quote on the toolbar; or 

 Click Accept quote button near a quote in the list of quotes. 

Declining a quote 

To cancel a quote: 

1. Click Decline quote on the toolbar (or icon near a quote in the list of quotes). 

2. A dialog will appear, where you can specify a reason for deletion.  

3. After declining a quote, manager will get corresponding notification. 



Note. Take a note that customer cannot delete quotes they created. If a quote has been created 

by mistake, please ask your manager, who has necessary permission, to delete a quote. 

Working with translation jobs 

Viewing translation jobs 

To view list of jobs: 

 Open the Dashboard and find Ongoing jobs widget; 

 Select Workspace > Translation jobs item in the navigation menu. 

 Click Translation jobs at the top toolbar. 

Creating new translation jobs 

As opposed to projects, translation job is created per one language pair. While creating a job, 

you may also select a project which this job belongs to.  

To create a new translation job: 

 Click New quote request...button on the Dashboard; 

 Click New button in the quote list. 

Job creation form will be opened: 

 

Here you can specify deadline, project manager, specialization, language pair, PO number, 

name of the job and internal job number. Optionally, you can provide additional instructions on 

the Instructions tab. 

On the Checklist tab, you can provide required items to be checked before the job delivery. 



To upload files, click Upload multiple files button on the toolbar  in the File attachments tab. 

The following dialog appears: 

 

Here you can upload up to 5 files. Open this dialog again if you need to upload more than 5 files. 

Click Save to save a request and send a notification to a manager, who will process attached 

files, create necessary tasks for a job and calculate job amount. 

For messaging between customer and a manager, Messages tab can be used, as in quotes and 

projects. 

Making edits in translation jobs 

If you saved a job and wish to edit some information, you can do this until a job remains in 

Received status. which means that it has not still been processed by a manager. To edit a job, 

find in on the dashboard or in the job list, and click on it. In this mode, as opposed to job 

creation mode, extended editing form will be opened: 

 

It has a little different layout, with more fields and Totals group at the bottom. 

If job is already in work, you can't make any changes in it anymore. However, there are still two 

few way to amend jobs: 

 By clicking Upload files button to upload additional files. Managers will be notified 

about this action. 



 If job has no purchase order number specified, by clicking Upload purchase 

order button: 

 
This can be done regardless current project status, provided that Purchase order field 

is empty. 

 By sending a message to a manager from the Messages tab. 

Working with translation projects 

Viewing translation projects 

To view list of projects: 

 Open the Dashboard and find Ongoing projects widget; 

 Select Workspace > Translation projects item in the navigation menu. 

 Click Translation projects at the top toolbar. 

Creating new projects 

To create a new project: 

 Click Create new project...button on the Dashboard; 

 Click New button in the project list. 

Project creation form will be opened: 

 

As opposite to quotes, when you create a project, this means that you give 'green light' to a 

company to start translation process. 



Here you can provide project name, deadline, specialization, source and target languages, and 

detailed instructions on the Instructions tab.  

To upload files, click Upload multiple files button on the toolbar in the File attachments tab. 

The following dialog appears: 

 

Here you can upload up to 5 files. Open this dialog again if you need to upload more than 5 files. 

Click Save to save a request and send a notification to a manager. 

If you wish to ask a question or send another message to a manager, open a quote, switch to 

the Messages tab, and click New. 

 

Type your message and click OK. 

Note. If you wish to create a project over a quote, please open quote list and select Accept 

quote button. 

If project is already in work, you can't make any changes in it anymore. However, there are still 

two few way to amend projects: 

 By clicking Upload files button to upload additional files. Managers will be notified 

about this action. 

 If project has no purchase order number specified, by clicking Upload purchase 

order button: 



 
This can be done regardless current project status, provided that Purchase order field 

is empty. 

 By sending a message to a manager from the Messages tab. 

Downloading files 

When customer receives notification in any form about fully or partially completed project, 

customer’s user may go to the customer portal and open a project (or it can be opened directly 

if project link is included in notification). 

In the project view form, you can find Deliverables tab, which displays only files delivered to a 

client: 

 

This tab has same functionality and buttons as File attachments tab, but displays only files 

with File type set to Deliverables, Translated file and Proofread file. 

From here, customer can download individual files or select multiple files and click Download 

as zip file, to pack selected files to zip-archive and download it. 

Working with invoices, payments 
and credit notes 

To view list of invoices, select Workspace > Invoices (or Payments, or Credit notes) item in 

the navigation menu. 

In the lists of payments and credit notes you can only view tables (with possibility to filter and 

search data), while list of invoices additionally allows to download invoice PDF files. 



To download a file, press Download PDF, which can be found in each table row. 

Note. This button is available only if a manager generated PDF file and attached it to an invoice, 

which is stated in the PDF column. 

Viewing reports 

By default, customers have access to a number of QuickReports. You can find them 

under Reports > QuickReports item in the navigation menu. Optionally, any report can be 

generated using Reports button, which can be found in the view toolbar, regardless of a 

currently opened view: 

 

Customers can view not all system built-in reports, but a limited set of them. Detailed 

description of all built-in reports can be found in this topic. 

To view any report, simply select it. 

From the report view page, you can export any chart/table to PDF, Excel or image file. 

 

Description of elements in a QuickReport: 

1. Time range filter. Allows to filter report's data by time period (in this case, by job's 

dates). 

2. Filterssection allows to apply additional filters to displayed data. For example, here you 

can filter jobs by their status and project, by customer contacts and managers 

responsible for jobs, as well as by job volume and amount. 



3. Hover mouse pointer over any report item to view it in a full-screen mode or export its 

contents into a number of formats (PDF, Image, Excel). Also, you can use Export to 

button on the report's toolbar to export the whole dashboard into a file. 

Some widgets can be interactive. Here you can press on a pie to view detailed information for a 

selected specialization category. Hover mouse pointer over a pie to view a tool-tip with actual 

values. 

Portal for Vendors 

Portal for vendors serves as a place for communicating data with vendors. It allows vendors to: 

 View, accept and decline job offers 

 View assigned jobs along with instructions and downloadable files 

 Partially or fully deliver jobs 

 View job history 

 Invoice delivered jobs 

 Track invoice payment status 

 View vendor performance reports 

Actually, vendor portal uses the same UI as main application, but security system hides and 

restricts access to any non-related data. In addition, list and edit views has different layouts to 

provide only information needed for vendors. For example, in the list of assignments a number 

of columns were deleted, while assignment editing form was reworked not only to hide few 

sensitive fields, but also to change layout: tabs are removed and groups of fields are stacked 

vertically. So, translator would not miss instructions or attached files, as it does not require to 

switch to another tab. 

When vendor logs in into web portal, the following screen appears: 



 

That's a dashboard, which shows all recent information about jobs, invoices and performance. 

Top widget called Offered jobs allows vendor to view available jobs, accept them and decline, 

or propose to change some terms by clicking Counter offer button. 

Top navigation bar is almost empty, and includes only the following links: 

 Dashboard 

 Translation assignments 

 Incoming invoices 

 Language selector 

 Link to edit Personal data 

 Link to access personal account 

Click on items above to read detailed information about parts of the portal for vendors. 

Personal information 

To edit personal information: 

1. Click your user name in the top right corner and then select My profile. Vendor editing 

form will be opened. 

 



2. Depending on application settings, vendor may be allowed or not allowed to edit 

personal information. If that is allowed, make necessary corrections in necessary fields 

and click Save on the toolbar. Information about changes will be sent to a 

manager. Audit trail system allows to view changes made by a vendor. 

3. To view prices, switch to the Price-list tab, which displays all prices associated with a 

vendor: 

 
4. To edit days of unavailability, switch to the corresponding tab and add necessary 

rows: 

 
5. Test pieces tab allows to work with tests. Here you can view assigned tests and pass 

new tests (by clicking Add new test button). To submit a test, open any test piece with 

'In work' status and enter value into the Target text field. Then, in the list of tests, 

click Submit button. Manager will get notification about submitted test and take 

appropriate action. Additional information about test pieces can be found in this article. 

6. If editing is not allowed, vendor can click Request profile changes button on the tool 

bar, and the following window appears: 

 
7. Provide desired changes in a free form and click OK to send a request. 

Vendor translation assignments 

Viewing assignments 

To open list of assignments, click Translation assignments icon at the top toolbar: 

 

This list contains all assignments of a currently logged in vendor (ongoing, delivered, paid). 



 

At the top, you can use Filter drop-down to view only Delivered, Invoiced, and Paid assignments. 

Also, there is a search box to find assignments by some search string. 

Additionally, vendor can use filtering in the list, to display only assignments which meet certain 

criteria: 

 

Viewing assignment details 

To view any assignment, simply click on it. The following form will be opened: 

 

Translator can view assignment details here, including instructions, and download files. 

To download a file, click on the link in the File column, or select necessary files and 

click Download as ZIP on the toolbar. 



Assignment delivery 

To deliver an assignment: 

1. In the list of assignments, click Partial delivery(  ) or Final delivery button ( ) 

2. The following popup appears: 

 
3. Upload a file to the File 1field (by clicking ... or dragging and dropping a file from File 

explorer). 

4. If you want to upload more files, click Add one more file...button at the top toolbar. 

5. Optionally, provide Notes. 

6. If this is Final delivery, check if all items in the Checklist list are checked, if any. 

7. Click OK to finish delivering. Assignment status will change accordingly, and company 

manager will get a notification about delivered assignment. 

Vendor Invoices 

Viewing invoices 

To view invoices, click Invoices button on the toolbar: 

 

This list contains all invoices created by/for a vendor. To view contents of an invoice, click on 

it. Detail view will be opened: 



 

From here, you can view list of assignments included in an invoice. To view contents of each 

assignment, click Open assignment button near each assignment. 

Creating invoices 

To create an invoice, do the following: 

1. Open list of assignments, select delivered assignments and click Register an invoice: 

 
or 

2. Open list of invoices and click New. 

In any case, invoice editing window opens: 

 
3. Enter Number and Payment term. Optionally, add Notes and upload Invoice file. 

4. In the invoice items, list of assignments appear. If you wish to add a new assignment, 

click Add assignment(s). A popup with assignments appears, where you can select one 

or multiple assignments and click OK to add them to an invoice. This list contains only 

delivered uninvoiced assignments. 

5. Select taxes, and check final amount. 

6. If all correct, click Save and close or Save to confirm an invoice. 

7. Until invoice is approved by a manager, you're free to edit it (click in invoice list to open 

editing form). 



Reports for vendors 

To view vendor report, use Reports button available in the view toolbar (regardless which 

view is currently opened, this button is always available): 

 

By default, drop-down list under this button contains only one report - Vendor performance. 

It looks like this: 

 

It shows information about total number of assignments with different statuses, specializations 

chart, average rating chart, unpaid assignments, unpaid invoices and amounts of unpaid 

invoices. 

To create additional report and allow vendor to use it, please follow recommendations from 

the Providing access to additional reports for Vendors article. 

Vendor self-registration 

SDL Trados Business Manager allows vendors to self-register from the Logon page. 

Before you begin: 

 In the system Settings > Application settings, p1 page, an Allow self-registration for 

vendors checkbox must be checked. 

 In the system Settings > Main data and contact details page, a Web-app URL field 

must be filled, as this address will be included in the confirmation message sent to 

registered user. 

 In the Reference data > E-mail accounts list, working e-mail account should be added 

and marked as default. The system will send confirmation message from this address. 



Note: Test this account by sending any message using built-in mail sender. 

When vendor clicks Register, he/she will be redirected to the simple registration page. 

 

On this page, only Login, E-mail, First name and Last name should be provided. After 

registration, vendor will receive a message with auto-generated password, which can be 

changed after first logon. Also, notifications will be sent to the system administrators, 

informing about newly registered user. If that registration was inappropriate, administrator 

can disable or delete registered user. 

When vendor logins into the system, he/she will see an empty list of jobs. Initial first 

recommended action is to select My personal info. 

 

On the vendor editing page, you can enter own contact details, upload photo, add languages, 

prices, payment information, CV file, etc.. 

 
 


